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1Exercise 1: Build a raster database

Estimated time: 40 minutes

This exercise will teach you about building a raster database by exploring the tools and
techniques available to manage raster data in the ArcGIS Desktop applications and in the
ArcGIS Spatial Analyst. You will also learn about setting the spatial reference for rasters,
mosaicking rasters, pyramids, statistics, and making choices with regards to rendering,
resampling, and picking an appropriate color ramp stretch.

Designing and building a database can be lengthy, difficult, and expensive. ESRI
publishes dozens of ArcGIS data models to serve the GIS community, like those for
utilities, forestry, agriculture, land parcels, hydrology, and defense. Modifying an existing
data model can help your organization save a lot of development time. You can download
the published data models from the ESRI Web site:

http://support.esri.com/datamodels

Step 1: Explore rasters in a personal geodatabase

In this step you will investigate rasters in the geodatabase. The geodatabase has many
raster capabilities. These include support for raster datasets (mosaics) and raster catalogs
to store rasters, fast raster display at any scale, easy raster data extraction, and a host of
advantages offered by relational database management systems.

Start by connecting to a personal geodatabase and previewing a raster catalog and raster
dataset.

Start ArcCatalog.

Navigate to the c:\educ\rastergdb folder and expand it.

This folder contains two personal geodatabases, one file geodatabase and several rasters
representing quad sheets for the Lake Tahoe area.

Expand the TahoeDataBase.mdb geodatabase to view its contents.

The geodatabase contains two feature class (TahoeQuadsBnd and TahoeStreams), two
raster catalogs (TahoeQuads and UMTQuads), and a raster dataset (TahoeRDS).

ArcSDE geodatabases actually store raster data inside the host relational database.
However, rasters in a personal geodatabase are simply references to rasters that are
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actually stored as disk files. A personal geodatabase can either manage or not manage the
rasters it references.

Click on the TahoeRDS raster dataset.

Note: A raster dataset is any valid raster format that is organized into bands. Multiple
rasters can be mosaicked into one larger raster dataset.

Click the Preview tab.

Right-click TahoeRDS and select Properties.

The dialog lists the specific details associated with the raster. These properties are
divided into five sections:

▪ Data Source
▪ Raster Information
▪ Extent
▪ Spatial Reference
▪ Statistics

You can collapse and expand the sections. By default, all sections are expanded.

Question 1: What is the format of the TahoeRDS raster?

______________________________________________________________________

Click OK to close the Raster Dataset Properties dialog.

In the tree view, click TahoeDataBase to select it.

Click the Contents tab and review the Type for each of the geodatabase contents.

Notice that there are two raster catalogs in the TahoeDataBase personal geodatabase. One
is a managed raster catalog, and the other is unmanaged. A raster catalog is a collection
of raster datasets listed in a table, where each record defines an individual raster dataset
that is included in the catalog. A raster catalog can be used to display multiple raster
datasets without having to mosaic them into a larger raster dataset. Next you will
examine a raster catalog.

In the tree view, click the TahoeQuads raster catalog.

Exploring the contents of geodatabase raster catalogs is different than for table-based
raster catalogs. For geodatabase raster catalogs, the Contents tab in ArcCatalog lets you
view the contents of the raster catalog in table format. At the same time, you can select
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raster datasets in the table and see detailed information about them. You select rasters by
clicking rows in the table or with attribute queries.

The Contents tab now displays the names and object ID’s of the rasters in the catalog.

Click the Expand control on the right edge of the content panel.

The Contents tab still displays the content information, but now it has sub tabs for
Overview and Selection—both of which display the raster catalog graphically, but in
different ways. You may resize the Contents and Overview panels by dragging the
window frame edge that is between them.

Click home in the Name column of the Contents tab to select it.

A low resolution graphic of the selected raster is drawn inside the polygon wireframe in
the Overview tab.

Ctrl-click emer to add it to the selection.

Both selected rasters are highlighted and displayed in the overview tab. Now experiment
with the Selection tab.

In the Contents tab, click the Selection sub tab.

Now the Overview panel displays just the selected rasters.

Select Properties from the Overview Mode dropdown list.

Now you are able to view the properties of each raster in the catalog by advancing
through the selection with the selected raster control.

Question 2: What is the uncompressed size of the emer raster?

______________________________________________________________________

Question 3: How many rows and columns does the home raster have?

______________________________________________________________________

Question 4: What raster format do both the emer and home rasters have?

______________________________________________________________________

In the tree view, click the UMTQuads raster catalog.
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This raster catalog has the same content as TahoeQuads, but it has a significant
difference; it is ‘unmanaged’ while TahoeQuads is ‘managed’. In the next few steps, you
will see the differences between ‘managed’ and ‘unmanaged’ raster catalogs.

Review the properties of the rasters in the UMTQuads raster catalog.

Question 5: What are the formats of the four rasters in the UMTQuads catalog?

______________________________________________________________________

All the raster datasets in the managed TahoeQuads raster catalog are in a ERDAS
IMAGINE format, while the raster datasets in the unmanaged UMTQuads raster catalog
are in various formats. This is one difference between managed and unmanaged catalogs;
the rasters in a managed catalog are converted to ERDAS IMAGINE format, while the
rasters in an unmanaged catalog stay in their original format.

Next you will investigate the storage of the managed raster TahoeQuads catalog.

Minimize ArcCatalog.

Start Windows Explorer and then navigate to and select the c:\educ\rastergdb folder.

Expand the TahoeDataBase.idb folder and the two folders it contains.

ArcGIS creates an ‘.idb’ (Image DataBase) folder to store rasters that are managed by a
personal geodatabase. The name, TahoeDataBase.idb, is derived from the name of the
personal geodatabase. The image database folder does not appear in ArcCatalog.

Subfolders with sequential names are created to store the rasters for each managed raster
catalog (c_1 in your database) and raster dataset (c_2). Managed rasters are converted to
ERDAS IMAGINE format for storage, are given sequential names, like r_1, r_2, and so
on that are unique within their folder.

Unmanaged raster catalogs, like UMTQuads, simply store the path names to their source
rasters in their original format. In your c:\educ\rastergdb folder, these are the emer and
meeks grids, the home.tif TIFF image, and the rock.img IMAGINE image.

Close Windows Explorer.

Step 2: Create a raster dataset

In this step you will use ArcCatalog to create a raster dataset and load rasters into it.
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Maximize ArcCatalog.

Right-click c:\educ\rastergdb\TahoeDatabBase.mdb and select New > Raster Dataset.

For Raster dataset name with extension, type FirstRasterDataset

The name may not have any spaces in it. You may also set the cell size, pixel type,
coordinate system, and number of bands for the raster dataset, but if you leave them
blank, they will be set by the first raster you load into the raster dataset.

ArcSDE offers more storage control and has several more parameters. These include
setting a configuration keyword, building pyramids, and setting the pyramid level. You
may also set the tile size and compression type for the raster dataset.

Click OK to close the Create Raster Dataset dialog.

Now load some rasters into your new, but empty, raster dataset.

Right-click FirstRasterDataset and select Load > Load Data.

Note: Raster data can be loaded in several ways. These include Import Raster Dataset
(Geodatabase context menu), Copy Raster (Geoprocessing tools), and Load Data
(ArcCatalog dataset context menu).

The Load Data option uses the geoprocessing Mosaic tool to append multiple rasters. It
appends multiple rasters into one seamless raster dataset. Now drag and drop the input
rasters from ArcCatalog into the tool, which is faster than adding them one by one.

Move the Mosaic dialog so that the ArcCatalog Contents tab is visible.

In the ArcCatalog tree view, click your c:\educ\rastergdb folder.

In the ArcCatalog Contents tab, Ctrl-click the grids emer, home, meeks, and rock.
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Drag the selected grids to the Mosaic dialog and drop them in Input Rasters.

If the input rasters have different spatial references, cell sizes, and so on, they will be
projected or otherwise converted to match the first specified input raster.

Mosaic has several other options, like how color maps are handled and how overlapping
cells are handled. The table below lists the overlap options:

Click OK to run Mosaic (you are letting the options default for now).

In ArcCatalog, preview your new FirstRasterDataset.

Step 3: Create a raster catalog

You have created a raster dataset by mosaicking several smaller rasters together. Next
you will create a raster catalog and explore how you can use it in ArcMap.

Raster catalogs are used to display multiple or adjacent raster datasets without having to
merge or mosaic them into one larger file. A raster catalog is a container for raster
datasets in many formats. They are very useful for managing large image archives.
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Raster catalogs may also be defined using a table that references raster datasets stored in
various locations throughout your GIS. These raster catalogs appear as tables in
ArcCatalog; they can be defined using any table format.

Note: When you create a raster catalog in a geodatabase, you are creating an empty
location to contain multiple raster datasets. You then load one or more raster datasets into
your empty raster catalog.

In ArcCatalog, click the Contents tab.

Right-click c:\educ\rastergdb\TahoeDataBase.gdb and select New > Raster Catalog.

The Create Raster Catalog tool opens.

For Input Raster Catalog Name, type FirstRasterCatalog

Next you will set the coordinate systems for the raster column and the geometry column.
If you do not set a coordinate system for the raster column, it will be derived from the
first raster you load into the raster catalog. If you do not specify the X/Y Domain for the
Geometry Column, the datasets may not be visible in the display.

For Coordinate system for raster, click the button .

The Spatial Reference Properties dialog opens. Use it to import the spatial reference from
the emer grid.

In the Spatial Reference Properties dialog, click Import.

In the Browse for Dataset dialog, browse to c:\educ\rastergdb\emer and click Add.

Click OK to close the Spatial Reference Properties dialog.

You will follow a similar process to import the spatial reference for the geometry column
from the TahoeQuadsBnd feature class in the TahoeDataBase geodatabase.

For Coordinate system for the geometry column verify that

Note: You cannot change the spatial reference for the geometry column after the catalog
has been created. While the Spatial Reference Properties dialog is open, you normally
check to ensure that the X/Y Domain is correct.

The same NAD_1927_UTM_Zone_10N coordinate system has been set for both the
raster and the geometry column. If not import the spatial reference from
c:\educ\rastergdb\TahoeDataBase\TahoeQuadsBnd.

The last setting you will make determines type of catalog (managed or unmanaged).
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For Raster Management Type, select Unmanaged.

For a managed raster catalog, the geodatabase copies the rasters you load into its own file
structure and reformats them to ERDAS IMAGINE. When you delete a raster from the
catalog, it is deleted from the managed file structure. For an unmanaged catalog, the
geodatabase just stores the path names to the rasters and does not change their formats.
When you delete a raster from the catalog, you only drop the path name.

Click OK to run the Create Raster Catalog tool.

Your new raster catalog has been created. Your next step will be to load several rasters
into the new, empty raster catalog.

Right-click FirstRasterCatalog and select Load > Load Raster Datasets...

Note: Raster data can be loaded into a geodatabase in several ways: Import raster
datasets (geodatabase workspace context menu), the Copy Raster tool (geoprocessing
tools), or Load Data (ArcCatalog dataset context menu).

The Raster To Geodatabase (multiple) tool opens. You only need to add the input rasters,
and you will use the same drag-and-drop technique you used before.

In the ArcCatalog tree view, click c:\educ\rastergdb.

In the Contents tab, Ctrl-click emer, home.tif, meeks, and rock.img to select them.

Drag the rasters from ArcCatalog to the tool and drop them in Input Rasters.

Click OK to run the Raster to Geodatabase (multiple) tool. Whern completed click on
the Close button.

Step 4: Use geodatabase rasters in ArcMap

In this step you will use your FirstRasterCatalog and FirstRasterDataset in ArcMap.

Start ArcMap with A new empty map.

Add the following data to the map from c:\educ\rastergdb\TahoeDataBase.gdb:
▪ TahoeStreams: Line feature class of streams
▪ FirstRasterCatalog: Your new raster catalog

Set the line color for TahoeStreams to a light blue.

Notice that the four rasters that make up the catalog are drawn.
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Right-click FirstRasterCatalog, select Properties, and then click the Display tab.

Check Display as wireframe when scales greater than 1: 1.00

Click the Selection tab.

Check with this symbol.

Check and draw rasters.

Click OK to close the Layer Properties dialog.

Notice that the raster catalog is now displayed as wireframe polygons. Next you will
explore the selection options available with raster datasets. You may select by raster
attributes or by location. You may also extract rasters from a catalog.

On the Tools toolbar, click the Select Features tool .

Click in any wireframe polygon in the map.

The raster is drawn for the selected wireframe polygon.You have selected a raster from
the catalog graphically. Next you will select several catalog rasters by their attributes.

On the Main Menu, click Selection > Clear Selected Features.

On the Main Menu, click Selection > Select By Attributes.

In the Select By Attributes dialog, set these parameters:
▪ Layer: select FirstRasterCatalog
▪ Method: select Create a new selection
▪ In the expression box: type [Name] = 'emer'

Click Apply; then click Close.

You have selected and displayed the rasters in the top left and bottom right of the catalog.
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Both of the selected rasters are displayed transparently, and their wireframes are
highlighted. This form of selection is useful if you have a large catalog with many rasters
and want to limit your analysis or tasks to a subset of the catalog.

Now you will investigate the selection of rasters by location. In this form of selection,
one layer acts as the target and another as the selector.

On the Main Menu, click Selection > Clear Selected Features.

Click Selection > Select By Location.

In the Select By Location dialog, set these parameters:
▪ Selection method: select select features from
▪ Target layer(s): check FirstRasterCatalog
▪ Source layer: select TahoeStreams
▪ Spatial selection method: select Target layer(s) features intersect the source layer

features

Click Apply; then click Close.

The rasters that are intersected by the streams are now selected.
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Click Selection > Clear Selected Features.

Step 5: Extract data from a raster catalog

In this step you will use the disconnected editing tools to extract a portion of your raster
catalog to a new raster catalog in a different geodatabase. First open the drawing and
disconnected editing toolbars.

On the Main Menu, check Customize> Toolbars > Distributed Geodatabase.

On the Main Menu, check Customize> Toolbars > Draw.

Before you extract the rasters from the catalog, you create a graphic to identify the area
you want to extract. You use the tools on the Draw toolbar to perform this task.

On the Draw toolbar, click the New Rectangle tool .
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Draw a box that overlaps the bottom two rasters in the catalog, as shown in the graphic
to the right.

The rasters that are touched by the box will be extracted and written to a new catalog in
another geodatabase.

Now you are ready to use the disconnected editing tools to extract the rasters from the
raster catalog into a new raster catalog.

On the Disconnected Editing toolbar, click the Extract Data button last tool to the
right.

In the first panel of the Extract Data Wizard dialog, set these parameters:
▪ For Which geodatabase ...?: browse to c:\educ\rastergdb\Tahoe-Extracted.mdb
▪ For Show advanced options...: check the box

Click Next.

In the Advanced Extract Data Options panel, set these parameters:
▪ For What spatial extent ...?: check The boundary of the currently selected graphic

Click Next.

In the Post Data Extraction Options panel, set the following parameter:
▪ For What do you want to do...?: check Change the layers and tables....
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Click Finish to extract the raster catalog data.

Delete the rectangle graphic from the map (select it first, if necessary).

The TahoeRasterCatalog and TahoeStreams layers from the original TahoeDataBase
have been removed and replaced by the extracted data (that have the same names) from
the Tahoe-Extracted geodatabase. The extracted TahoeRasterCatalog consists of only the
two bottom rasters, and the TahoeStreams features have been clipped to the extent of the
rectangle graphic used to define the extraction extent.

Exit ArcMap without saving your changes.

The following table compares raster datasets and raster catalogs.

Exercise 1

Copyright © 2008 ESRI 1-13



Answers to Exercise 1 Questions

Question 1: What is the format of the TahoeRDS raster?

Answer: ERDAS IMAGINE

Question 2: What is the uncompressed size of the emer raster?

Answer: 1.31 MB

Question 3: How many rows and columns does the home raster have?

Answer: 1008 rows and 1348 columns

Question 4: What raster format do both the emer and home rasters have?

Answer: ERDAS IMAGINE

Question 5: What are the formats of the four rasters in the UMTQuads catalog?

Answer: emer is ESRI GRID, meeks is ESRI GRID, home is TIFF, and rock is
ERDAS IMAGINE.
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2Exercise 2: Exercise

Estimated time: 45 minutes

In this exercise, you will create an ArcGIS Server solution by incorporating the steps
you've learned in the lecture into a workflow. You will access the Resource Centers, copy
an existing ArcGIS for JavaScript API sample, and modify it to serve two map services.

In this exercise, you will:
▪ Apply the skills that you've obtained to author, publish, and use GIS services
▪ Visit the ArcGIS Server Resource Center
▪ Test a sample ArcGIS API for JavaScript application
▪ Modify the sample code to include your own map services

Step 1: Author map documents

In this step, you will author two map services, and publish them as ArcGIS Server map
services. You will work with two map documents; one containing basemap data and one
containing operational data.

Navigate to ..\Creating Web Maps and open CorvallisOperational.mxd.

For this exercise, suppose that you are building a simple web application. Your client,
Oregon State University is planning renovations on campus and would like a web map
that will eventually enable users to sketch out new features, such as a library, on campus.
The intention of this exercise is not for you to edit, but rather to go through the steps of
creating a web application using the ArcGIS API for JavaScript from beginning to end.

In this case, the data you will use relates to Oregon State University (OSU) as operational
layers - Historic OSU Buildings and OSU Boundary. A second map document with
several other layers of Corvallis, OR data will be used for a basemap service.

Examine the contents of the map document. Pan and zoom the map document.

Notice there is a scale range set to display the two layers in the map. Applying scale
dependencies is a common technique to improve map drawing time and performance.

Right-click on one of the layers, choose Layer Properties, and click on the General tab.

The table below summarizes the scale dependencies set in the two map documents. The
first two layers are drawn in the current map document (CorvallisOperational). The last
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two layers are included with the basemap map document you will view later in this
exercise step.

Layer name Dependency Threshold Scale

Historic OSU Buildings Out Beyond 1:8,000

OSU Boundary Out Beyond 1:8,000

Hillshade In Beyond 1:8,000

DEM In Beyond 1:8,000

Close the Layer Properties dialog.

You will now examine the performance of the map document using the Map Service
Publishing toolbar.

From the Customize menu, choose Toolbars, then choose Map Service Publishing.

Dock the new toolbar with the other toolbars in ArcMap.

You should use the Map Service Publishing toolbar to analyze your map documents,
address recommended optimization techniques for your services, and create Map Service
Definition (MSD) files for your optimized map services.

From the Map Service Publishing toolbar, click the Analyze Map button (first button
in the toolbar).

The Prepare window highlights any errors, warnings, and messages that will make your
map document more optimized in a server environment. In this case, you did not receive
any errors - good news! However, you do have one warning you could address, although
it is not necessary to create the MSD file.

Right-click on the Description of the warning, and choose Use Color Transparency.

Click the Analyze Map button again to resolve the warning message.

Close the Prepare window.

You are ready to create the MSD file for this map document.

From the Map Service Publishing toolbar, click the Save Map Service Definition
button (the third button in the toolbar).
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Save the MSD file, using the default name of CorvallisOperational.msd, in the
..\Creating Web Maps folder - the same location as the MXD file.

The first MSD file has been created for the operational map service. You will now go
through the same process to create an MSD file for the basemap map document.

From the File menu, choose Open. Navigate to the ..\Creating Web Maps folder and
open CorvallisBasemap.mxd. Do not save the changes to CorvallisOperational.mxd.

Perform the same tasks you performed on the first map document to the current
basemap map document.
▪ Examine the map content, including the scale ranges set to the bottom two layers.
▪ Use the Analyze Map button to find any errors, warnings, and messages.
▪ For this map document, you will just acknowledge the first warning concerning

color transparency by right-clicking on that warning and choosing Mark As
Exception. Ignore the other warnings concerning layers draw at all scale ranges.
That is okay for your basemap.

▪ Create CorvallisBasemap.msd in the same folder as the other MSD file.

When finished, keep ArcMap open, but you can close the Prepare window.

You should now have two map service definition files representing your map content. In
the next step, you will create map services for these MSD files.

Step 2: Publish map services

In this step, you will publish your MSD files as map services, and create cached tiles for
your CorvallisBasemap service.

First, you will need connect to your web server before you can publish the map services.

Hover over the Catalog window tab to unhide the Catalog window.

In the Catalog tree, expand the GIS Servers folder.

Notice that you can establish connections to a variety of GIS servers. In this case, you
want to establish a connection to an ArcGIS server.

Double-click Add ArcGIS Server.

When the Add ArcGIS Server wizard opens, notice that you have two options:
▪ Create a user connection to use GIS services, or,
▪ Create an administrative connection to an ArcGIS Server to manage GIS services.
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Because you need to publish and administer GIS services, you will establish an
administrative connection.

On the first panel, choose Manage GIS Services. Click Next.

To complete the second panel, you will need to provide your server's URL. The URL
uses the host name of your web server and the ArcGIS Server instance name. The URL's
format is: http://<host name>/<instance name>/services.

To keep things simple, you will reference the host name using a generic web server
name. The default ArcGIS Server instance name is ArcGIS.

On the second panel, do the following:
▪ For Server URL, enter your server's URL as http://localhost/arcgis/services.
▪ For Host Name, enter the GIS server host name as localhost.

Click Finish.

Your new GIS server connection appears in the GIS Servers folder.

Verify that the connection's format is localhost (admin).

Right-click the connection and choose Server Properties.

Using the tabs in the ArcGIS Server Properties dialog box, explore your GIS server's
default settings.

Close the dialog box when you are finished.

You are now ready to create the two map services.

In the Catalog window, navigate to and expand the ..\Creating Web Maps folder.

If necessary, press F5 to refresh your display.

Right-click CorvallisOperational.msd and choose Publish to ArcGIS Server.

Be sure to choose the .msd file, not the .mxd file.

Accept the default service name as CorvallisOperational.

Create the service in the existing root folder. Click Next.
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Accept the default map capabilities. Click Next.

Review what is going to be created. Click Finish.

Using the same workflow, create the CorvallisBasemap map service based on the
CorvallisBasemap.msd file. Mirror the same steps in Catalog to create the second map
service.

When finished, under GIS Servers, expand the localhost (admin) connection and verify
the two services you just created are running on your server.

Before you continue, make sure you have created two map services
and both are ready and running.

Next, you will create a cache for the CorvallisBasemap service. Caching your map
service will always draw your map service quickly as the map images are pre-rendered.

Right-click the CorvallisBasemap map service and choose Service Properties.

On the Map Service Properties dialog box, click the Caching tab.

On the Caching tab, you define the cache properties and create the tiles.

For Draw this map service, choose Using tiles from a cache that you will define below.

When caching your basemap, you need to determine which scales are most appropriate
for your data. You can use a pre-defined tiling scheme that mirrors the tiling levels used
in ArcGIS Online, Google Maps, and Bing Maps. However, you will not overlay your
servies with other external services for this exercise. So you will customize your own
map scales.

You will define your custom tiling scheme with the following scales:

Smallest Scale/Full Extent: 1:108,800

1:54,400

1:27,200

1:13,600

1:6,800

Largest Scale: 1:3,400
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Under Scales, type in the first scale value (108800), then click the Add button. Repeat
this for all six scale levels listed above.

Next to Storage Format, choose Exploded.

Leave the other options on the dialog box as is.

Now that your cache properties are set, you are ready to create the tiles. To do so, you
will use a tool for generating a map service cache - the Manage Map Server Cache Tiles
tool.

In the upper-right corner on the Caching tab, click Create Tiles.

The dialog box for the Manage Map Server Cache Tiles tool opens.

Note: The Manage Map Server Cache tool is also accessible in ArcToolbox.

Take a moment to scroll down and review the tool's parameters.

As you can see, you have a lot of control over how the map cache is created. Most of the
parameters have been autopopulated based on the tiling scheme you defined. For
simplicity, you will accept the defaults and begin to create the tiled map images.

Leave the options in the tool dialog box as is, and click OK to run the tool.

A progress window will appear to allow you to monitor the cache building.

The time it takes to build a map service cache depends on the size of your map service,
the number of layers, your computer's processing speed, and the number of scales
desired. The simple cache for the extent of the Corvallis area should not take long - a few
minutes.

When a client requests your map, rather than the GIS server drawing the map for each
request, the Web server will return these images instead. In reality, the map is drawn only
once - now - as you generate the cache.

In the tool's progress window, a confirmation appears when the tool is finished running.

Close the progress window.

Click OK on the Map Service Properties dialog box.

If you'd like, take a look at the cache tiles themselves within the scale level folders. Once
the cache completes, use Windows Explorer to view the cached tiles that were generated.
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Note: The path to access this particular cache is
C:\arcgisserver\arcgiscache\CorvallisBasemap\Corvallis\_alllayers.

You just created an exploded cache, which represents each individual tile according to its
level of detail. If you were to create a compact cache, these tiles would all be bundled
together into a non-viewable format.

When you're finished, close Windows Explorer and ArcMap.

Step 3: Interact with a live ArcGIS API sample

In this step, you will visit the online ESRI Resource Center to explore live sample
JavaScript API applications. These applications utilize the ArcGIS API for JavaScript to
combine map and geoprocessing services inside a standard html page.

Open Internet Explorer and enter the following URL in the Address bar:
▪ http://resources.arcgis.com

The ArcGIS Resource Center home page opens.

Navigate to ArcGIS Products > Server.

From the ArcGIS Server home page, select the Web APIs tab and click the JavaScript
graphic.

Click the link to visit the ArcGIS API for JavaScript (2.0) home page.

At the top of the Web page, click the Samples tab.

The Samples Overview page displays a tree on the left side.

The ArcGIS API for JavaScript page contains links for some of the samples we've used
and talked about in this course (such as the Editor widget, the Time-Aware widget and
Feature Layers).

These samples demonstrate how to use various features in the ArcGIS API for JavaScript.
Each sample page contains a live demo, a description of what happens in the sample, and
the source code.

In many cases you can extend or combine the samples to create a starting point for your
own applications.

The samples use services from the ESRI sample servers (sampleserver3) and ArcGIS
Online. You can use the services from the ESRI sample servers in your own test
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applications as you learn the API. You can also use ArcGIS Online layers in your
applications. See the ArcGIS Online home page for terms of use.

On the left side of the page, select the book named Layouts.

Select the first layout on the list, named Full map layout.

Notice that for each sample, you have the option to view a live sample, a thumbnail of the
sample, a description, and the code used to create it.

At the top of the code, click the View live sample link.

A new window opens and displays an interactive map of the world.
▪ Click and drag your mouse pointer to pan around the map.
▪ Use the slider bar to zoom in or out.

You can use this sample to show your own map service embedded within. Now you will
take a look at a few other samples to see how they vary.

Close the sample for Full map layout.

On the left side of the page, under the book named Layouts, select Map with right
content.

You can see from the thumbnail that the display of this map is slightly different, as it
contains some white space, a title, and a panel on the right for relevant information.

The sample you will use for this exercise is named Map Layout with Header and Footer.
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Locate this sample and view it live.

This is a simple map viewer, with space for a title as well as additional information that
you would like to provide in header/footer format.

Close the live sample.

In the next step, you will modify the source code for this application to include your map
services.

Step 4: Modify the sample code

The code needed to create the application you just viewed appears toward the bottom of
the Map Layout with Header and Footer sample page.

Highlight all of the code (from <!DOCTYPE HTML PUBLIC to </html>) to select it.

Right-click the selected code and choose Copy.

Open Notepad (Start > All Programs > Accessories > Notepad).

Right-click in the Notepad window and choose Paste.

When you just viewed the live sample for this code, did you notice the white space at the
top section of the map which was allotted for a header?

You will add a title in the map.
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Scroll to the bottom of the Notepad file and locate the following code:

Type in a title for your map such as Proposed OSU Renovations.

This JavaScript sample contains a reference to the ArcGIS Online Street Map service.

Now, you will update the file to point to your map services instead of the default map
service from ArcGIS Online.

Just as you have done in previous exercises, you can modify the URL reference in the
source code and interact with your own service in the application. You will first remove
the reference to the ArcGIS map service.

First, you will remove the reference to the cached ArcGIS Online service and replace it
with the endpoint to your CorvallisBasemap service.

In the htm file, locate the URL for the ArcGIS Online service as shown below:
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You will now use the ArcGIS Services Directory to find the URL for your Corvallis map
services.

Click the ArcGIS Services Directory icon on your desktop.

Note: Or Start menu > All Programs > ArcGIS > ArcGIS Server for the Microsoft .NET
Framework > ArcGIS Services Directory.

In the ArcGIS Services Directory, navigate to the link for your CorvallisBasemap
service.

In the Services Directory, scroll through the details of this service and notice that the
levels of detail for your cache are listed along with additional details such as additional
tile information, spatial reference, etc.

Select and copy the URL for CorvallisBasemap in the address bar:
▪ http://<yourwebserver>/ArcGIS/rest/services/CorvallisBasemap/MapServer

Note: You can also use localhost for yourwebserver.

Return to Notepad.

Right-click in the same location where you deleted the URL for ArcGIS Online and
paste the service's URL between the quotes.

From the File menu in Notepad, choose Save As.

Save the file to ..\Creating Web Maps folder and save the file as
MyCorvallisApp.htm.

Next, you will provide a spatial extent in the application to reference the data in your
service.
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Locate the following code in your htm file:

Maximize your ArcGIS Services Directory and locate the Initial Extent spatial
reference for your CorvallisBasemap service.

Copy and paste the XY min/max values from your ArcGIS Services Directory to
replace the existing extents in the htm file.

Next, replace the existing WKID spatial reference with the specified WKID for your
service.

Save the htm file.

Finally, you will add a few lines of code to display your Operational layers in the
application. To simpify things, this block of code has been provided for you in the
..\Creating Web Maps folder.

In Windows Explorer, navigate to and open ..\Creating Web
Maps\add_dynamic_layer.htm in Notepad.

Copy the entire block of code.
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In your MyCorvallisApp.htm, paste the block of code beneath the code identifying
your basemap.

Be sure to copy the code between the basemap references and the
closing bracket }.

From the ArcGIS Services Directory, locate and copy the URL for your
CorvallisOperational service.

When viewing your CorvallisOperational service in the ArcGIS Services Directory,
notice the description of Single Fused Map Cache: False. Did you notice that this was
stated as True for your cached service?

Replace the existing service's URL with your CorvallisOperational URL.

Save the file.

From the File menu, choose Save As, navigate to your web server folder, located at
C:\inetpub\wwwroot, and save the file as MyCorvallisApp.htm.

Close all open windows.

Step 5: Test the application

You are ready to test your new application.

Open a new browser window.

In the Address bar, enter the URL for your application:
▪ http://localhost/MyCorvallisApp.htm

Note: If a security bar displays, click it and choose Allow Blocked Content. Click Yes to
dismiss the Security Warning window.
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At first, you will only see the extent of your basemap.

Do you remember that your original Corvallis map document used scale-dependent
display to turn layers on and off at appropriate scales? Those settings are maintained in
your map service regardless of the application you use to consume it.

Notice there are six notches on your scale bar, reflecting the six layers of your caching
tile scheme.

While this application looks similar to the ESRI sample you explored earlier, notice that
it contains your services.

Use the mouse and slider bar to zoom in and pan around the map.

When completed, close the browser window.

You have finished this exercise.

Conclusion

ArcGIS Server offers options for Web application development on various platforms. For
example, three ArcGIS APIs are available for you to use to embed your GIS services into
simple Web sites. The best way to get started with these APIs is to use the samples
provided at the ArcGIS Resource Center and modify them to include your own services.

Education User Conference 2010

2-14 Copyright © 2008 ESRI



In this exercise, you performed the following tasks:
▪ Authored map documents to display operational layers and basemaps
▪ Optimized map documents as map service definition files to improve map display

performance in a server environment
▪ Published MSD files as map services
▪ Cached the contents of the basemap map service to maximize drawing

performance
▪ Served the map services using an application built using the ArcGIS API for

JavaScript.
▪ Leveraged sample code from the ArcGIS Resource Center to build your web

application.
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3Exercise 3: Exercise

Estimated time: 30 Minutes

ArcGIS has several ways for you to update and edit your data. One important and often
used way is to perform edits in ArcMap.

In ArcMap, editing occurs in an edit session, where, you can create or modify vector
features or tabular attribute information. When you want to edit, you need to start an edit
session, which you end when you're done. Editing applies to a single workspace in a
single ArcMap data frame, where a workspace is a geodatabase or a folder of shapefiles.
If you have more than one data frame in your map, you can only edit the layers in one
data frame—even if all data is in the same workspace. Although you can edit data in
different coordinate systems, it is generally best if all the data you plan to edit together
has the same coordinate system as the data frame.

There are two ways to start an edit session: by clicking the Editor menu on the Editor
toolbar or by right-clicking a layer in the table of contents. If you use the Editor menu to
start editing on a data frame that contains data from multiple workspaces, you are
prompted to choose the workspace to edit. If you right-click a layer in the table of
contents, you automatically start an edit session on the entire workspace containing that
layer.

Most of the time you edit data in data view, since it shows only the data in your map and
hides the layout elements. You can also edit in layout view, although editing is typically
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easier and more accurate in data view. However, editing in layout view is useful when
you want to make minor additions to your map in the context of your map layout.

Edits are temporary until you choose to save and apply them permanently to your data.
You can also quit an edit session without saving your changes. Just saving a map
document does not save the edits to the features—you need to specifically save the edits
in your edit session. When you save edits, you write them to the data source, or a
database.

When you are working with data in a database, making edits and saving them are
transactions against the database. Versions allow multiple users in a multiuser
geodatabase to edit the same data without applying feature locks or duplicating data.
When users are ready to apply their edits, they merge their changes through a process of
reconciling edits, resolving conflicts, and posting their changes to the parent version of a
database.

Some types of data, such as CAD drawings or coverages, can be viewed but not edited
inside ArcMap and must be edited in the data's native application. For example, while
you can view coverages in ArcMap, you can only edit them in ArcInfo Workstation. You
can import these display-only formats into geodatabase feature classes or shapefiles and
edit them in ArcMap.

In the exercise following this introduction, you will use the Editor Toolbar commands in
ArcMap to create and modify features stored in a file geodatabase.

There are 2 editor toolbars - one for 2D features and one dedicated to 3D editing. In the
exercise you will be using the 2D edit tools.

You will be introduced to the snapping environment, feature templates, and construction
methods.

Education User Conference 2010

3-2 Copyright © 2008 ESRI



The data used in the exercise is supplied courtesy of the National Park Service, United
States Geological Survey, and ArcGIS Online. The values, shapes, measurements, and
attributes in this exercise are for demonstration purposes only and do not reflect reality.

Leaning objectives:
▪ Create and modify shapes and attributes.
▪ Create feature templates.
▪ Use construction methods to define a feature's shape.
▪ Use snapping to accurately position a feature easily in relation to other feature.

Step 1: Create a point feature

This step introduces the editing environment, including terminology and the ArcMap user
interface. You will create a new point in the Ranger stations layer and add an attribute.

Start ArcMap

ArcMap will display the Getting Started window from which you will pick an existing
map.
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Expand Existing Maps; then click Browse for more...

Browse to c:\educ\EDIT10 and double-click Edit.mxd to open the map document in
ArcMap

The Edit.mxd map contains six layers representing Zion National Park: Ranger stations,
Roads, Tracts, Zion park boundary, Tracts.png, and SpringdaleEastNW.png.
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Notice in the Table of contents (TOC) upper right corner, you have a Pin button that will
allow you to Auto Hide the TOC. If you choose to Auto Hide, the TOC becomes a "Shy"
window, which means that if you hover over the large Table of Contents button on the
extreme left, the TOC will reveal itself.

The same is true for the catalog and search windows located in the right top of the
ArcMap application. The catalog application gives you ArcCatalog functionality right
inside of ArcMap.
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You may wish to undock a window and reposition it somewhere else within the
application or to allow it to remain free floating. This is acomplished by clicking on the
title bar of the window and dragging to a new position. You will notice that as you do
this, 4 blue direction arrows located to the left, right, top and botom are generated to act
as guides for you to dock the window you wish to move. If you hover over one of these
your window will be docked at this location. The 4 arrow icon in the center is a shortcut
to save you having to move the window towards the desired direction, as you hover over
the arrow you wish to move to a guide in blue shows you where your windo is going to
dock.
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Spend a few minutes to become familiar with the changes to the interface and the
location of toolbars, tools and commands.

Click the Editor Toolbar button on the Standard toolbar to add the Editor Toolbar
to ArcMap.

The Editor Toolbar contains commands to edit your data. You can start and stop an edit
session, create new features, modify existing features, and save your edits from the Editor
Toolbar.

Editing occurs in an edit session. You must start an edit session when you want to edit
and stop it when you are done editing. Editing applies to a single workspace in a single
ArcMap data frame. A workspace is a geodatabase or a folder of shapefiles.
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Click the Editor menu on the Editor Toolbar and click Start Editing to start an edit
session.

ACreate Features window appears to the right of the ArcMap application. You start with
this window anytime you create features on the map. The top panel of the Create Features
window shows the feature templates in the map, while the bottom panel of the window
lists the feature construction tools available to create features.

Creating features is accomplished through the use of feature templates. Feature templates
define all the information required to create a feature: the layer where a feature will be
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stored, the attributes a feature is created with, and the default tool used to create that
feature.

Click Bookmarks on the ArcMap main menu then click Visitor center to zoom to the
area around a visitor center ranger station at the south entrance of Zion National Park.

In the Create Features window, click the Ranger stations point feature template to set
the target layer to Ranger stations and activate the appropriate feature construction
tools.

The set of available tools in the Construction Tools panel depends on the type of feature
template selected. For example, when a point template is selected, tools for creating point
features are made available. When an annotation template is selected, tools for creating
annotation are made available.

Point features are straightforward to create. The Point tool is automatically activated
when you click a point template. Just click the map where you want to add the point. As
you move around the map to place the point, the pointer on-screen feedback shows the
symbol for the new point feature.

Use the following graphic as a guide for the next step.

Click the Point tool on the Create Features window if it is not already selected. Using
the aerial imagery, click the map directly over the visitor center building to place a
point.
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Notice that the center of the symbol contains a solid, cyan circle. A newly created feature
is selected as soon as it is created. This allows you to easily identify it and add attribute
values.

Click the Attributes button on the Editor Toolbar to open the Attributes window.

The Attributes window is a quick way of updating attributes for selected features. The top
panel displays a hierarchy of the layer name and selected features from that layer. The
bottom panel displays field names and the attribute values.

Click on <Null> inside the box for the Location attribute and type Visitor Center.

Press ENTER to store the attribute values for that feature.

Edits are temporary until you choose to save them. Saving a map document does not save
the edits. You must specifically save the edits in your edit session. When you save edits
they are written to the data source. In this case, the data source is the Zion geodatabase.

Click the Editor menu on the Editor Toolbar and click Save Edits to save the new point
feature in the Zion geodatabase.

Click the Close button on the Attributes window to close it.
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Step 2: Digitize a line feature using snapping

This step introduces snapping. You will set the snapping environment and create a new
line feature on the Roads layer.

Snapping allows you to create features that connect to other features with better accuracy
and fewer errors. With snapping, the pointer will jump, or snap to, points, endpoints,
vertices, or edges of other features enabling you to easily position a new feature in
relation to them.

Click Bookmarks on the ArcMap main menu then click Digitizing roads to zoom to the
study area.

Click the Editor menu on the Editor Toolbar and hover over Snapping.

Click Snapping Toolbar to add the Snapping toolbar to ArcMap.

The Snapping toolbar contains all the settings for the snapping environment. Snapping
must be enabled or disabled from this toolbar. The main buttons on the toolbar facilitate
snapping to a point, end, vertex, or edge and can be turned on or off as required.

The snapping tolerance is also set from the Options on this toolbar. Snapping tolerance is
the distance within which the pointer snaps to another location. Additionally, Snap Tips
can be turned on to display a text box indicating the layer you are snapped to and the snap
locations whether point, end, vertex, or edge.
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Click the Snapping menu on the Snapping toolbar and confirm that Use Snapping is
checked. If not, click it to enable snapping.

Confirm that the end , vertex , and edge snap types are highlighted in blue
on the Snapping toolbar. This means it is active. If not, click each button to enable
those snap types.

Click the Snapping menu, click Options, and set the snap tolerance to 10 pixels if it is
not already set.
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Check the boxes for Show Snap Tips, Layer Name, Snap Type, and Background if it
they are not already checked. This will display those items in the Snap Tips text box.

Click OK on the Snapping Options window to close it.

With the snapping environment set, you are ready to begin creating the newline feature
on roads layer.

In the Create Features window, click the Local road line feature template to set the
target layer to Roads and activate the appropriate feature construction tools.

You create a new line feature by drawing an edit sketch. This is the underlying
representation of the features shape. It is composed of all the vertices and segments of the
feature. Vertices are the points at which the sketch changes direction, such as corners.
Segments are the lines that connect the vertices. This is digitizing, the process of
converting features into a digital format.

Use the following graphic as a guide for the next six steps.
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Click the Line tool on the Construction Tools panel.

Move your pointer over the endpoint of the existing line in the western portion of the
map display but do not click. The pointer icon will change to a square snap symbol and
a SnapTip appears with the name of the layer and the snap type (Roads: Endpoint).

Click once to add the first vertex in the new line.

As you sketch, a preview for the symbology is displayed with vertices symbolized as
green and red squares. Additionally, the Feature Construction toolbar appears near your
pointer providing quick access to common edit tools and commands. Press the TAB key
to reposition it if it gets in the way.

Digitize the line along the road by clicking the map at each place where the road
changes direction. Each click adds a vertex.

Continue the new line until you snap to the end of the existing feature (Roads:
Endpoint).

Click to place a vertex there.
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Click Finish Sketch on the Feature Construction toolbar to finish the sketch. This
action will convert the sketch to an actual feature. A sketch can be finished in several
other ways: pressing F2, double-clicking or the Finish Sketch command from the
context menu.

Click the Editor menu on the Editor Toolbar and click Save Edits to save the new line
feature in the Zion geodatabase.

Step 3: Creating a feature template

In the first two steps, feature templates were already created for you. Now you will create
a new feature template for a polygon layer representing private landownership.

Feature templates are used to create features by defining the information required to
create that feature such as the layer, attributes, and the default tool used to create it. They
are named, described, and tagged to help find and organize them. Feature templates are
saved in the map document or the layer file. They are automatically created for each layer
in the current editing workspace if the layer does not already have one.

Click Bookmarks on the ArcMap main menu then click Tracts to zoom to the study
area.
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Click the Organize Templates button on the Create Features window to open the
Organize Feature Templates dialog box.

The Organize Feature Templates dialog box allows you to author and manage the
templates in your map, such as by creating, deleting, copying, and renaming templates
and setting template properties.

Click Tracts in the Layers pane of the Organize Feature Templates dialog box.
Existing templates would be displayed to the right but none exist.

Click New Template to open the Create New Templates Wizard. All the
layers in your map that are currently being edited are listed here.

Ensure only the Tracts polygon layer is checked.

Click Next to choose the categories for which you want to make feature templates. The
two categories listed are based on the two categories in your symbology: Private and
Public domain land BLM.

Ensure both categories are checked and click Finish to close the wizard.
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Properties must now be defined for the Tracts feature template. The Template Properties
dialog box allows you to rename a template, provide a description, add tags, set the
default construction tool, and specify the attribute values that should be assigned to new
features created with this template.

Right-click the Private template in the Create Features window and select Properties.
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Type Private lands in Zion in the Description box. This description appears when you
rest your pointer over a template in the Create Features window.

Click in the Tags box immediately after Polygon, type a semicolon (;), add a space,
and type Zion. Type another semicolon, add a space, and type land ownership.

The Polygon tool is selected as the Default Tool. It will active by default when you
click the template to start editing.

Notice that Private is assigned as the default attribute value for the OWNERSHIP
field. All new features created with this template will have this attribute in the
OWNERSHIP field.

Click OK.

Repeat the same steps for the Public domain land BLM template. Use Public domain
land BLM for the Description and OWNERSHIP value. Use the same Tags as the
Private feature template: Polygon; Zion; land ownership.

Click Close to close the Organize Feature Templates window.

Step 4: Create and modify a polygon feature

This step introduces construction methods. You will use several different methods to
construct the polygon tract boundaries including entering coordinates and measurements.
You will also use keyboard shortcuts to improve productivity while creating features.

Click Bookmarks on the ArcMap main menu then click Create private tract to zoom to
the study area.

Click the Private template in the Create Features window to activate the Polygon
construction tool .

Click the Straight Segment construction method on the Editor toolbar if it is not
already selected. This method places a vertex each time you click, with the segments
between vertices being straight lines.

Your first vertex will be at known coordinates.

Press the F6 key for a shortcut that allows you to type Absolute XY coordinates for a
vertex.
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Type 312115 in the X: box and type 4141564 in the Y then press ENTER. A new
vertex is created at the coordinates where you will begin your sketch.

Your second vertex will be at a known direction and length from the first vertex.

Press CTRL+G for a shortcut that allows you to type direction and length for your
next vertex.

The Direction type and units are based on the settings on the Units tab of the Editing
Options dialog box, accessed from the Editor menu. By default, east is 0 degrees, and
positive angles are measured counterclockwise. For example, a 90-degree angle
represents north, and a 180-degree angle represents west.

Type 180 for the direction and type 1500 for the length then press ENTER to create the
second vertex.

The next line forms the western boundary of this tract and follows the curve of the river.

Click End Point Arc Segment on the Editor Toolbar. This method creates a
parametric curve with only two vertices as endpoints rather than creating a chain of
several vertices.

Use the following graphic as a guide for the next two steps.
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The start point of the arc is the most recently created vertex.

Click south along the river where it changes direction to establish the endpoint of the
arc. Do not worry about accurately placing this point. This step is about understanding
the construction method.

Click on the river midway between the start and end point to establish the radius. Use
the following image as a guide.

Press F2 for a shortcut to finish the sketch.

Assume you finished the sketch too early because the southeast portion of the tract should
end in a corner. Although the sketch was finished but you can still modify it.
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Click the Edit tool on the Editor Toolbar and double-click the feature to expose
the sketch and open the Edit Vertices Toolbar.

Click the Add Vertex tool on the Edit Vertices toolbar.

Click anywhere on the diagonal line between your first vertex and your third vertex to
add a new vertex.

Position the pointer over the vertex until it changes to the move pointer .

Click and drag the vertex to the desired location for the southeast corner.

Use the following image as a guide.

Press F2 to finish the sketch.

Click the Attributes button on the Editor Toolbar to open the Attributes window. The
OWNERSHIP field is already populated based on your template properties. If you had
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used the Public domain land BLM template to create this polygon, the OWNERSHIP
field would be populated with Public domain land BLM based on the properties of that
template.

Click the Editor menu on the Editor Toolbar and click Stop Editing to stop the edit
session.

Click Yes when prompted to save your edits.

Close ArcMap and do not save changes.

Conclusion

In this exercise, you edited points, lines, polygons, and attributes.

The Editor toolbar allowed you to start and stop an edit session, access a variety of tools
and commands to create new features, modify existing features, and save your edits.

The Create Features window allowed you to choose and create feature templates. The
feature template set the target layer in which your new features were stored, activated
feature construction tools, and assigned default attributes to the feature you created.

You created and modified a features by using an edit sketch. The edit sketch is the
underlying representation of the feature's geometry composed of all the vertices and
segments of the feature.

Various construction methods allowed you to use construction tools to define a feature's
shape, such as creating curved lines or specifying coordinates.

The Snapping toolbar allowed you to enable snapping types and sets snapping options to
position a feature easily in relation to the locations of other features so that your edits
were accurate with fewer errors.

The Attributes window allowedyou to edit the field values.

Thank you for particpating in the Editing in ArcMap lesson and exercise.

Exercise 3

Copyright © 2008 ESRI 3-23





4
Exploring GIS

analysis methods and
geoprocessing tools

Exercise 4A: Exploring Cholera Deaths
Estimated time: 20 minutes

Exercise 4B: Hazard Risk Modelling
Estimated time: 20 minutes

Exercise 4C: Optional Investigating
Florida Airports
Estimated time: 40 minutes





4AExercise 4A: Exploring Cholera Deaths

Estimated time: 20 minutes

In this exercise, you will explore a few GIS techniques, similar to those employed by
John Snow to explore and stop the spread of disease in the Soho District of London,
England. Using some data from the Soho District of London, England, you will learn
how ArcGIS can be used to interpret and investigate the spread of disease.

In this exercise, you will explore a few common GIS operations used in Analysis.
These include :

▪ Summarizing values
▪ Calculating new values
▪ Performing tabular joins
▪ Initiating Spatial joins
▪ Creating graphs

For some background, included below is a description of John Snow's use of basic GIS
Analysis techniques to investigate the outbreak of Cholera.

Cholera reached the British Isles in the early 1830's. Outbreaks would continue for about
50 years. Cholera is a horrible disease. The first symptom of cholera is diarrhea, and the
infected person does not feel severely ill. The diarrhea will quickly worsen, the person
will lose lots of fluids, and the blood will become increasingly thick. Within a short time,
often only two to three days, about half the people infected by cholera will die; the main
cause being dehydration.

Many assumed cholera to be an airborne disease. However, John Snow was not sure this
assumption was correct. As a London physician, he had evaluated many patients with
cholera and had not contracted the disease himself. He also argued that the infection
always seemed to affect the intestines before the patients felt ill. Hence, he suggested that
cholera was not caused by an airborne pathogen, but a pathogen that was ingested. He
published this hypothesis in The Mode of Communication of Cholera in 1849, but many
refused to accept it. Towards the end of August of 1854, Snow, in the most extreme of
circumstances, was given the chance to prove his theory.

During late August of 1854, cholera deaths began to surface in the Soho District of
London, England. The nights of August 31st and September 1st appeared to be the most
tragic. Fifty-six new cases of cholera were reported in those two nights. The next day
there were 143 new cases. On September 3rd, there were 116 new cases. The deaths were
soon to follow, 70 on September 3rd and 127 on the 4th.
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Immediately Snow began his investigation. Snow again hypothesized that if cholera was
in fact an airborne disease, then the cases should be uniformly distributed among the
streets of the Soho District. Snow analyzed this hypothesis and was able to discount it.
He was convinced that the water supply was to blame.

Using maps of the water pumps found throughout the city, he was immediately
suspicious of the water pump that stood at the junction of Broad and Cambridge Streets.
He examined it on September 3rd, but found only minimal visible contamination. The
evidence was not enough to resolve the case. During this investigation, he discovered that
cholera occurred mostly in customers of the Southwark and Vauxhall water company,
which drew its water from the lower Thames River, which was polluted with London
sewage.

Snow went to the Register of Deaths and got details regarding all the deaths from cholera
in the Soho District for that week. After obtaining the locations where the people had
died, Snow returned to the streets to begin a more in depth investigation. He noticed
immediately that the majority of the deaths occurred in the vicinity of the pump.
Specifically, of the 89 people who died of cholera by September 2nd, only ten lived
closer to a different pump. In five of those ten cases, he discovered that the deceased
individual actually preferred water from the Broad Street pump, and sent for it. At the
peak of the epidemic, more than five hundred people in one neighborhood died from
cholera over a ten day period.

Many situations proved to be evidence that there was something terribly wrong with the
Broad Street water pump. On Poland Street there was the Workhouse. The Workhouse
had 535 inmates; however, only 5 people died there. The Workhouse was surrounded on
three sides by houses in which cholera deaths occurred. So why didn't more people die in
the Workhouse? The Workhouse had its own well. Also, there were no deaths at the
Brewery. Snow visited the Brewery on Broad Street and asked them a series of questions.
Snow discovered that the Brewery had their own well too.

The percussion cap factory at number 37 was a totally different situation. Two tubs of
water were kept for the workers, and 18 of them died. The water came from the Broad
Street pump.

Obviously, residents began to panic. Some thought that they were somehow being
infected by the buried corpses of plague victims who died during the European pandemic
a century before. Housing had been built on the cemetery where those plague victims
were buried. As cholera deaths occurred in these homes, and homes in the surrounding
area, the residents feared that they were being infected by vapors coming from the
ground. After analyzing this issue, Snow discounted this hypothesis.
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One specific case was the clincher for Snow. This case involved two ladies who died in
Hampstead and Islington; over five miles away from Soho where there was no outbreak.
Snow visited the house in Hampstead where one of the ladies had died. He was told that
every day a cart took a large bottle of water from the Broad Street pump to Hampstead
because the lady liked the taste. A delivery of water arrived on Thursday the 31st of
August. By Saturday she was dead. The other lady was her niece, who paid a visit from
her home in Islington. She died in her home in Islington.

By September 7th, Soho was deserted. Many of the people had fled due to fear which
helped to slow the outbreak. However, there were still 28 new cases that day. That
evening, Snow met with the Board of Guardians of St. Jame's parish, and told them what
he had found with his investigations. The handle to the Broad Street pump was removed
the next day. The number of cases after that immediately started to diminish.

Investigation of the Broad Street pump revealed the cause. The poor sanitary conditions
of the city's water supply was the culprit of the cholera deaths from the end of August to
the beginning of September in 1854. Early Victorian cities, such as London, often
included cowsheds mixed in amongst the houses. These areas, combined with poor
handling of human sewage, led to rapid contamination of the drinking water. At Broad
Street specifically, the well below the pump was about 28 feet deep. At 22 feet down,
within yards of the well, there was a sewer. A few people had reported that the water did
smell poorly at times. Snow became more and more certain as he interviewed people that
the well had become contaminated with the infected sewage, or by contaminants from the
many nearby cesspits. As the outbreak continued, the sewage became more and more
contaminated, and so did the water.

John Snow's analysis of the cholera outbreak in the Soho District of London, England
would come under the realm of Geographic Information Systems today. Some have even
claimed that his analysis of cholera outbreaks might be the first example of GIS.
Unfortunately communication of this analysis and results was slow to spread. London
cholera outbreaks would continue on into the 1880's, until all of the shallow water pumps
would be decommissioned.

Step 1: Explore the data

Now it is your turn to analyze some of the cholera data.

Start ArcMap and open C:\EdUC\Methodology\LondonCholera.mxd

By looking at the layers represented in the Soho data frame, you realize how difficult it
could be to determine trends and relationships without visually and accurately seeing the
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different layers of information. Likewise, John Snow realized this as well. Consequently,
he determined it was necessary to create maps of the different layers of information he
collected to reveal and evaluate relationships.

Symbolize the Cholera_Deaths, LondonWaterPumps, LondonStreets, and
FormerMagueCemetery.

Choose symbol properties that will most accurately represent these layers of information.

Save the map as C:\EdUC\Methodology\LondonCholera1.mxd.

Now, after symbolizing these layers properly, you can see how important map location is.
In this case, the locations are cholera deaths. By simply looking at this information in the
GIS, you can begin to make conclusions regarding the layers of information you are
seeing. Seeing the locations of these cholera deaths reveal more information that may or
may not have come to fruition reading paper documents.

Step 2: Calculating Acreage

As part of your analysis, later you will be using the size of the Mague Cemetery as a
basis for comparison. Therefore you need to calculate it's size in Acres. Keep in mind that
there are 4048.58 sq meters in 1 acre.
.

Right click on the FormerMagueCemetery layer in Table of contents

Click Open Attribute Table

Add a new attribute field to the FormerMagueCemetery attribute table

Click Table Options > Add Field (First tool from the left)

Name: acreage
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Type: FLOAT

Next you will populate the acreage field using the shape area

Right-click Acreage field > Field Calculator...

In the expression area, build the following expression [SHAPE_Area] / 4048.58
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Click OK

Note how the field is populated with a value of 3.48 acres. Close the table

Step 3: Distance between Cholera deaths and Waterpumps

John Snow determined that the water pumps were the source of bad water and the cholera
disease based on interviews with various people who had information about the epidemic
along with visual interpretations from maps. He also investigated the deaths of many
people. In this step, you will use some of the analysis functionality in ArcMap, to show
that the water pumps were the problem.

There are several analysis operations within desktop ArcGIS that could be used to show
that the water pumps were the source of the cholera outbreak. Both the Spatial Join
functionality and the Near tool can determine the distance between the cholera death
point features and the water pump point features. Along with determining the distance,
the closest water pump to the cholera death is also recorded.

Right-click Cholera_Deaths > Joins & Relates > Join

In the Join Data dialog -> For What do you want to join to this layer, click Join data
from another layer based on spatial location

For 1, choose LondonWaterPumps for the layer to join to
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For 2, choose the add distance field option. (Number 2, second choice)

For 3, navigate to C:\EdUC\Methodology\London.mdb

For Save as type, choose Personal GDB Feature Class

Name the new output: DistDeathToPump

Click Add; then, OK

Note: The Spatial Join functionality in ArcMap joins two spatial layers of information.
In this case, you joined the Cholera_Deaths layer with the LondonWaterPumps layer.
When setting up the spatial join, you specified in the dialog that a distance field be
created. The distance field will hold the distance values from one cholera death to the
nearest water pump. Another field named Id_1 was created as well. This holds the unique
identifier for each water pump. This unique identifier corresponds to each individual
water pump. In addition, all attribute values from the LondonWaterPumps layer will be
joined to the Cholera_Deaths layer.

Layer is added to Table Of Contents

Open the DistDeathToPump attribute table

Investigate the Distance field and other joined layer's attributes

Question 1: What conclusions can you draw from looking at the map?

______________________________________________________________________

Step 4: Identifying Waterpumps by name

While exploring the water Pump data, you may have noticed, that the names of the water
pumps have not been added to the spatial locations. In this next step you will execute a
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Tabular/attribute join to join a table containing the water pump names to the water pump
locations.

Right click DistDeathToPump > Joins & Relates > Join

In the Join Data dialog:
▪ For What do you want to join to this layer, click Join attributes from a table
▪ For 1 -> Field: LondonWaterPumps_Id (from the DistDeathToPump table)
▪ For 2 -> Table to Join: WaterPumps
▪ For 3 ->Field: Id(from the WaterPumps table)

Open the DistDeathToPump table

Notice that the WaterPump points now have the names of the Pumps attached. This will
enable you to identify and summarize your data better.

Step 5: Summarizing Cholera deaths per Waterpump

In this step you will summarize the number of deaths that can be attributed to each
waterpump based on the distance the death occurred away from a waterpump. In other
words, you will be determining which of the pumps has the highest number of deaths
close to it.

Open the DistDeathToPump attribute table

Right-click on the LondonWaterPumps_Id field > Summarize
▪ For 1 -> Field: DistDeathToPump.Id_1
▪ For 2., For DistDeathToPump.Distance field, expand and choose Average
▪ For 3., Navigate to C:\EdUC\Methodology\
▪ Name table: Sum_Output.dbf

Open the Sum_Output.dbf table.

Notice how the Broad Street pump (Id_1 = 6) has the largest number of deaths and also
has the shortest average distance form a death to the water source.

Step 6: Distribution of deaths per pump

Finally, to complete your investigation of the relationship between cholera deaths and
their proximity to water pumps, you will graph the results obtained from the summary of
which water pump has the highest number of cholera deaths close to it.
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Click View> Graphs > Create

Choose Bar graph (the first one in the second row).

Under Layer/Table Choose the Sum_Output table

For Value field: the Cnt_Id_1.

Uncheck Add to legend

Check Show labels (marks)

Click Next

For Title: Name the graph Deaths per Pump

Click Finish

Explore the graph take note of the number of deaths in close proximity to waterpumps
(resize if necessary).

Close ArcMap without saving

Conclusion

In this short exercise, you read how John Snow used the early forms of GIS to stop the
spread of disease in the Soho District of London, England. Using some data from the
Soho District of London, England, you explored how ArcGIS can be used to interpret and
stop the spread of disease. during these steps you were using tools that are commonly
used in spatial modeling. Geographic information systems are used all over the world
today to increase health care efficiency and service, and to save lives. For more
information on this subject, see GIS for Health Organizations by Laura Lang published
through the ESRI Press.
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Answers to Exercise 4A Questions

Question 1: What conclusions can you draw from looking at the map?

Answer: There is a correlation between the cholera deaths and the distance away
from Water pumps.
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4BExercise 4B: Hazard Risk Modeling

Estimated time: 20 minutes

Risk is defined as the chance of something going wrong: the danger that injury, damage,
or loss will occur. A Hazard is defined as somebody or something likely to cause injury,
damage, or loss. During this brief exercise, you will be exploring the risk potential for
USA Counties by performing some basic analysis of some natural disaster hazard for the
counties.
During the exercise you will be exploring indexes for Hail, Hurricanes, Tornados, Wind
and Earthquakes.

The indexes are based on 100,
▪ a value of 100 is equal to the national average
▪ a value of 200 is equal to twice the national average, and so on.

The plan is for you to combine all these factors and display the results.

Step 1: Explore the data

The Hazard.mxd contains the ESRI dataset, counties.shp, for the United States. Most of
the fields in the table have been hidden. Also in the map document is weather.dbf, a
subset of a risk file acquired (used with permission) from Applied Geographics.
Weather.dbf contains five weather risk indexes for various types of events and also a
composite index. The indexes are based on 100, which means that a value of 100 is equal
to the national average; a value of 200 is twice the national average, and so on. Each of
the individual indexes received a particular weight by estimating the total damage
annually for that type of hazard risk. In the exercise, you will calculate a weighted hazard
risk index.

Open the map document

Navigate to C:\EdUC\Methodology

Open Hazard.mxd

The Hazard.mxd map contains 6 data frames
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Examine the tables

Make sure the Overlay data frame is active

Open the Counties attribute table and view the fields

Open the weather.dbf attribute table and view the fields

Notice that the weather.dbf has been joined to counties.shp.
▪ County is the foreign key in weather.dbf
▪ Fips is the primary key in counties.shp.

Examine the other data frames

Activate each data frame and explore the range of index values and how they vary
between each hazard type.

Hail Index

Hurricane Index

Tornado Index

Wind Index

QuakeIndex

When you are done exploring the different hazard data frames, activate the Overlay
data frame before proceeding to the next step.

Step 2: Model combined hazard risks

Next you will combine all the risk factors and display the results in the Overlay data
frame.
You will have noticed, the range of index values vary between each hazard type. This
makes it somewhat difficult for you to bring this data together in your mind. GIS makes
this easy and will let you combine data and visualize the results.

Model combined hazard risks (average sum)

Add a field called Composite to the Counties.shp layer
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In the attribute table > click Table Options > Add Field
▪ Name: Composite
▪ Type: Float

Next, calculate Composite equal to the average sum of the index fields

The expression to calculate the average sum of the index fields is the following:

[weather.HAIL_INDEX] * .20 + [weather.HURRICANE_] *.20 +
[weather.QUAKE_INDE] *.20 + [weather.TORNADO_IN] *.20 +
[weather.WIND_INDEX] *.20

This is not truly weighted … it is really averaging of the Indexes

Click Ok to execute the expression

Examine the Composite field values before reclassifying and symbolizing the counties
based on the new Composite values
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- Reclassify the Counties layer

▪ Use Quantities > Graduated colors
▪ Value field: Composite
▪ Color ramp: green to red (slope color ramp)
▪ Label column > Format labels
▪ Decimals > 0

Examine the reclassified counties. You will notice that it is now possible for you to
visualize those USA counties with the highest Risk with regards the hazards we have
used. Green represent low risk counties and red represents high risk counties.

If time permits, explore your own counties Hazard risk.

Question 1: what would you change to make the model better ?

______________________________________________________________________

In the next step, you will explore using a different weighting scheme.
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Step 3: Weighted hazard risks

It seems obvious, that you could get better or at least a more realistic result by weighting
the individual indexes before adding them together. For example, just how damaging are
hail storms compared to hurricanes or earthquakes?

Below are a few things you may want to consider:

▪ Issues:
▪ What about the index values?
▪ They are not in the same scale.
▪ How were they created?

▪ What about other hazards:
▪ Disasters (forest fire or volcanoes)?
▪ Environmental hazards (air and water pollution)?
▪ Urban hazards (crime)?

▪ What about the size of the counties:
▪ They are not all the same size.
▪ The west tends to have larger counties then the east.
▪ Maybe normalize the data by area

▪ Is this type of data appropriate for this type of analysis?
▪ Maybe model the problem with raster data (use equal samples in each cell

Model combined hazard risks (weighted sum)
Note: Remember to have the weights add up to 1

Insert > Data Frame and name it Weighted results

Copy the layer/table that are in the Overlay data frame into the new one

Add a new field (composite2) to make the comparison between weighted and non-
weighted values easier.

In the attribute table > click Options > Add Field
▪ Name: Composite2
▪ Type: Float

Next, calculate Composite2 equal to the weighted sum of the index fields

The expression to calculate the weighted sum of the index fields is the following:

Exercise 4B

Copyright © 2008 ESRI 4-15



[weather.HAIL_INDEX] * .05 + [weather.HURRICANE_] *.20+
[weather.QUAKE_INDE] *.40 + [weather.TORNADO_IN] *.30 +
[weather.WIND_INDEX] *.05

Click Ok to execute the expression

Examine the Composite field values before reclassifying and symbolizing the counties
based on the new Composite values

- Reclassify the Counties layer

▪ Use Quantities > Graduated colors
▪ Value field: Composite2
▪ Color ramp: green to red (slope color ramp)
▪ Label column > Format labels
▪ Decimals > 0

Examine the reclassified counties.
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You will notice that it is now possible for you to visualize those USA counties with the
highest Risk with regards the hazards we have used, but as we have applied weights to
the different hazards, the resultant counties at risk are significantly different. Once again,
Green represent low risk counties and red represents high risk counties.

Note: Notice how many counties in the West now indicate a higher risk as we raised the
relative importance of earthquakes over other hazards.

If time permits, try another weighting scheme using weights that you feel should have
a greater or lesser importance and explore the results.

Conclusion

In this exercise, you have explored a different approach to the classic Polygon overlay
style of analysis. By combining the different attribute indexes for different hazards, you
were effectively adding all the risk factors together. You made this combining more
effective when you introduced weight factors into the analysis. By doing this, you were
able to emphasize and de-emphasize the relative importance of one hazard over another.
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Answers to Exercise 4B Questions

Question 1: what would you change to make the model better ?

Answer: Weight the Hazards before combining them.
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4CExercise 4C: Optional Investigating Florida Airports

Estimated time: 40 minutes

In this optional challenge your are given a breakdown of what you need to do, but no
explicit instructions. For this challenge you will use model builder to explore airports in
the Orange county area of Florida. You will need to apply your ArcGIS knowledge and
skills to complete this challenge.

The following are the broad steps you will need to execute:
▪ Create a user model in ArcMap -> ArcToolbox
▪ Store the model in the OrangeCounty.mdb
▪ Add data and tools
▪ Add labels for added information
▪ Run the model
▪ Export the model to a Python script
▪ View script in Python

What follows below are the more specific steps you need to execute.

Note: Since the steps are general and not explained in great detail, feel free to ask the
instructor for assistance as you may need it.

Your data is located in the C:\EdUC\Methodology\Florida.mdb and
C:\EdUC\Methodology\OrangeCounty.mdb

The object of the exercise is to learn how to create a user defined toolbox and model and
also to create a model that will clip and buffer runway features, and then to run the model
in Model Builder

Step 1: Create a Toolbox

In this step you need to create a new Toolbox to store your model

In ArcCatalog create a new toolbox in OrangeCounty.mdb and name it Z_MyModels

Step 2: Create a Model

In this step you will create a new model in MyModels Toolbox.

Open ArcMap, add the ArcToolbox dockable window, and add the MyModels toolbox
from the OrangeCounty.mdb
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Create a new model in the Z_MyModels toolbox.

Open model properties

Name the model Runways

Check the store relative paths check box

Make sure to make your environment settings.
▪ Projection same as inputs
▪ Extent set to default
▪ Output workspace set to OrangeCounty.mdb
▪ Remainder of settings set to the default.

Step 3: Add Data & Tools to Model

In this step you will add the input data and tools to your model.

Add the C:\EdUC\Methodology\Florida.mdb\AirportRunways feature class to the map

Add the C:\EdUC\Methodology\OrangeCounty.mdb\CountyBoundary feature class to
the map

Add the AirportRunways to the Model Builder canvas

Add the CountyBoundary to the Model Builder canvas

Add the clip tool to the Model Builder canvas

Add the buffer tool to the Model Builder canvas

Connect the AirportRunways data to the clip tool

In the Select Parameter dialog, choose Input Features (Parameter)

Connect the output data from the buffer tool to the buffer tool

In the Select Parameter dialog, choose Input Features (Parameter)

Step 4: Set Tool Parameters

Next you will set the tool parameters.
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Double-click the clip tool

Set the following parameters:
▪ Input Features: AirportRunways
▪ Clip Features: CountyBoundary (blue icon)
▪ Output Feature Class:

C:\EdUC\Methodology\OrangeCounty.mdb\AirportRunwaysClip

Double-click the buffer tool

Set the following parameters:
▪ Input Features: AirportRunwaysClip
▪ C:\EdUC\Methodology\OrangeCounty.mdb\AirportRunwaysBuffer
▪ Linear unit: 1000 meters
▪ Leave the rest of the parameters at their default values

Right-click the AirportRunwaysBuffer output data and choose Add to Display

Add some labels to the ModelCanvas
▪ Add 2 connector labels for clip and buffer tools
▪ Add a diagram label to serve as title for model

Save the model

Step 5: Run the Model

In this final step, you will execute your Runways model and interpret the results.

Run the model by pressing the run button in the Model Builder

Notice the output is added to the display

Conclusion

In this brief exercises you learnt how to create a user defined toolbox and model and also
to create a model that will clip and buffer runway features, and then to run the model in
Model Builder.

By following this exercise, you have also learn how to develop a simple automated work
flow.
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5Exercise 5: Getting Started with ArcGIS Server

Estimated time: 45 minutes

In this exercise, you will complete the entire process required to make GIS information
available on the Web. You will author content using familiar ArcGIS® Desktop
applications, publish GIS services using ArcMap™, and create a Web mapping
application using ArcGIS Server Manager that will consume your services. In addition,
you will edit the application to use a public Geocoding service and an optional
Geoprocessing service.

In this exercise, you will:
▪ Author content for a GIS service
▪ Connect to your GIS server
▪ Publish a GIS service
▪ Create a Web mapping application
▪ Configure and use a Geoprocessing service from ESRI Sample Server.

Step 1: Author GIS service content in ArcMap

In this step, you will create a simple map document containing data you wish to publish
as a map service. In general, the process of authoring a map for publication in ArcGIS
Server is no different than authoring any other map document. Although, map rendering
performance is a very big consideration when authoring maps that will be published by
ArcGIS Server. If the map does not perform well locally, it will not perform well once
published and accessed through an ArcGIS Server client.

Before authoring your own data, you will first add a base data service from ArcGIS
Online to an ArcMap document. This base data will serve as background, reference
information for your map during the authoring phase and will eventually be blended with
your map service in the Web mapping application.

Open ArcMap.

You can add basemap content from ArcGIS online directly from within ArcMap.

Click File, ArcGIS Online.

The ArcGIS Online window appears where you can search for GIS content. Imagine you
would like to overlay your data on a Streets basemap.
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In the Search window, type Streets, and click the Search button .

You can see a number of different layer packages and map services in the ArcGIS Online
Search window. Scroll through the list to look at the different options. Some of these
datasets are posted by users and some of them are provided by ESRI. If you scroll to the
bottom of the window, you can see other types of basemaps you can use - Shaded Relief,
Imagery, Transportation, etc.

Find the Streets layer package by ESRI at the top of the list and click on the Add Data
button .

The World Streets basemap layer package gets added to ArcMap.

Now you are ready to add your own data on top of this public base data.

Using the World Street Map base data as a reference while authoring provides you with
context so you are not trying to symbolize your data based on a white background.

Click the Add Data button in ArcMap .

Click the Look in down arrow and navigate to California File Geodatabase located at
C:\EdUC\AGServer\California.gdb.

You see several datasets you can add to your map document.

Hold down your CTRL on your keyboard and select some layers to add to your map
document (choose whichever ones you like, perhaps the State Boundary and/or
Counties, and a couple of other layers).

Click Add.

Click Close if a warning pops up.

Zoom into the area around the newly added data.
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Next, you will symbolize the data you have added.

In the table of contents, click anywhere in the white space to deselect the layers.

Take a few minutes to quickly symbolize the data you have added:
▪ Right-click any layer and choose Properties.
▪ In the Layer Properties dialog box, click the Symbology tab.
▪ Modify the symbology as you'd like - perhaps choose Hollow for the State or

County boundaries.
▪ Click OK to close the dialog box.

Use the same process to modify the symbology of the other layers to your liking.

It is important to think about the base data that will be used in your Web application at
the time of authoring so that you can author your layers appropriately but you don't
necessarily want to save this base data information into the same map document as the
California data. To achieve the best performance in the Web mapping application, you
will publish the California data independant from the base data and then fuse them back
together in the Web application. Therefore, you will remove the World Street Map data
from your map document now.

Right click Streets basemap and select Remove.

When you are finished symbolizing the map layers, from your File menu, choose Save
As.

On the Save As dialog box, click the Save in down arrow and navigate to the
C:\EdUC\AGServer folder.

In the File name field, type California.mxd.

Click Save.

You have successfully completed the first step required to publish GIS content on the
Web. As you have seen, you can author content for ArcGIS Server using familiar ArcGIS
Desktop applications such as ArcMap. Next, you will establish a connection to ArcGIS
Server and publish your map document as a map service. You can do this using the
Catalog window in ArcMap or using ArcCatalog. You will use the Catalog window in
ArcMap.
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Step 2: Connect to your GIS server

There are three applications that can be used to publish and administer GIS services:
ArcMap, ArcCatalog and ArcGIS Server Manager.

Before you make a connection, first, you need to know the name of you computer (which
contains all of the required ArcGIS Server components).

From the Windows panel, right click on My Computer icon and select Properties.

Click the Computer Name tab and write down the Full computer name here:
___________________.

Note: Fill in this name whenever you are asked to fill in <host_name>.

Close My Computer Properties.

In ArcMap, go to Windows, Catalog.

The Catalog window will open. Using the Auto Hide button, you can choose to dock it
or minimize it to the side of the ArcMap application.

Expand GIS Servers.

You can establish connections to a variety of GIS servers, including WMS (Web Map
Server) servers, ArcIMS servers, and ArcGIS Servers. These connections might be to a
server running locally on your machine, on your local network (intranet), or on the
Internet.

Double-click Add ArcGIS Server.

You can create either a user or an administrative connection to ArcGIS Server. To
publish and administer GIS services, you will establish an administrative connection.
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On the first panel of the Add ArcGIS Server wizard, choose the option to manage GIS
services.

Click Next.

On this panel, you will enter your server's URL. The URL is built using the host name
(your machine name) and ArcGIS Server instance name in the format
http://<host_name>/<instance name>/services. For example, the URL for a GIS server
running locally on a machine called DevBox using the default ArcGIS Server instance
name ArcGIS would be http://DevBox/ArcGIS/Services.

In the Server URL field, enter your server's URL. (http://<host_name>/ArcGIS/
Services)

Next, in the Host Name field, enter your host name.

Click Finish to create the connection to your GIS server.

Your new GIS server connection appears in the GIS Servers folder. The name of your
connection should be <host_name> (admin).
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Now that you have established an administrative connection to the ArcGIS server running
on your machine, you have the ability to control which GIS services are provided and
how they are made available to people who may wish to use them.

In the next step, you will publish the California.mxd map document that you authored as
a new map service.

Step 3: Publish a map service using ArcMap

After you have established an administrative connection, it is simple to publish, start, or
stop GIS services using ArcMap or ArcCatalog. Both of them can be use also as clients
for viewing services. In this step, you will publish your map document as a new map
service. You will then use ArcMap and ArcCatalog to preview the service and verify that
it is running.

In the Catalog tree, navigate to the C:\EdUC\AGServer folder and locate the
California.mxd map document you authored earlier.

Right-click the map document and choose Publish to ArcGIS Server.

On the first panel of the Publish to ArcGIS Server wizard, change the service name to
CaliforniaService.

GIS service names cannot contain a space.

On the same panel, choose the option to create a new folder.

Education User Conference 2010

5-6 Copyright © 2008 ESRI



In the Folder Name field, type Maps.

Click Next.

On the next panel, keep the default capabilities checked (Mapping and KML).

Click Next.

On the final panel, click Finish to publish the CaliforniaService map service.

This is the quickest and easiest way to publish a GIS service. By right-clicking a GIS
resource (map document, globe document, geodatabase, address locator, etc.), you are
only a few mouse clicks away from creating a GIS service. While this method does not
allow you to specify many of the available preferences for the new service, you can
always edit these properties later.

Expand the administrative connection to your Server.

Expand the Maps folder to verify the service was created.
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You should be able to see your CaliforniaService map service. You will now preview the
service to verify that it is running as expected.

Remove all layers from the Table of Contents.

Drag and drop the CaliforniaService from the Catalog window to the ArcMap display.

Your CaliforniaService will appear - feel free to expand the layers in the Table of
Contents and toggle them on and off.

You can also use ArcCatalog as a client to preview your service.

Go to Start, All Programs, ArcGIS, and click on ArcCatalog 10.

In the Catalog Tree, expand your ArcGIS Server connection, and expand the Maps
folder.

Click on your service and click the Preview tab to view it.
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Use some of the navigation tools (Pan , Identify , Zoom In , Zoom Out )
to interact with the map service either in ArcMap or in ArcCatalog. Your map may
look different than the screenshot below.

When you are done exploring the map service, close both ArcMap and ArcCatalog. Do
not save any changes.

ArcMap and ArcCatalog are familiar ArcGIS Desktop applications that can be used to
publish and administer GIS services. ArcGIS Server provides another application for
managing your GIS server, working with services, and even creating Web mapping
applications—ArcGIS Server Manager. In the next step, you will learn how to publish
services using this application.
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Step 4: Create a Web mapping application

While ArcMap, ArcCatalog and ArcGIS Server Manager can be used to publish and
manage GIS services, only ArcGIS Server Manager has the ability to create new Web
mapping applications. In this step, you will use the wizard-driven tools in ArcGIS Server
Manager to create a client application that will consume your new map services. You will
see how easy it is to produce a Web mapping application using ArcGIS Server Manager
and will become familiar with some of the options available when creating such a client.

Go to Start, All Programs, ArcGIS, ArcGIS Server for the Microsoft .NET framework,
ArcGIS Server Manager.

In the Log In window, enter your User Name and Password.

First, you will confirm that the CaliforniaService is started.

Click on the Services tab.

For Services in, click the drop down menu and click Maps.

Make sure the Status of the CaliforniaService is Started.

When you create a Web application, only services that are currently running will be
available to you.

Click the Applications tab.

The Web Applications panel displays a list of applications you've created previously (if
any). In addition to creating new applications, ArcGIS Server Manager also allows you to
delete or edit existing applications.
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At the top of the tab, click Create Web Application to begin creating a new Web
mapping application.

On the first panel of the wizard, for Name enter: California Web App

Leave Description blank and click Next.

You may use numbers and spaces in the name of a Web mapping
application. You may not, however, use special characters (e.g., /, \, :,
?, etc.).

Now you will add a Layer to your application.

Click Add Layer.

Double click the ArcGIS Server Internet connection to your server.

Double click on Maps and select the CaliforniaService map service, then click Add.

Select Add Layer again.

Select the Home button.

Double click the connection to ArcGIS Online.

Select the World_Street_Map toward the bottom of the list, then click Add.

The map services you choose for the application will be drawn as layers in the new
application in the same order shown in this list (from the bottom up).

Make sure that the World_Street_Map map service is at the bottom of the list, so it will
be drawn under the CaliforniaService map service. If it is not, move it down by selecting
it and clicking the up arrow (located to the right of the list box).
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With both services added to your application, you will now manipulate the extent
property.

At the bottom of the screen for Set initial extent to, choose Custom Extent then click
Define.

Zoom into the area around California and choose OK.

Click Next.

The next panel prompts you for the tasks that you wish to include in the new application.
Many of these tasks require a supporting GIS service. The Find Address task, for
example, requires a geocoding service. If you do not have the required supporting
service, you cannot include such a task. For now, you will not use any Tasks.

Click Next.

On the fourth panel, you specify the map elements you want your application to contain.
You can also modify their properties. In this case, you want the World_Street_Map to
display in your application's overview map.

Click Overview Map to select it. (Be sure to leave its box checked.)

In the Properties pane, from the Layer drop-down list, choose World_Street_Map.

Now you will add some copyright information to your application.
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Click Map Copyright Text to select it. (Again, be sure to leave it checked.)

On the Properties panel, you specify the copyright information. The Label text you enter
will appear as a link. When users click the link, the text you enter in the Description box
will display.

Modify the properties as follows:
▪ For Description, enter your name and today's date.
▪ Change the Label text to your liking (or leave the default).

Be sure the boxes for all of the map elements are checked, and click Next.

On the fifth panel, enter a title and choose a theme (or use the defaults) for your
application.

Click Next.

On the Application Settings panel, accept the default and choose Next.

The final panel shows a summary of your new Web mapping application.

Click Finish to create the application.

Your application starts in a new window.

Note: Pop-up blocking software might prevent the application from launching when you
complete the wizard. If this is the case, start the Web mapping application by clicking its
hyperlink on the Applications tab of ArcGIS Server Manager.

You will now explore the application a little to get a feel for the kind of functionality it
delivers and to see the effect of some of your configuration choices.

All Web mapping applications that you build with ArcGIS Server Manager will have the
same basic layout that you see in this application. The largest portion of the application is
used for the map display, the left console contains tools for working with the map (such
as a layer list and overview), and the toolbar above the left console contains familiar tools
for interacting with the map (e.g., Zoom In, Zoom Out, Identify, and Pan).

Use the interactive navigation tools to zoom in and pan around a section of the map.

Click the button to open the Overview Map .
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The Overview window displays the map at a slightly larger (more "zoomed out") extent.
The current extent of the map display is shown in the Overview window as a red
rectangle. When configuring a Web application, you can choose which map service to
display as the overview map.

Click the Identify tool , then click a feature in the map.

Expand the result(s) listed in the Identify window and examine the information
returned.

To the left of the application, you can see the Map Contents and the Results windows.

Expand the Map Contents window, if it is not already expanded.

Notice that the map services used for your application are displayed as group layers in the
Map Contents window. By expanding a service listed here, you can see all the layers it
contains. You can toggle layer visibility for all layers in a service by checking the check
box next to the service. You can toggle visibility of individual layers by checking the
check box next to each layer name.

When configuring a new Web mapping application, you can choose to restrict users from
toggling layer visibility, and you can hide layer symbology if you wish.

When you are finished exploring your Web application, close the Web application
window.

In this step, you've seen how easy it is to use ArcGIS Server Manager to build a Web
mapping application that uses your map services. In the next step you will modify the
application to add some analytical capabilities.

Step 5: Add a Geocoding Task to the Web application

In this step you will explore the tasks available on ArcGIS Online and you will work with
an existing, public geocoding task. Then, you will add this Find Address analytical task
to your Web mapping application.

If you did not close your California Web App at the end of the last step do so now.

Open Internet Explorer and type http://resources.esri.com/arcgisonlineservices.

Click on the Data tab.
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This is another way to get access to a number of different basemaps, reference maps,
tasks, globe documents, etc.

Scroll down to Tasks.

There are a number of free tasks available to users. You will add the United States Street
Locator task to your web mapping application, which will enable your users to geocode
an address in the United States and plot it on the web mapping application.

Click on the United States Street Locator task and briefly read its description.

Copy the link for ArcGIS Desktop/Explorer URL, which is
http://tasks.arcgisonline.com/arcgis/services

Navigate back to ArcGIS Server Manager and make sure you are on the Web
Applications page.

Select the pencil icon next to California Web App to edit the existing application.

Select the Tasks tab and choose Add Task.

From the task list, select Find Address and click OK.

Next, click Supporting Services and click Add.

Click Add ArcGIS Server.

You will add a connection to the ArcGIS Online tasks you were just looking at.

Leave the default for Type.

For Catalog URL, paste the link that you just copied. Your link should be
http://tasks.arcgisonline.com/arcgis/services and click Add.

Double click the Locators folder, select the TA_Streets_US geocode service, and click
Add.

Click OK.

Click Configure to configure this service for use.

Leave the Task Name as Find Address and leave all the other options as defaults.
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Click on the Results tab. Your result will display as a push pin.

Click OK.

Note: If you cannot see the OK button click F11 on your keyboard to maximize the
Internet Explorer screen.

Click Finish on you application properties.

When the application opens again, select the link for your Find Address task on the
right.

For an address, you will type up the address for the San Diego Convention Center.

For Street or Intersection, type 111 West Harbor Drive. For City, type San Diego. For
State, type CA.

Click Find to do the geocoding on the server.

In the Results pane, right click on your result and click Zoom To.

You have just geocoded the address for the San Diego Convention Center using the free
Geocoding task. Feel free to find other addresses.

When you have finished exploring the Geocoding task and your application, close the
California Web App.

In this step you learned how to add a Geocoding task from ArcGIS Online.

Step 6: Optional: Add a Geoprocessing Task to the Web
application

In this step you will work with an existing, public geoprocessing service available from
the ESRI Sample Server. You will explore the services available on the Sample Server
and add the analytical service to your Web mapping application.

If you did not close your California Web App at the end of the last step do so now.

Open Internet Explorer and type http://sampleserver1.arcgisonline.com/ArcGIS/
rest/services.

This is one of the home pages of the ArcGIS Services Directory for the ESRI Sample
Server.
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The ArcGIS Services Directory is an application that is installed with ArcGIS Server that
allows you to browse and find information about the service, like the type of service it is
or, for map services, its layers.

Select Network.

There is a Geoprocessing service in this folder that will allow you to calculate the drive
time from a specified point on a map.

Close ArcGIS Services Directory.

Now you will modify the California Web App application to use this Geoprocessing
service.

Navigate back to ArcGIS Server Manager and make sure you are on the Web
Applications page.

Select the pencil icon next to California Web App to edit the existing application.

Select the Tasks tab and choose Add Task.

From the task list, select Geoprocessing and click OK.

Next, click Supporting Services and click Add.

Click Add ArcGIS Server.

You will add a connection to the ESRI Sample Server you were just looking at.

Leave the default for Type.

For Catalog URL enter http://sampleserver1.arcgisonline.com/ArcGIS/services and
click Add.

Double click the Network folder, select the service ESRI_DriveTime_US, and click
Add.

Click OK.

Make sure your Geoprocessing Task is selected and click Configure to configure this
service for use.

For Task Name enter Drive Time.
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Under ESRI_DriveTime_US select CreateDriveTimePolygons and click OK.

Note: If you cannot see the OK button click F11 on your keyboard to maximize the
Internet Explorer screen.

Click Finish on you application properties.

When the application opens again, zoom into a large map scale (small area), such as
Los Angeles or San Diego.

Select the link for your Drive Time service.

Click the Add New Feature button and click a location on the map.

Notice that you are calculating a drive time of intervals 5, 10, and 15 minutes.

Click Execute to run the analysis on the server.

You can see your 5, 10 and 15 minute drive time polygons on the map. In the Results
panel, you can expand and right click the Output DriveTime Polygons to manipulate the
results.

When you have finished exploring the Geoprocessing task and your application, close
the California Web App.

In this step you learned about the ArcGIS Services Directory as well as geoprocessing
tasks.

Conclusion

In this exercise, you carried out all the steps required to make GIS data available on the
Web. First, you authored content using familiar ArcGIS Desktop applications. Next, you
published a GIS service using ArcMap. Finally, you consumed GIS services in a Web
mapping application and edited the application to use a public Geocoding task from
ArcGIS Online and a public Geoprocessing task from the ESRI Sample Server.
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6Exercise 6: Importing GPS Data into ArcMap

Estimated time: 20 minutes

The purpose of this exercise is to learn how to import raw GPS data into ArcMap.

Students will learn how to utilize GPS data by incorporating it into a GIS Geodatabase
for analysis purposes.
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Step 1: Add GPS Data to ArcMap

Open ArcMap.

a.) Open the map document titled Tree_Inventory.mxd

Note: You should see a map of the ESRI Denver Campus in Broomfield Colorado. The
Aerial Imagery is a basmap provided by Bing that was previously added to the map
via ArcGIS Online

b.) Next select Bookmarks from the context menu and choose "Denver Campus"

c.) Add GPS Data to ArcMap
Use the "Add Data Button"

browse to the C:\GPS_GIS Workshop directory and choose "GPS.txt"

d.) Right click on the GPS.txt layer in the Table of Contents and choose "Display XY
Data..."

e.) Select the "Edit..." button below the "Coordinate System of Input Coordinates" box
as shown below:
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f.) "Select" a predefined coordinate system. Navigate to Geographic Coordinate
Systems|World and choose "WGS1984.prj" Press "Add", "Apply" then "OK."
Make sure you have the "X" and "Y" fields mapped correctly. Press "OK" You will
see a warning that the table does not have object ids. Select "OK."
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You should now have an Event layer called GPS.txt Events in your table of contents
displaying your GPS Points.

Note: An event layer is only a representation of the points from the text file. Events
cannot be queried or selected. In the next steps, you will learn how to import the GPS
data into a geodatabase to use for analysis.

Step 2: Import GPS Data into a Geodatabase

Open ArcCatalog

a.) Navigate to the C:\GPS_GIS Workshop directory. Expand the folder, and you will
see a file geodatabase called " Tree_Inventory.gdb " Inside there is a feature class
called "Trees"

b.) Right click on the geodatabase and select "Properties." Click on the "Domains" tab.

Note: Notice there are several coded value domains. These domains are lists of
acceptable values for certain fields. They represent attributes for the GPS points that
were collected in the field.

Close ArcCatalog

Return to ArcMap
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Using the "Add Data" button, add the "Trees" feature class to ArcMap. You will see a
warning that the "Coordinate System does not match" click "OK"

c.) "Right Click" on the "GPS.txt Events" layer in the Table of Contents and choose
"Data" then "Export Data." In order to copy the Events into the Trees Feature Class,
they first need to be converted to a GIS format. In the "Output feature class" box,
navigate to the Tree_Inventory.gdb. Type "Output_Temp" in the Name box and
select "OK." Add the layer to the map. Click "Yes"

Next, you will need to start an edit session to copy the new features into the Trees
feature class.

d.) From the standard Toolbar, choose the "Editor Toolbar" button

The Editor Toolbar should now be floating within the ArcMap window. From the
Editor dropdown choose "Start Editing." Select "Trees" as the layer to edit and then
select "OK" and "Continue" on the next dialog. Now you are ready to edit data.

e.) Right click on the "Output_Temp" layer in the Table of Contents and choose
"Selection" and "Select All"

f.) On the Standard toolbar, choose the "Copy" then "Paste" buttons.

Be sure to specify the "Trees" layer as the target.

g.) Next, right click on the "Trees" layer in the table of contents ans "Open Attribute
Table." Highlight a record in the table or choose a tree feature from the map. The
attributes can now be edited.

Note: Several fields have dropdown lists of values for the attributes. These are called
domains, and were setup inside the geodatabase. Domains area available for use
with any feature class within the geodatabase.
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h.) Edit several of the attributes for the trees feature class including the "IDP" field.
This field will be used to symbolize the trees on the map later.
On the Editor Toolbar, choose "Editor" and "save edits"

Step 3: Symbolizing Data

The final step is to symbolize the trees based on their health or other variables.

a.) Right click on the "Trees" layer in the Table of Contents and choose "Properties."
Open the Symbology tab. Choose "Categories" and "Unique Values." Choose
"IDP" as the value field. You can add all or some of the values. Each value can be
displayed with a different color or symbol.

b.) Click "OK" and "Apply."
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Step 4: Adding Hyperlinks

In many cases, it is helpful to take pictures of the features or observations while in the
field. With GIS, we can incorporate and store the photos in many ways. In this
exercise, you will learn how to add photos as hyperlinks within a map document

a.) Using the "Identify" tool on the Tools Toolbar, identfy a tree feature

Right click in the white space under "Tree" and choose "Add Hyperlink." Select the
button next to the box under "Link to a Document." Navigate to the C:\GPS_GIS
Workshop\Photos directory and choose a photo.

b.) Click the "Hyperlink" button

on the "Tools" toolbar. Click on a feature on the map to see the hyperlinked photo.
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Conclusion

In this exercise, we learned how to take GPS data from a raw format such as a text file
and bring it into the GIS. We first displayed the X,Y coordinates for fetures as Events in
ArcMap. Next created a feature class to store temporary data. We then copied the
temporary data into a feature class with a defined schema. Additionally, we were able to
add a hyperlink to store photos of features within the map document
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7AExercise 7A: Work with ArcMap Layout View

Estimated time: 15 minutes

In this exercise you will edit an existing map template, and review the ArcMap Layout
toolbar and basic map layout management techniques.

Step 1: Edit an existing template

Open ArcMap, and choose to open an existing map

Navigate to the seminar data folder C:\EdUC\MAPS\

Open Mollweide.mxd

Question 1: What is the page size and the layout units?

______________________________________________________________________

Click the Change Layout button , located at the far right of the Layout toolbar

Click the Traditional Layouts tab, and select the LandscapeClassic.mxd

Click Finish

Observe the changes in the page size and some of the surrounding map elements.

Question 2: What is the new page size?

______________________________________________________________________

You see how easy it is to switch between layout templates. However, there are obvious
changes that need to be made to improve this map, you will do this in the next step.

Step 2: Edit map elements

You will change a few of the settings for the combined Mollweide / Landscape Classic
template to make the map look better.

Double-click on the white, vertically oriented text to open the text properties dialog

Change the text to World Map - Mollwiede Projection
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Click OK to close the Properties dialog

The Legend is very difficult to read against the 'Dark Umber' background. You will
change the background of the Legend frame itself.

Double-click on the Legend

Click the Frame tab, change the Background color to: Grey 10%.

Click OK

Move the Legend box so that it is better centered within the title area

The data frame containing the world data is very blue. Considering the size of this page,
it might take a long time and a lot of ink to print. You will remove the default
background blue for this data frame.

Select the data frame by clicking on the darker blue area

Right-click and select Properties

Click the Frame tab

As you did with the Legend, you will change the background color. This time change
it to: <None> (scroll to the top of the color dropdown list)

Click OK

In three quick steps you have made this map easier to read.

From the File menu, click Save (or Ctrl+S) to preserve the changes to the map
document.

At this map scale, do you feel the point marker symbol size for the world cities is
appropriate? When the map was first created for an 8" x 11" page, the symbols were
probably cartographically balanced. Now that you have changed the page size by
switching the map template, the city points are too large. Next, you will enhance your
map slightly by reducing the size of the city point symbols.

In the ArcMap Table of Contents, click on the point symbol for the City layer.

Change the symbol size to 4 points
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Click OK to close the Symbol Selector

This may seem small, but consider how large the page will be. To confirm how symbols
and text will appear on a final map, you should always preview your layout view at its
actual size.

On the Layout toolbar, click the Zoom to 100% button

The city point symbols are not too large for this map.

Zoom to the full page extent

Save the map document, and close ArcMap.

Conclusion

This is the end of the first exercise. If you have finished before the next lecture has
begun, feel free to continue with the next exercise or explore the software.
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Answers to Exercise 7A Questions

Question 1: What is the page size and the layout units?

Answer: 8.5 x 14 inches (Legal size sheet)

Question 2: What is the new page size?

Answer: 22 x 34 inches (ANSI D)
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7BExercise 7B: Layout Tips and Tricks

Estimated time: 30 minutes

In this exercise, you will use good cartographic principles to improve an existing map.
You will also be introduced to some advanced layout techniques which are available with
ArcGIS 10.

Step 1: Visually balance the layout

Open ArcMap, and choose to open an existing map document

Navigate to the seminar data folder (C:\EDUC\MAPS) and open FixMap.mxd

Confirm that ArcMap is showing the Layout view for this map

This map is cartographically poor, and has a number of errors and omissions which you
will correct. By the end of this exercise you will:

1. Balance the layout elements,
2. Improve the visual balance and hierarchy of color and text,
3. Add meaningful map elements,
4. Use some advanced layout techniques

What is the purpose of this map? It might be difficult to discern, based on the current
relationship between the data frames. However, the intention is to show the locations of
the main cities in South America.

Select the data frame for the World, make it smaller and move it to the top left corner.

Note: If you haven't re-sized or moved graphic elements in ArcMap before, first click on
the data frame, you will see the outline of the box change symbol to a blue dashed line
and blue boxes. These boxes are called 'handles', as you pause the cursor over the
handles, it will change to another cursor symbol. This is when you re-size or re-shape the
data frame box

Select the data frame for South America and increase its size to take up about half the
page

As necessary, zoom in on the data for South America so that it fills the data frame
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You will notice that some of the map elements changed drastically when you changed the
South America data frame: the label text, though it remained at an 8 point font, is now
much more legible, and the scale bar divisions changed.

Your map should now look something like this:

You have slightly improved the communicatory power of this map; it is now more
obvious that the purpose of this map is to show cities in South America.

Now that you have made the relationship between the data frames more clear, the city,
rivers, and lakes information in the World data frame is difficult to read, and should be
removed to reduce clutter on the map.

In the ArcMap Table of Contents, for the World data frame, turn off the display for the
City, rivers, and lakes layers.

The data frame does not have to be active for you to turn these layers off.

Now that you have improved the visual balance of the map, you need to change some of
the color and text.
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Step 2: Enhance color and text balance

ArcGIS 10 provides you with a comprehensive set of tools to control the "graphic" part
of "cartography". You will next use some of these tools to further improve the layout.
First, you will change the color of the World countries. The darker color gives too much
visual weight to the data frame, and also makes it difficult to discern the country
boundary lines.

In the ArcMap Table of Contents, click the symbol box below the Countries layer for
the World data frame.

Change the Fill Color to a beige or olive green (Tecate Dust, a beige-like color at row
seven, column four is a nice choice)

Change the Outline Color to Grey 40%

Click OK

It should be immediately apparent that lightening the color of the World map has the
effect of making the South America map appear more prominent.

Now that you have improved the color balance of the World data frame, you will change
the color scheme of the South America data frame, so that the City labels are more easy
to read.

In the South America data frame, right-click the Countries layer, and click Properties

Click the Symbology tab

From Show: click on Categories>Unique values

Verify for Value FIeld CNTRY_NAME Iis selected, click Add All Values

The current Color Ramp is "Basic Random", you will change it to a more muted scheme.
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Switch between the graphic display and textual description of the various color ramps
by right-clicking in the Color Ramp window and turning Graphic View off

Select a color ramp that is less intense than the current one - as you are viewing the
text description of the color scheme, select one with the word "Pastel", "Muted", or
"Cool" in the name.

Click OK

The next change you will make is to improve the legibility of the text.

Switch to the ArcMap Display view (at the bottom left of the map window )

If necessary, activate the South America data frame

Note: You have two methods of doing this from the ArcMap Table Of Contents: one is
to right-click on the data frame and click Activate; the other is to press the Alt key while
selecting the data frame with your mouse

Add the Labeling toolbar (Customize > Toolbars > Labeling ).

This toolbar provides you with a single interface from which you can control the label
properties for all of the layers within a single data frame. Given the limited time available
here, you will use only one tool.

Click the Label Manager

Click the Default label classes for each of the layers. Note that the label placement
options change for each different geometry type.

Click the City - Default label class
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Change the Text Symbol settings to: Arial, Bold, font size 9

Click OK

The city text is now a bit more prominent, and therefore easier to read. This change also
pushed the city text upward in the 'visual hierarchy' of the data frame. However, the
'South America' text is still a bit too heavy; also note that this is graphic text, and not
associated with a feature.

Add the Draw toolbar (Customize > Toolbars > Draw).

Use the Select Elements tool on the Draw Toolbar to select the 'South America'
text.

Double-click to open the text properties dialog.

Click Change Symbol

In the Symbol Selector dialog, select the Country 2 font type

Change the font size to 20, Bold, and click OK

Click OK to close the text properties dialog.

Switch back to Layout View

The text elements for this map now have a bit more balance, and more clearly reflect
what the priority of the map is supposed to be. Next you will change some other map
elements.

Step 3: Work with map elements

Considering that the map is intended to show the locations of cities in South America, is
it critical to include a north arrow? How important is it to add a scale bar? Will this map
be used to make distance measurements? If so, how accurate would they be at this scale
on this size of paper? For this map and its intended purpose, you will not add a north
arrow. However, you will change the existing scale bar, and add a graticule to the South
America data frame which will display the Latitude and Longitude coordinates.

Double-click on the Scale bar to select it and open the properties dialog.
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Select the 'Scale and Units' tab

Notice that the Division Units are currently 'Unknown Units'.

From the Division Units drop down list, select Kilometers

From theWhen resizing... drop down list, switch to: Adjust Width

Notice that the Division Value window is now active: change the value to 500 km

This is a nice round number and easy to divide or multiply against the map.

Change the number of divisions to 4 (if necessary)

Change the number of subdivisions to 0
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Click OK to close the scale bar properties dialog.

Select and move the scale bar so that it is centered and just below the South America
data frame.

Next, right-click the South America data frame, and click Properties

Click the Grids tab, and click New Grid.

This will start a wizard which will step you through the graticule creation process. You
will accept the default settings, but take the time to examine the various parameters that
you can set with this wizard.

In the first panel, select Graticule, then click Next

Click Next again in the Create a graticule panel - note the settings you can change here

In the Axes and Labels panel, click the button for Labeling > Text style

Change the text to Times New Roman, size 6, and click Bold

Click OK

Click Next

Click Finish

Click OK in the Data Frame Properties dialog.

The graticule is added to the data frame. You may need to move the South America data
frame in order to fit all of the graticule text on to the page.

You can add text elements with a variety of layout behaviors. Take a moment to hover
your mouse over the various text tools located on the Draw toolbar in order to see the
different text creation options that are available.

Select the Polygon Text tool

On the white space of the map, draw a polygon with any irregular shape you choose -
double-click to finish the drawing

Right-click inside the graphic outline of the New Polygon Text box that you have just
drawn, and click Properties
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Click the Text tab, and enter a sentence or two of text - the amount of text you enter
will be determined by the size of the polygon which you drew.

When you have finished entering some text, click the Frame tab

Click the dropdown list arrow for Border, and add a 1.0 Point line

Click OK

You can add new polygon text anywhere on a map. Where white space is limited, and
you have important textual information which you need to include, you can use this
technique to maximize the available space on your map.

There are many more details which need to be addressed to make this map complete. The
goal of these exercises was to give you a brief introduction to some of the map layout
tools and techniques available in ArcMap 10

Step 4: Challenge Step: Advanced Layout Techniques

Each of the following techniques are located within the data frame properties. The
following instructions will give you the location of the settings, but you are left to your
own creativity when experimenting with these parameters.

Rotate data frame - use this technique where the extent of the data doesn't fit well
inside a rectangle or square.

If you have placed a north arrow inside of the data frame, it will rotate as well. The
rotate data frame input is located at the bottom section of the Data Frame Properties >
General tab.

Extent rectangle - is located on its own tab in the Data Frame Properties.

You have control over the symbology for both the extent rectangle, and the leader lines
which link the corners of the related extents. Keep in mind the nature of the relationships
between the data frames on your map. For example, in today's subject map, you would
not be able to show the extent recangle for the World data frame in the South America
data frame

Clip data frame to shape - use this technique to mask data that falls outside of a
specified area.
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This is a graphic operation only, and does not affect the source data. You will find this
setting at the bottom of the Properties > Data Frame tab. Investigate the different options
for defining the shape that you use to clip.

Conclusion

This is the end of exercise 2. If time allows, feel free to explore other layout properties.
Consult your seminar presenter for suggestions or demonstrations.
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8Exercise 8: Regression Analysis

Estimated time: 45 minutes

Analyzing 911 response data using Regression

This tutorial demonstrates how regression analysis has been implemented in ArcGIS, and
explores some of the special considerations you'll want to think about whenever you use
regression with spatial data.

Introduction
In order to illustrate how the regression tools work, you will be doing an analysis of 911
Emergency call data for a portion of the Portland Oregon metropolitan area.
Suppose we have a community that is spending a large portion of its public resources
responding to 911 emergency calls. Projections are telling them that their community's
population is going to double in size over the next 10 years. If they can better understand
some of the factors contributing to high call volumes now, perhaps they can implement
strategies to help reduce 911 calls in the future.
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Step 1: Getting Started

The steps in this tutorial document assume the tutorial data is stored at C:\SpatialStats. If
a different location is used, substitute "C:\SpatialStats" with the alternate location when
entering data and environment paths.

Open …\RegressionExercise\RegresssionAnalysis911Calls.mxd map document

Make sure that Background Geoprocessing is NOT enabled
(Geoprocessing>Geoprocessing Options)

Step 2: Exploring OLS Regression

The next question our community is probably asking is, "Why are call volumes so high in
those hot spot areas?" and "What are the factors that contribute to high volumes of 911
calls?" To help answer these questions, we'll use the regression tools in ArcGIS.
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Expand the 911 Regression tools and Spatial Statistics tools toolboxes

Instead of looking at individual 911 calls as points, we have aggregated the calls to
census tracts and now have a count variable representing the number of calls in each
tract.
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Right click the ObsData911Calls layer and choose Open Attribute Table

The reason we are using census tract level data is because this gives us access to a rich set
of variables that might help explain 911 call volumes.

Notice that the table has fields such as Educational status, Unemployment levels, etc.

When done exploring the fields, close the table

Can you think of anything … any variable… that might help explain the call volume
pattern we see in the hot spot map?

What about population? Would we expect more calls in places with more people? Let's
test the hypothesis that call volume is simply a function of population. If it is, our
community can use Census population projections to estimate future 911 emergency call
volumes.
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Navigate to the Modeling Spatial Relationships toolset in the Spatial Statistics toolbox,
and run the OLS tool with the following parameters:

Note: Once the tool starts running, make sure the "close this dialog when completed
successfully box" is NOT checked

▪ Input Feature Class: ObsData911Calls
▪ Unique ID Field: UniqID
▪ Output Feature Class: …\RegressionExercise\Outputs\OLS911calls
▪ Dependent Variable: Calls
▪ Explanatory Variables: Pop

Move the progress window to the side so you can examine the OLS911calls layer in
the TOC.

The OLS default output is a map showing us how well the model performed, using only
the population variable to explain 911 call volumes. The red areas are under predictions
(where the actual number of calls is higher than the model predicted); the blue areas are
over predictions (actual call volumes are lower than predicted). When a model is
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performing well, the over/under predictions reflect random noise… the model is a little
high here, but a little low there… you don't see any structure at all in the over/under
predictions. Do the over and under predictions in the output feature class appear to be
random noise or do you see clustering? When the over (blue) and under (red) predictions
cluster together spatially, you know that your model is missing one or more key
explanatory variables.

The OLS tool also produces a lot of numeric output. Expand and enlarge the progress
window so you can read this output more clearly.

Notice that the Adjusted R-Squared value is 0.393460, or 39%. This indicates that
using population alone, the model is explaining 39% of the call volume story.

So looking back at our original hypothesis, is call volume simply a function of
population? Might our community be able to predict future 911 call volumes from
population projections alone? Probably not; if the relationship between population and
911 call volumes had been higher, say 80%, our community might not need regression at
all. But with only 39% of the story, it seems other factors and other variables, are needed
to effectively model 911 calls.

The next question that follows is what are these other variables? This, actually, is the
hardest part of the regression model building process: finding all of the key variables that
explain what we are trying to model.

Step 3: Finding Key Variables

The scatterplot matrix graph can help us here by allowing us to examine the relationships
between call volumes and a variety of other variables. We might guess, for example, that
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the number of apartment complexes, unemployment rates, income or education are also
important predictors of 911 call volumes.

Go to View>Graphs>Create Scatterplot Matrix. Experiment with the scatterplot matrix
graph to explore the relationships between call volumes and other candidate
explanatory variables. If you enter the "calls" variable either first or last, it will appear
as either the bottom row or the first column in the matrix. Select features in the focus
graph and notice how those features are highlighted in each scatterplot and on the map.

Below is an example of scatterplot matrix parameter settings (be sure to set the Layer/
Table parameter to ObsData911Calls):

Exercise 8

Copyright © 2008 ESRI 8-7



Clear selected features, if necessary.

Step 4: A properly specified model

This time you are going to execute the OLS tool from a model.

Right click the OLS: Calls=f(Pop,Jobs,LowEd,Dst2Center) model and pick Edit.
Notice that this model has two tools: OLS and Spatial Autocorrelation
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Double click the Ordinary Least Squares tool to open it.

Check that the tool has the following parameters set.
▪ Input Feature Class: Analysis\ObsData911Calls
▪ Unique ID Field: UniqID
▪ Output Feature Class: …..\RegressionExercise\Outputs\Data911CallsOLS
▪ Dependent Variable: Calls
▪ Explanatory Variables: Pop;Jobs;LowEduc;Dst2UrbCen

The explanatory variables in this model were found by using the Scatterplot matrix and
trying a number of candidate models. Finding a properly specified OLS model, is often
an iterative process. Modeling call volumes as a function of population, jobs, adults who
didn't complete high school, and distance to the urban center, produces a properly
specified model. Let's investigate this.

Close the model. Double click on the model from Toolbox and run the model tool
(running it this way will ensure that the results from the analysis are in the Results
Window).
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Notice that the Adjusted R2 value is much higher for this new model, 0.831080,
indicating this model explains 83% of the 911 call volume story. This is a big
improvement over the model that only used Population.

Step 5: The 6 Things You Gotta Check!

There are 6 things you need to check before you can be sure you have a properly
specified model - a model you can trust.
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1. First check to see that each coefficient has the "expected" sign.

A positive coefficient means the relationship is positive; a negative coefficient means the
relationship is negative. Notice that the coefficient for the Pop variable is positive. This
means that as the number of people goes up, the number of 911 calls also goes up. We are
expecting a positive coefficient. If the coefficient for the Population variable was
negative, we would not trust our model. Checking the other coefficients, it seems that
their signs do seem reasonable. Self check: the sign for Jobs (the number of job positions
in a tract) is positive, this means that as the number of jobs goes <up/down>, the number
of 911 calls also goes <up/down>.

2. Next check for redundancy among your explanatory variables. If the VIF value
(variance inflation factor) for any of your variables is larger than about 7.5 (smaller is
definitely better), it means you have one or more variables telling the same story. This
leads to an over-count type of bias. You should remove the variables associated with
large VIF values one by one until none of your variables have large VIF values. Self
check: Which variable has the highest VIF value? <POP, JOBS, LOWEDUC,
DST2URBCEN>
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3. Next, check to see that all of the explanatory variables have statistically significant
coefficients.

Two columns, Probability and Robust Probability, measure coefficient statistical
significance. An asterisk next to the probability tells you the coefficient is significant. If a
variable is not significant, it is not helping the model, and unless theory tells us that a
particular variable is critical, we should remove it. When the Koenker (BP) statistic is
statistically significant, you can only trust the Robust Probability column to determine if
a coefficient is significant or not. Small probabilities are "better" (more significant) than
large probabilities. Self check: Which variables have the "best" statistical significance?
Did you consult the Probability or Robust_Pr column? Why?

Note: An asterisk indicates statistical significance!
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4. Make sure the Jarque-Bera test is NOT statistically significant:

The residuals (over/under predictions) from a properly specified model will reflect
random noise. Random noise has a random spatial pattern (no clustering of over/under
predictions). It also has a normal histogram if you plotted the residuals. The Jarque-Bera
test measures whether or not the residuals from a regression model are normally
distributed (think Bell Curve). This is the one test you do NOT want to be statistically
significant! When it IS statistically significant, your model is biased. This often means
you are missing one or more key explanatory variables. Self check: how do you know
that the Jarque-Bera Statistic is NOT statistically significant in this case?

5. Next, you want to check model performance:

The adjusted R squared value ranges from 0 to 1.0 and tells you how much of the
variation in your dependent variable has been explained by the model. Generally we are
looking for values of 0.5 or higher, but a "good" R2 value depends on what we are
modeling. Self Check: go back to the screen shot of the OLS model that only used
Population to explain call volume. What was the Adjusted R2 value? Does the Adjusted
R2 value for our new model (4 variables) indicate model performance has improved?
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The AIC value can also be used to measure model performance. When we have several
candidate models (all models must have the same dependent variable), we can assess
which model is best by looking for the lowest AIC value. Self Check: go back to the
screen shot of the OLS model that only used Population. What was the AIC value? Does
the AIC value for our new model (4 variables) indicate we improved model performance?

6. Finally (but certainly NOT least important), make sure your model residuals are free
from spatial autocorrelation (spatial clustering of over and under predictions).
▪ Right click the OLS: Calls=f(Pop,Jobs,LowEd,Dst2Center) model and pick Edit.
▪ Double click the Spatial Autocorrelation tool to see the parameters:

The Output Feature Class from the OLS tool contains a field called Std Resid
(Standardized Residuals) measuring the under and over predictions from the model. The
Spatial Autocorrelation tool tests to see if the residuals exhibit spatial clustering, or if
they reflect random noise (a random pattern).

To see the HTML output from the Spatial Autocorrelation tool we have to go to the
results window.
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Expand the results, and double click on the HTML output.

The graphic tells you that the residuals (over/under predictions) are random. This is good
news! Anytime there is structure (clustering or dispersion) of the under/over predictions,
it means that your model is still missing key explanatory variables and you cannot trust
your results. When you run the Spatial Autocorrelation tool on the model residuals and
find a random spatial pattern, you are on your way to a properly specified model. Notice,
too, that the map of residuals appears much less clustered than it did with only the
Population variable.
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Find the Regression Analysis Basics online documentation (Search for Regression
Analysis Basics at http://help.arcgis.com/en/arcgisdesktop/10.0/help), and look for the
table called "How Regression Models Go Bad". In this table there are some strategies
for how to deal with spatially Autocorrelated regression residuals:

Optional work to be completed after class: run OLS on alternate models. Use "Calls"
for your dependent variable with other variables in the ObsData911Calls feature class
for your explanatory variables (you might select Jobs, Renters, and MedIncome, for
example). For each model, go through the 6 checks above to determine if the model is
properly specified. If the model fails one of the checks, look at the "Common
Regression Problems, Consequences, and Solutions" table in the "Regression Analysis
Basics" document shown above to determine the implications and possible solutions.

Step 6: Running GWR

One OLS diagnostic we didn't say very much about, is the Koenker test.
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When the Koeker test is statistically significant, as it is here, it indicates relationships
between some or all of your explanatory variables and your dependent variable are non-
stationary. This means, for example, that the population variable might be an important
predictor of 911 call volumes in some locations of your study, but perhaps a weak
predictor in other locations. Whenever you notice that the Koenker test is statistically
significant, it indicates you will likely improve model results by moving to
Geographically Weighted Regression.

The good news is that once you've found your key explanatory variables using OLS,
running GWR is actually quite simple. In most cases, GWR will use the same dependent
and explanatory variables you used in OLS.

Run the Geographically Weighted Regression tool with the following parameters
(open the side panel help and review the parameter descriptions):
▪ Input feature class: ObsData911Calls
▪ Dependent variable: Calls
▪ Explanatory variables: Pop, Jobs, LowEduc, Dst2UrbCen
▪ Output feature class: …\RegressionExercise\Outputs\GWRResults
▪ Kernel type: ADAPTIVE
▪ Bandwidth method: AICc (you will let the tool find the optimal number of

neighbors)
▪ Additional Parameters:

▪ Coefficient raster workspace: …\RegressionExercise\Outputs\Raster
▪ Output cell size: 135

Run GWR.

This might take a while to finish. GWR generally runs quickly, but in this case we have
asked it to determine the optimal number of neighbors, which means a variety of
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neighbor values will be tested. We are also creating a raster surface for each explanatory
variable. Writing these surfaces can take several minutes.

Notice the output from GWR:

Neighbors           : 50
ResidualSquares     : 7326.27931715036
EffectiveNumber     : 19.863531396247385
Sigma               : 10.446299891967717
AICc                : 674.6519110481873
R2                  : 0.8957275343805387
R2Adjusted          : 0.8664297924843125

GWR found, applying the AICc method, that using 50 neighbors to calibrate each local
regression equation yields optimal results (minimized bias and maximized model fit).
Notice that the Adjusted R2 value is higher for GWR than it was for our best OLS model
(OLS was 83%; GWR is almost 86.6%). The AICc value is lower for the GWR model. A
decrease of more than even 3 points indicates a real improvement in model performance
(OLS was 680; GWR is 674).

Close the progress window. Notice that, like the OLS tool, GWR default output is a
map of model residuals. Do the over and under predictions appear random? It's a bit
difficult to tell.
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Run the Spatial Autocorrelation tool on the Standardized Residuals in the Output
Feature Class. The Spatial Autocorrelation tool is in the Analyzing Patterns toolset
within the Spatial Statistics Toolbox:

Go to the results window, expand the results from the last run of Spatial
Autocorrelation, and double click on the HTML output. Are the residuals randomly
distributed? (yes and this indicates we have a properly specified model)
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Notice that GWR has added a coefficient surface for each of your explanatory
variables, to the TOC. Uncheck all of the layers in the TOC down to the Pop surface
and notice the light and dark areas of the surface raster. The light areas are places in
the study area where the Pop explanatory variable is a very strong predictor of 911 call
volume. The dark areas are locations where that variable is less important. The graphic
below shows the coefficient surface for the Dst2UrbCen explanatory variable:
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Your map document includes raster surfaces that have been rendered for you. Turn
everything off, and turn ON the Coefficient Surfaces group. View the surface for the
Low Education variable:

The red areas are locations where the low education variable is a strong predictor of the
number of 911 calls. The blue areas are locations where low education isn't very strong.
Suppose your community decides that, as a way to reduce 911 calls, as well as to promote
overall community benefits, they are going to implement a program designed to
encourage kids to say in school. They certainly could apply this new program to the
entire community. But if resources are limited (and resources are always limited), they
might elect to begin a rollout for this new program in those areas where low education
has a strong relationship to 911 call volumes (the red areas).

Anytime the variables in your model have policy implications or are associated with
particular remediation strategies, you can use GWR to better target where those polices
and projects are likely to have the biggest impact.

Conclusion

You used Ordinary Least Squares (OLS) regression to see if population alone would
explain 911 emergency call volumes. The scatterplot matrix tool allowed you to explore
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other candidate explanatory variables that might allow you to improve your model. You
checked the results from OLS to determine whether or not you had a properly specified
OLS model. Noting that the Koenker test was statistically significant, indicating non-
stationarity among variable relationships, you moved to GWR to see if you could
improve your regression model. Your analysis provided your community with a number
of important insights:

▪ Hot Spot Analysis allowed them to evaluate how well the fire and police units are
currently located in relation to 911 call demand.

▪ OLS helped them identify the key factors contributing to 911 call volumes.
▪ Where those factors suggested remediation or policy changes, GWR helped them

identify the neighborhoods where those remediation projects might be most
effective.

To learn more about OLS and GWR see "Regression Analysis Basics" in the online help.
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9
Teaching science,

technology,
engineering and math
(STEM) with ArcGIS

Exercise 9: Exercise
Estimated time:





9Exercise 9: Exercise

Estimated time:

What is GIS?
▪ Geographic Information Systems (GIS) allows us to view, understand, question,

interpret, and visualize data in many ways that reveal relationships, patterns, and
trends in the form of maps, globes, reports, and charts. A GIS helps you answer
questions and solve problems by looking at your data in a way that is quickly
understood and easily shared.
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Why Use GIS in Science, Technology, Engineering, and Mathematics Education?
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▪ GIS provides an excellent way to teach STEM concepts and skills. Solving
problems in a GIS environment allows students to grapple with biodiversity,
crime, natural hazards, climate, energy, water, and other relevant real-world issues
of the 21st Century. Students often do not feel that what they are learning is
relevant to what they will be doing after they get out of school. Hundreds of jobs
in geospatial technologies—not just surveyors and remote sensing
analysts—require analytical, statistical, and computational skills that are learned
in STEM education.

▪ Starting with mathematics, the value of visualizing numbers is affirmed
throughout the US Principles and Standards for School Mathematics. These
standards were designed by the National Council of Teachers of Mathematics
(NCTM). Representing numbers, understanding patterns, relationships, and
function, 2-D and 3-D geometric and spatial relationships, probability, statistics,
change, models, measurements, problem solving, reasoning, connections, and
communications are critical concepts. Every one of these can be explored using
GIS tools and methods. Comparing graphs and maps of birth and death rates over
time and region, analyzing the response of a stream to a recent storm through a
real-time hydrograph, and creating cross-sections of terrain are three common
activities in geography instruction, easily done in a GIS environment. All of
them—and thousands more geographic activities—involve analyzing numbers.
One might say that GIS is visualizing numbers, since its basis is representing
numbers as cells, points, lines, or polygons on a map.

▪ NCTM's curricular "focal points" also connect well with GIS. A focal point must
pass three rigorous tests: Is it mathematically important, both in mathematics and
for use in applications in and outside of school? Does it "fit" with what is known
about learning mathematics? Does it connect logically with the mathematics in
earlier and later grade levels? When we connect latitude and longitude to the
Cartesian coordinate system, when we measure area, shape, size, and distance in
different map projections, when we compare geometric to exponential growth
rates of agricultural output, even when we explain the Earth's shape, rotation, and
revolution, we are applying geographic and mathematical concepts and can use
GIS to teach it.

▪ The use of GIS brings math to life by making math visual. Think of common
problems such as: "Where and when will these trains cross paths? One departs
Point A at 6:00am and heads toward Point B at 70kph, while the other departs
Point B at 6:30am bound for Point A at 60kph." Where and when will they cross
paths?" GIS allows the anchoring of these and other problems in the real world:
Points A and B could be Cheyenne and Casper, and students can determine and
plot the course and passing point at a real point on a GIS map layer.

▪ These connections between spatial analysis and mathematics have deep historical
roots: Willis Ernest Johnson wrote Mathematical Geography back in 1908, and
Eratosthenes connected geography to mathematics in measuring the Earth's
circumference over 2,200 years ago!
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▪ With GIS, students investigate real issues that are critical to the world—on a daily
basis. It is difficult to think of a topic that is as critical as some of the
fundamentals of science education, such as climate, biodiversity, water, energy,
and natural hazards. As an example, climate underpins our agriculture,
biodiversity, and our very civilization. GIS is a perfect tool for studying climate
first because GIS was created to be an inquiry-based, problem-solving toolkit.
Second, climatic variables are intricately tied to locations and affected by spatial
relationships—mountains, ocean currents, depressions, vegetation, human impact,
and much more. Through GIS, students use maps, satellite images, graphs, and
databases that are focused on the question of "where," to analyze patterns, trends,
and influences, in the past, present, and future.

▪ GIS can extend your students' investigations into the natural world, leveraging
mapping and analysis tools to better understand and explore the Earth. Whether
students are studying atmospheric science, geology, oceanography, or any other
Earth systems science, GIS is the best approach to making sense of spatial data.

▪ GIS is fundamental to teaching with Technology not only because GIS is a
technology-based tool, but because it is a holistic, integrated technology. Students
using GIS must understand data types and formats, be able to integrate disparate
data sets, must manage error, understand how to organize and catalog their data,
output their data, use data to make a decision in a problem-solving environment,
and be able to help others understand their data. GIS incorporates multimedia,
mobile, and telecommunications devices. GIS can be used in engineering
education as well, because measurement, calculation, physical processes, and
other concepts and skills go far beyond CAD to 2D and 3D design with GIS.

Learning Objectives Include:

1. Understand the linkages that exist between GIS and STEM education.
2. Gain confidence that you can teach STEM using GIS.
3. Practice using some STEM-related GIS lessons.

Step 1: Secondary School Math 1: Coordinates

Spatial Math: Analyzing Coordinates: High Secondary: 1 of 5
Name: ________________

Summary: In this lesson, you will use Geographic Information Systems (GIS) to study
coordinates.

Objectives: Develop practical skills in using coordinates within a GIS framework,
addressing, understanding latitude and longitude and their relationship to coordinates,
understand precision and coordinates, and use different units of measurement.
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Software: ArcGIS from ESRI.
Level: 20 Questions. Grade 9 through 12. Ages: 13 through 18.
Activity: Start ArcMap. Use File, Open to open the file worldreference_hd.mxd.
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Coordinates are positions in a two-dimensional plane or a three-dimensional surface
that help us determine where things are on the Earth's surface. Coordinate systems
have an origin and a set of axes. Everything in the coordinate system is referenced off
of that coordinate system. A street address is one type of coordinate. In a metropolitan
area, each address is referenced off of a point of origin where the addresses begin. This
could be a real place (such as 1st Avenue and Main Street) or an imaginary one (such
as a point 1 mile off of the western shore of a city). At the origin, addresses could start
at zero, or they may start at 100, or some other number.
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▪ 1) What is the address of your school? _______________________________.
▪ 2) Do you know where the addressing system of your city or community begins?

_________. Where does it begin? _____________________________________
_________________________________________________________________.
If you don't know where the addressing system begins, do some research and find
out. Some things on the Earth have no street address.

▪ 3) Name 3 things in your neighborhood with no street address:
____________________________________________________________.
____________________________________________________________.
____________________________________________________________.
Even for those things without a street address, we can still locate them on the
Earth's surface, but we need to use a different kind of coordinate system. We can
use the coordinate system called latitude and longitude.
Move your mouse on the map, noting the X and Y values in the lower right. These
values are in degrees (shown by the ° symbol, even though the symbol is not
shown on your map). In the latitude-longitude system, degrees is a position, not a
temperature. The X is longitude, and the Y is latitude.

▪ 4) Where on the Earth's surface is 0° latitude 0° longitude located? ___________.
▪ 5) What continent is near this point?______________.
▪ 6) What is the 0 latitude line called? ____
▪ 7) What continents does the 0 latitude line intersect? _______________________.
▪ 8) What is the 0 longitude line called? _______________________.
▪ 9) What continents does the 0 degree longitude line

intersect?___________________.
▪ 10) What is the latitude of the North Pole? __________.

What is the latitude of the South Pole? ____________________.
▪ 11) How is latitude-longitude like the Cartesian Coordinate System?

____________
__________________________________________________________________.

▪ 12) How is latitude-longitude different from the Cartesian Coordinate System?
___
_____________________________________________________________________.
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Make the map layer "LatLong" visible by checking its box. Right click or double
click on this map layer ' Properties ' Labels, as above. Select the drop-right arrow
and label features using the "VALUE" field. Label countries in a similar way.
Zoom to where you live.

▪ 13) What is your latitude (include north or south)? _______________.
What is your longitude (include east or west): ___________________.

▪ 14) Use Find with the Features tab, as shown below.
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Right click on the first link and zoom to the Caspian Sea.
What is the latitude-longitude of the Caspian Sea? ___________
What is the latitude-longitude of the country of Tokelau?
____________________.

▪ 15) Circle which is further south:
Madagascar or Uruguay? Circle which is further north: Great Bear Lake or Lake
Baikal?

▪ 16) What country is at the following intersections?
30 North, 30 East: _______________.
20 South, 60 West: ______________. Note below the map that latitude and
longitude are divided into fractional units for greater precision.

▪ 17) What latitude is the long straight section of the US-Canada border to the
nearest tenth of a degree? _______________.
What is the latitude and longitude of Gibraltar to the nearest hundredth of a
degree?
___________________________________________________________. 18)
Use measure with the distance drop-down with kilometers to answer the following
questions, as shown below:
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What distance (in km) is 5 degrees of longitude at the Equator?
____________________ What distance (in km) is 1 degree of longitude at the
Equator? (Show your work):
________________________________________________________________
.What distance (in km) is 0.1 degree of longitude at the Equator? (Show your
work):
__________________________________________________________________
__________________________________________________________________.
Note that the coordinates go up to 5 decimal places.

▪ 19) What is the distance of 0.00001 degree at the Equator, in kilometers? Show
your work:
_________________________________________________________
What is the distance of 0.00001 degree at the Equator, in meters? Show your
work:
____________________________________________________________________________________________________________________________________.

▪ 20) Summarize what you have learned about coordinates using a GIS:
__________________________________________________________________
__________________________________________________________________.

Step 2: Secondary School Math 2: Measurement

Spatial Math: Exploring Measurement: High Secondary: 2 of 5
Name: __________________________

Summary: In this lesson, you will use GIS for measurement.
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Objectives: Understand measurement concepts and practice skills, use different units
of measure, use measurement in calculations, use map projections, use measurement in
tabular and spatial forms with selections and buffers in a GIS environment.

Software: ArcGIS, from ESRI.

Level: 20 Questions. Grade 9 through 12. Ages: 13 through 18.
Activity: Start ArcMap. Use File, Open to open the us_hd.mxd file.

Measurement is a core concept in mathematics and in all of life. Measurement
underlies everything that is done on maps and in a GIS, because all data is grounded in
a coordinate system and map projection, which is a surface that is anchored to real-
world coordinates.
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Use Find and Measure using the cities layer.
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▪ 1) What is the distance from Bemidji to New Orleans in miles? _______.
What is the distance from Bemidji to New Orleans in kilometers? ________.

▪ 2) What is the distance between the two cities if you had to follow the river that
flows from Bemidji to New Orleans? ____________km.

▪ 3) Why is this distance longer than your answer in the previous question?
__________________________________________________________________.

▪ 4) What river connects the two cities? __________________.
What direction does the river flow toward? _______________________.

▪ 5) If you could canoe this river at 10km/hour, how long would it take you to travel
from Bemidji to New Orleans? Show your work and indicate the units.
_________________________________________________________________
_________________________________________________________________.

▪ 6) In what states does this river begin and end?
Begins in: _____________. Ends in: _______________. Clear the selection.
Set the selectable layers (Selection--> Set Selectable Layers) to rivers only, as
shown below:

Select the river by clicking on a segment of the river with the selection by
rectangle tool. The entire river should be highlighted.Use Select By Location
to select the cities within 10 miles of this river, as shown below:
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▪ 7) How many cities are =< 10 miles from the river? _____________
What percentage of the total number of cities in the database are less than 10
miles from the river? Show your work: ________________________________
_______________________________________________________________.

▪ 8) Which of the cities < 10 miles from the river has the largest population
(POP2000)?____________.

▪ 9) How many of these people do you think are susceptible to flooding from the
river? ___________. Why?
_______________________________________________.
In the cities attribute table, click on Selected underneath the table, and in the
selected cities that appear, right click on POP2000 and Sort Descending to answer
the following question:

▪ 10) Which city < 10 miles from the river has the smallest population?
________________.
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▪ 11) What is the range of the populations of these two cities? ________________.
Clear your city selections.
Say you need to assess earthquake hazards on Memphis and surrounding cities.
Use similar techniques as you worked with above to select cities within 100 miles
of Memphis.

▪ 12) Of all of the cities in the database, how many are within 100 miles of
Memphis? ___________.
In what states are these cities located? _________________________________.
Your map is in the Albers Equal Area map projection, a projection that does a
good job of displaying map features accurately according to their area.Take a
good look at your map before you change it in the following step.Use View' Data
Frame Properties ' Coordinate System 'Clear.

▪ 13) Describe how your map changed:
_____________________________________.

▪ 14) Measure the straight line distance between Bemidji to New Orleans again in
miles: _________________.
Why is your answer different from that you wrote in question 1 earlier? ______
_______________________________________________________________.

▪ 15) Feel free to consult other sources to help answer the following: Why does map
projection affect measurement? ________________________________________
________________________________________________________________.

▪ 16) Measure the perimeter of Utah by clicking, dragging, and letting go of
each of the sides of the state: ___________ miles.
Calculate Utah's area and show your work: _______________________________
________________________________________________________square
miles.

▪ 17) Was your measured value more or less than the actual value for Utah's area in
the state attribute table (SQMI)? _________.

▪ 18) Angela's measurement for Utah of 90,000 square miles differed from the
actual value by ((90,000-84,872/84,872) * 100) = [fill in the
blank]___________________________________________________________
%.
How close is your measured value to the actual value? Show your work: ______
____________________________________________________%. Why was
there a difference? _________________________________________.

▪ 19) What rank is Utah's areal size (SQMI) amongst all states in the USA?
________________.

▪ 20) Write your own measurement question: ______________________________
____________________________________________________________.
Solve your question: ________________________________________________
_____________________________________________________________________.
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Step 3: Secondary School Math 3: Scale

Spatial Math: Studying Scale: High Secondary: Lesson 3 of 5
Name: __________________________
Summary: In this lesson, you will use Geographic Information Systems (GIS) to work
with scale.

Objectives: Understand and practice using scale on maps, understand the relationship
between scale, size, ratios, and fractions, use GIS to work with scale.

Software: ArcGIS, from ESRI.

Level: 20 Questions. Grade 9 through 12. Ages: 14 through 18.
Activity: Open ArcMap. Use File, Open to open the world_hd.mxd file.
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Scale is an important concept not only in making and using maps but also in everyday
life. Scale on maps does not refer to how much the map weighs, but how detailed the
map is, and what size map features can be seen on the map, such as countries, rivers, or
cities. Scale helps us understand how large or small a phenomenon or an object is.
Make all layers visible. Right or double click on countries and use Properties' Labels to
label countries using the CNTRY_NAME field.
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▪ 1) What is the scale, indicated by the numbers that are given in the scale window

located on a toolbar near the map? ________.
This number means that 1 inch (or 1 centimeter) on the map is equivalent to the
number of inches (or centimeters) indicated by the number in the scale, on the
Earth's surface.

▪ 2) Fill in the blank: A scale of 1:170,000,000 means that 1 cm on the map is
equivalent to __________________ cm on the ground.

▪ 3) What happens to the scale as you zoom in -does the number get larger or
smaller? Circle your answer: Larger or Smaller.

▪ 4) Does the total quantity represented by the fraction (or ratio) become larger or
smaller as you zoom in? Circle your answer: Larger or Smaller
Right or double click on the Lakes layer and open the Lakes attribute table. Sort
on the SQKM (Square Kilometers) field to find the name of the smallest lake in
the world, according to this data set.

▪ 5) What is the name of this lake? ______________________.
On the map, use to Find this lake (use Find features, as shown below) and
zoom to it.

Education User Conference 2010

9-18 Copyright © 2008 ESRI



You must spell it exactly like it appeared in the table you opened earlier,
including all punctuation, with case sensitivity.

▪ 6) What is the minimum map scale that allows you to see all of this
lake?_________________.

▪ 7) In what country is this lake located? _______________________________.
▪ 8) On what continent is this lake located? _______________________________.
▪ 9) What is the name of the larger lake about 20 km (use measure) to the northwest

of this lake? __________________________.
▪ 10) Enter the following in the scale window: 20000000. (20 million). What is the

nearest city with a population rank of 3 (POPRANK) to these lakes?
__________________.

▪ 11) Fill in the blank: A large-scale map shows much detail but little area; a small-
scale map shows much area but little ________________.
Think of the colon ":" in the scale as a fraction.

▪ 12) Which is larger: 1:10 (1/10) or 1:100 (1/100) of a pizza?
Circle your answer: 1/10 or 1/100.

▪ 13) Which map is "large scale"-Canada, or the map of the lake you made earlier?
Circle your answer: Canada or The Map of The Lake
Enter 1:1 in the scale window. On the map, zoom out . Dragging small
rectangles will zoom you out faster.
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▪ 14) Why were you zoomed in so far at 1:1? ______________________________
__________________________________________________________________.

▪ 15) If you made a map at 1:1 scale of your classroom, how big would the map be?
__________________________________________________________________.
Would such a map be easy to fold? _______ Why or why not?
________________
__________________________________________________________________.
This is why map scale is important-we usually scale things in the real world down
so that they will fit on a map.

▪ 16) What scale is suitable for studying Canada (use Find)?
____________________
What scale is suitable for studying Estonia?
_______________________________.What scale is suitable for studying your
school building? _____________________.

▪ 17) What scale allows you to see both the cities of Jaipur and Kanpur?
___________.
What scale allows you to see both the cities of Annapolis and Baltimore?
____________.

▪ 18) Fill in the blank: To study something smaller in size, the scale that you need
becomes ________________________.

▪ 19) Circle the correct answer: Scale and size have what kind of relationship?
Direct or Inverse?

▪ 20) Formulate your own question about scale: ____________________________
_________________________________________________________.
Answer your question:
________________________________________________
__________________________________________________________________.

Step 4: Secondary School Math 4: Classification

Spatial Math: Investigating Classification: High Secondary: 4 of 5
Name: ______________________________

Summary: In this lesson, you will use Geographic Information Systems (GIS) to
investigate classification.

Objectives: Understand and use different classification methods, understand how
classification is related to data, make maps using different classification methods and
understand how and why those methods differ, use standard notation, mean, standard
deviation in conjunction with classification.

Software: ArcGIS, from ESRI.
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Level: 20 Questions. Grade 9 through 12. Ages: 14 through 18.
Activity: Open ArcMap. Use File, Open to open the worldelev_hd.mxd file.
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Classification refers to how we split up data into classes in order to make sense of data.
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▪ 1) Circle your answer: Which map layer is classified: Circle your answer:
elev_image or elevation?
How do you know which layer is
classified?____________________________________.

▪ 2) How many classes of elevation exist? ________.
▪ 3) What is the elevation range? ___________.
▪ 4) Are the elevation units in feet or in meters? ______
▪ 5) How do you know what the elevation units are?

___________________________________________.
Label countries based on CNTRY_NAME. Use Find if you need to.

▪ 6) What country has a higher average elevation? Circle your answer:
Kyrgyzstan or Turkmenistan?

▪ 7) What country has a higher average elevation? Circle your answer:
Ethiopia or Congo? Use Identify to answer the following:

▪ 8) What is the Elevation code for the class corresponding to the highest elevation?
___.
As shown below, right or double click on the Elevation map layer - Properties -
Symbology - Change from Unique Symbols to Graduated Colors on Elev_Code.
OK.

▪ 9) Describe your map: _____________________________________________.
Change the symbology to Unique Value and observe your map.
Change the symbology back to Single Symbol. 10) What is the difference
between maps symbolized by: Single Symbol, Unique Symbols, and Graduated
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Symbols? __________________________________________
______________________________________________________________________.
Turn off Elevation. Change symbols of the Country map layer to Graduated
Colors on Field (value) POP2005 (Population in 2005). Countries will be
classified under the Natural Breaks classification method. In the Symbology
window, click on Classify and observe the histogram:

11) Why are there so many records in the first class?
___________________________ ________________________________.Give
the following 3 answers in standard (not exponential) notation. 12) What is the
mean population of world countries? _________________. What is the Standard
deviation of the population of world countries? ________________.
What is the total world population according to this data set? ________________.
13) Press OK and describe your map:
_______________________________________ ________________________.
14) In your opinion, does this map help you understand population patterns?
________. Why or why not?
________________________________________________________
___________________________________________________________.15) Use
"Classify" and change to Quantile, again noting the histogram. What does
"quantile" mean? You may need to look it up in Help or in some other source. ___
______________________________________________________________________.16)
Is this quantile map more helpful than the Equal Interval map? __________.
Why? __________________________________. Change the Symbols to Manual.
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17) What manual class breaks make the most useful map?
__________________________________________.18) How many classes do
you believe are optimal? ______. Why?
__________________________________.
19) Circle the most useful, in your opinion, classification method for this
population data:
Equal Interval, Quantile, or Manual.
Give at least 2 reasons why you believe this classification method to be the most
useful:
_____________________________________________________________________.
20) Create your own classification question:
_____________________________.Answer your
question:_________________________________________.

Step 5: Secondary School Math 5: Data Analysis

Spatial Math: Analyzing Data: High Secondary: Lesson 5 of 5
Name: ____________________________
Summary: In this lesson, use Geographic Information Systems (GIS) to analyze data.

Objectives: Understand and use databases, use rank, buffer, range, calculations, and
relationships in tables and on maps in a GIS environment.

Software: ArcGIS, from ESRI.
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Level: 20 Questions. Grade 9-12. Ages: 14-18.
Activity: Open ArcMap. Use File, Open to open the world_hd.mxd file.

A GIS allows you to analyze data in many ways, by attribute and by its location. Each
map layer contains an attribute table behind it, stored as a database.

Use the check boxes to make the layers visible. Right or double click on the map layer
"Country" ' Properties ' Labels and label using CNTRY_NAME.
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Right or double click on each layer to open the attribute tables. Each row in the table
corresponds to a feature on the map (city, river, etc.).
Sort any column by right clicking on it and choosing Sort Ascending or Sort
Descending.
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▪ 1) How many lakes are in the database? ___________.
▪ 2) What is the name and depth of the highest (SURF_ELEV) lake in terms of

elevation?
Name:__________________.
Depth: _________________.
Are the elevations in feet or meters? ______________How do you know what the
elevation units are? ____________________________.Go to the left side of the
table, then right click on this row in the table, and zoom to the lake.

▪ 3) In what 2 countries is this lake located? ______________________________.
▪ 4) How does this lake rank among world lakes in total size (SQKM)? ________
▪ 5) How does this lake rank among world lakes in DEPTH? _______.

Let's say you want to assess the impact of nearby population on this lake. Use
Selection' Select By Attributes, and select cities that are within 100 km of the
lake, as shown below.
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Open the cities attribute table, and choose "Selected" to see only the selected
cities.

▪ 6) What 2 cities are within 100km of this lake?
____________________________.

▪ 7) What is the population range (POP_CLASS) of the two cities? ________.
Right or double click on Rivers ' Properties' Symbols' by length in kilometers as
shown below.

Click on Classify to answer the following questions.
▪ 8) What is the mean length of the world's major rivers? _______km.
▪ 9) What is the total length of the world's major rivers? ________km.
▪ 10) If you could kayak 50 km per day, how long would it take you to kayak all of

the world's major rivers, in days? Show your work: ________________________
_______________________________________________________________.
How many years would it take you to kayak the rivers? Show your work: _______
______________________________________________________.
How old will you be when you finish kayaking the rivers? Show your work:
_______ ____________________________________________________.

▪ 11) What are the 4 longest rivers in South America? _______________________
_________________________________________________________________.

▪ 12) What direction does the Amazon River flow?
From ______________ to _______________. Next, examine cities.

▪ 13) Circle the correct word:
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The lower the population rank, the city size is larger | smaller. As shown below,
use Selection' Select By Attribute to select cities with a population rank of 1 or 2.
For best results, select everything that you need to build your expression from the
lists, rather than typing it. Use "Get Unique Values" so that you can pick the
values from the list rather than typing them in.

▪ 14) How many cities have a rank of 1 or 2? ______.
Press Statistics for POP_RANK.

▪ 15) What is the mean population rank? ______.
Close the box, Press Execute, and return to your map. If prompted, indicate "Yes"
that you wish to see all of the records.

▪ 16) Describe the pattern of these "rank 1 and 2" most populous cities on your
map:
__________________________________________________________________.

Education User Conference 2010

9-30 Copyright © 2008 ESRI



What continent contains the most of these most populous cities? ____________.
Observe the latitude and longitude values below your map as you move the
mouse.

▪ 17) Circle the correct word:
Latitude has a positive | negative effect on city location. Why?
____________________________________________________.

▪ 18) What city in the world is farthest north? __________________.
What is its latitude? ______________.

▪ 19) What city in the world is farthest south? __________________.
What is its latitude? ______________.

▪ 20) Create your own data analysis question:
_____________________________________________.
Answer your question:
________________________________________________ _______________.

Step 6: Secondary School Math 6: Land of Cartesia

Spatial Math: The Land of Cartesia: Exploring the Cartesian Coordinate System and
Geometry
Name: ______________________________
Summary: Use GIS to explore the Cartesian Coordinate System and geometry.
Objectives: Understand and use coordinates, axes, shapes, measurements, and values
in the Cartesian Coordinate System and understand how the system relates to the
latitude longitude system.
Software: ArcGIS, from ESRI.
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Level: 20 Questions. Grade 9-12. Ages: 14-18.
Activity: Open ArcMap. Use File Open to open the 10gridpn_hd.mxd file.
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▪ Welcome to the land of Cartesia! The Cartesian Coordinate System is more than a
useful system for modeling concepts and formulas in mathematics. It is related to
the coordinate system for the planet, latitude-longitude. Let's explore the system
and then relate it to the planet.
The Cartesian Coordinate System Use the check boxes to make the map layers
visible. Move the mouse to the middle of the map. Observe the coordinates
underneath the map as you move the mouse around.

▪ 1) What is the X and Y coordinate shown at the center point of the map?
X: _____________.
Y:_____________.
What is the X and Y coordinate shown at the top right point of the map?
X: _____________.
Y:_____________.
What is the X and Y coordinate shown at the bottom left point of the map?
X: _____________.
Y:_____________.
Use measure and change the units to meters to answer some of the following
questions:

▪ 2) What is the length of the X and Y axes in meters?
X:_____________.
Y:_____________.

▪ 3) Use the Pythagorean Theorem to determine the distance from (0,0) to (10,10)
and show your work:
______________________________________________________.
Check your answer using the measure tool.
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▪ 4) What is the measurement from the measure tool? _________.
Is this answer the same as the answer you computed with the Pythagorean
Theorem? ____________.

▪ 5) Why might your measured answer be slightly different from your computed
answer? ___________________________________.
Use Selection' Set Selectable Layers to make sure that you only select points in
the next step:

Highlight the map layer "points". Select the (0,0) point.Access ArcToolbox.
Use the Analysis tools' Proximity' Buffer to buffer this point by 1 meter, as shown
below. Store the results buffer as a feature class in the geodatabase that you have
been using for this lesson.
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▪ 6) What shape is your buffer? ________.
▪ 7) How wide is your buffer? _________.
▪ 8) What is the radius of your buffer? __________
▪ 9) Compute the area of your buffer (show your work): ___________________

______________________________.
Behind each map layer is a table of data, stored in a database. Each row in the
table corresponds to a feature on the map. Right or double click on each layer to
open the attribute tables. Use the attribute table information to circle the correct
answer:

▪ 10) What lines are analogous to latitude lines on a map? Circle your answer:
(A) Lines connecting points having the same X value,
or
(B) Lines connecting points having the same Y value. What lines correspond to
longitude lines? Circle your answer:
(A) or (B) above?
Now, think about the Earth.

▪ 11) What line on the Earth is the major east-west line and therefore corresponds to
the Cartesian X axis? ___________________.
What line on the Earth is the major north-south line and therefore corresponds to
the Cartesian Y axis? _____________________. Examine the attribute tables.

▪ 12) What is another name for a latitude line? _____________________
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Why do you think this name is appropriate? _______________________. Are
these lines parallel on the Earth? ____________________.
Why or why not?
____________________________________________________.

▪ 13) What is another name for a longitude line? ____________________.
Are these lines parallel on the Earth? _________________. Why or why not?
____ ____________________________.

▪ 14) What is the total area of Polygon I? (indicate units) _____________________.
▪ 15) What is the perimeter of the entire map? ___________.
▪ 16) If your map represented the Earth with the X and Y axes equal to the latitude

and longitude lines you indicated above, what 2 polygons correspond to the
western (W) hemisphere? Circle your answer:
I II III IV. What 2 polygons correspond to the northern (N) hemisphere? Circle
your answer: I II III IV.

▪ 17) Circle your answer:
If you lived in the N and W hemisphere,
your latitude would have a Positive | Negative value
and your longitude would have a Positive | Negative value. The Cartesian
Coordinate System for the World: Latitude-LongitudeIn the table of contents on
the left that shows your map layers, you have been working in a data frame called
the Cartesian Coordinate System:

Notice that you have another data frame listed, called "World".

Right click on it and Activate it. You should see world countries with a latitude-
longitude grid.The coordinates under the map are in latitude and longitude. You
should know based on your earlier work which number is the latitude and which

Education User Conference 2010

9-36 Copyright © 2008 ESRI



number is the longitude value.Label countries on the value CNTRY_NAME.
Move your mouse to the USA.

▪ 18) Circle your answer: The latitude values in the USA are
positive | negative. The USA's longitude values are (circle your answer):
positive | negative. Why? ______________________________________.

▪ 19) In what 2 hemispheres is the USA?
_____________________ and _________________________.

▪ 20) How is your world map like the Cartesian Coordinate System?
_________________________________________________________________.
How is your world map different from the Cartesian Coordinate System?
________ ____________________________________________________.

Step 7: Secondary School Math 6: Distributions, Means,
Standard Deviations

Spatial Math: Exploring Distributions, Means, and Standard Deviation
Name: ______________________________
Summary: Use GIS to ask even deeper questions of your data.

Objectives: Analyze distributions, ranges, measurements, standard deviations, and
Boolean algebra statements using tables and maps in a GIS environment.

Software: ArcGIS, from ESRI.

Level: 20 Questions. Grade 9-12. Ages: 14-18.
Activity: Open ArcMap. Use File, Open to open the worldtectonic_hd.mxd file.
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Analyzing data is an important skill in mathematics and in everyday life. A GIS allows
you to analyze data in tables, or databases, and on maps, using a variety of tools. Here,
let's dig even deeper and analyze more data associated with plate tectonics:
Earthquakes and volcanoes.
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Use the check boxes to make the layers visible. Click each layer and open its attribute
table. Right or double click on each layer, go to Properties, and then Symbology or
Labels to change the symbology and labels for each layer.
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▪ 1) Is it easy or difficult to identify the largest earthquakes on your map?
________________.
Why? ______________________________.
Therefore, change the symbology for the largest magnitude earthquakes to yellow.
Before clicking OK, answer the following:

▪ 2) What is the range of magnitude for the earthquake data set? Show your work:
________________________________________.
To answer the following questions, use Selection--> Select By Attribute to
construct a statement MAG > 7.0.

Open the attribute table for earthquakes, click on MAG, and select Statistics.
Examine the resulting box of statistics to answer the following questions.

▪ 3) What is the mean magnitude of the data?_________.
▪ 4) What is the standard deviation of the magnitude? ___________.
▪ 5) Would you say that earthquake magnitudes are normally distributed? Circle

your answer: Yes | No.
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Why? ________________________________________________________.
Close the statistics box and return to your map. The earthquakes of magnitude 7.0
and greater will appear in the selection color (cyan, unless you have changed the
default selection color) on your map.

▪ 6) Is it easier now to pick out the largest earthquakes?__________.
On what 2 continents are the largest earthquakes?
_________________________
_________________________.Change the Symbols on volcanoes to Graduated
Symbols on Elevation, as shown below.

Experiment with symbol size and style. Examine the statistics for Elevation.
▪ 7) Would you say that volcano elevation is normally distributed?_____________.

Why? _________________________________________________________.
▪ 8) Which is more "normal"-earthquake magnitude or volcano elevation? Circle

your answer: Earthquake magnitude | Volcano elevation
▪ 9) Make 2 observations about the pattern of volcano elevations on your map:

________________________________________________.
Change the classification method to quantile.

▪ 10) How many observations are in each class? ___________________.
▪ 11) Based on your observations, what is quantile classification? _______

__________________________.
Use Selection' Select By Attribute as shown below to find all volcanoes that are
over 2,500 meters in elevation or are active.
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▪ 12) How many volcanoes are active OR have an elevation over 2500 m?
______________.

▪ 13) What % of the total # of volcanoes are active or over 2500m high? Show your
work:
_____________________________________________________________.

▪ 14) How many of these volcanoes are in the United States?
__________________.

▪ 15) What is the name of the volcano in this group (> 2500m high and active)
nearest where you live? ___________________________________.

▪ 16) How far away is this volcano in km? _________________.
Clear your selection .
Re-run your query with an AND statement instead of an OR statement.

▪ 17) How many volcanoes are active AND have an elevation over 2500m?
_______.

▪ 18) What % of the total # of volcanoes are active AND over 2500m high? Show
your work: ________________________________________________________.

▪ 19) Which is more inclusive-the AND operator, or the OR operator? ________.
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Why? ___________________________________________.
20) Create your own question about the data:_____________________________
____________________________________________________________________________________.
Now, answer your question: _________________________________________.

Step 8: Secondary School Math 7A: Distance = Rate x Time

Spatial Math: Distance = Rate x Time: ArcGIS Version
Name: _________________________
Summary: Use GIS to analyze problems involving Distance = Rate x Time.

Objectives: Investigate Distance = Rate x Time problems by using travel time and
distances within a GIS environment.

Software: ArcGIS 9.2 and above, from ESRI.

Level: 20 Questions. Grade 9-12. Ages: 14-18.
Activity: Start ArcMap. Use File--> Open to open the
lesson_distance_rate_x_time.mxd file.

Let's dig some DIRT! Distance Is Rate x Time, that is. This lesson builds on a previous
lesson entitled "Travel by Land and by Sea" involving travel problems. The classic
DIRT is an algebraic story problem, often referred to as a "uniform rate" problem, and
is a variation on the following theme: "City A and City B are 500 km apart. Train A
departs City A at 6:00am local time and travels toward City B at 150 kph. Another
train, Train B, departs City B at 9:00am and travels toward City A at 150 kph. At what
time will the 2 trains pass by each other? How far from City A and from City B will
they pass by each other?" Train A will take 500km/100kph=5 hours to reach City B.
Train B will take 500km/150kph=3.33 hours to reach City A.

Using Distance = Rate * Time, or D=R*T:
Distance(A) + Distance(B)= 500 km
R(A) = 100 kph and R(B)=150 kph
Train A travels 3 hours longer than Train B, so T(A)=T(B)+3
Using D(A)=R(A)*T(A), this yields D(A)=100(T+3). This is the distance A travels.
Using D(B)=R(B)*T(B)=150T. This is the distance B travels.
The total distance = D(A) + D(B) yields: 500=100(T+3)+150T
This yields: 500=100T+300+150T
This yields: 200=250T
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T=200/250, or .8, or 4/5 hours, or (.8*60) = 48 minutes

The trains meet at 9:00 + :48, or, at 9:48am.
Train A traveled D(A)=R(A)*T(A), or 100(3.8) = 380 km
Train B traveled D(B)=R(B)*T(B), or 150(.8)=120 km

The passing point is closer to City B than City A, because halfway would be 250 km
between each city. The reason is because even though Train B is faster, Train A had a
3 hour "head start" and was able to travel farther.

The DIRT problem is an important one in mathematics, because several concepts can
be taught and understood through it, such as algebra, measurement, calculations, units
of measure, conversions, percentages, time, and distance. Within a GIS environment,
the DIRT problem can be analyzed in the context of real places, calculations, and
distances on maps.

You are taking a train and boat holiday in Europe! Use the check boxes to make the map
layers visible. Label the cities based on CITY_NAME with a color of your choice, as
follows:
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Label the countries as well in a different font and color than that which you used for your
city labels.Use the measure tool in this exercise to calculate distances. It is easier to
measure distances between cities when the "snap to feature" button is activated, so that
you do not have to try to "pinpoint" the city's exact location. To active the snap to feature
functionality, press the green circle in the measure toolbar, shown below:

Important: The "Geodesic" distance is the Great Circle route, the shortest distance
between two points on a sphere, the Earth. The geodesic distance is the one you should
use for this exercise. To use the geodesic distance, hold down the Shift key when
taking measurements!

Traveling By Sea
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First, you have decided to journey by sea from London, England to Istanbul, Turkey!
But now you need to plan to determine how much time you need to ask off of work. To
do that, you need to determine the distance between the two cities and calculate how
long it will take to reach your final destination, and return.
Use Selection' Select by Attribute to select these two cities, as follows:

Examine your map. You might need to zoom out to see more land and ocean. Use the
measure tool.
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▪ 1) How far apart are London and Istanbul, in straight-line (remember: the
geodesic) distance, in km? __________________.
2) What direction is Istanbul from London? _____________________.

▪ 3) If you decided to sail from London to Istanbul by ship due east from London
along the Thames River to the North Sea, then southwest along the French coast,
then south along the western, Atlantic coast of Europe and through the Straits of
Gibraltar into the Mediterranean Sea, describe the route you would need to take,
including the list of countries that you will sail past en route from London to
Istanbul: _________________________.

▪ 4) How far is your ocean voyage (in km) from London to Istanbul? ________km.
If your ship travels at 25 kph, how long will it take for you to reach Istanbul?
Show your work and give the results in
hours:__________________________________
_____________________________.

▪ 5) How long will it take you to travel round trip from London to Istanbul,
including a 48 hour stop in Istanbul to see the sights? Show your work with the
result in hours: _________________________________________________.

▪ 6) How long will it take you to travel round trip from London to Istanbul,
including a 48 hour stop in Istanbul? Show your work with the result in days:
___________________________________________.

▪ 7) If your ship uses 1 liter of diesel fuel for every 50 meters, how many liters of
diesel fuel will it use for the round trip? Show your work:
_______________________________________.
1 liter = 0.26 US gallons.
How many gallons of diesel fuel will your ship use for the round trip? Show your
work: ____________________________________________________.
Do some research on fuel efficiency of cruise ships. How realistic is the above
fuel efficiency? _______________________________.

▪ 8) You have heard that it is also fun to sail on a smaller ship, a 50-person yacht.
The yacht is slower than a cruise ship. The yacht you are considering travels at 20
kph and the cruise ship travels at 25 kph. If the yacht that you are considering
departs London on Monday morning at 8:00am, and the cruise ship departs
London on Tuesday morning at 8:00am, which will arrive in Istanbul first-the
yacht or the cruise ship? Each will follow the ocean route that you identified
above. Show your work:
__________________________________________________________________________________________.
If the yacht is passed by the cruise ship, how far from London and Istanbul will
this occur? Show your work:
________________________________________________.
If the yacht is passed by the cruise ship, when will this occur? Show your work:
_________________________________________________________________________________________________.
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Use measure to determine the following answer: If the yacht is passed by the
cruise ship, off of which country's shore will this point occur?
________________________________.Traveling On Land
Now that you know how long the trip will take by ship, you want to consider
taking the train.
For this section, ignore the fact that Europe has several different time zones
except for the second part of question 17.
Also, don't be concerned about the body of water (the English Channel) between
England and France. There is a tunnel underneath the English Channel for trains!

▪ 9) If you board a train in London, bound for Istanbul, and the train travels at 100
kph, how long will it take for you to reach Istanbul? Assume the train tracks run
in a straight line between the cities. Show your work:
___________________________________.

▪ 10) Say a train departs Istanbul, bound for London, at the same time that your
train leaves London. (Assume both trains are on London time). What is the
distance that each train will travel before they pass each other on the tracks? Show
your work: _______________________________________________.
To see a graphic representation of this and to check your work, use ArcToolbox --
> Analysis--> Proxmity-->Buffer. Use cities as your input features. Write your
output as a feature class with an appropriate name such as "cities_buffer" into the
geodatabase that you are using for this lesson. In the Buffer Distance box, enter
the number you indicated above. This will draw buffers (circles) around each of
your cities:
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The point where the two circles touch is the halfway point between the two cities.
▪ 11) Nearest which city will you pass the other train? _________________.
▪ 12) If you traveled this same distance from London but changed directions and

traveled due east, toward Poland, could you reach Warsaw? _____________
If you traveled this same distance to the south, could you reach Madrid? ______.
Use Selection' Select By Location to select features from cities that are within the
buffer layer; that is, cities within the specified distance from London and from
Istanbul, as follows:
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Cities within the buffers are now highlighted, representing all of the cities you
could reach in your given distance from London, plus all the cities that could be
reached by the people on the train that departed Istanbul.
Open the attribute table for cities and note how many cities are selected.

▪ 13) How many cities could you reach at the specified distance from London or
Istanbul? _______________.

▪ 14) What percent of all world cities in the database could you reach in the
specified distance from London or Istanbul? Show your work:
_________________________________.
Use measure again to answer the following:

▪ 15) When you board the train in London, the conductor announces that the train
will go through Warsaw en route for Istanbul. How far will your train trip now be,
in km? ___________________________________________.
Name 3 cities that you would pass near on your way from London through
Warsaw to Istanbul:_____________________________
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____________________________________
____________________________________

▪ 16) If you board a train in London, bound for Istanbul, and the train travels at 100
kph, and now you must go through Warsaw, how long will it take for you to reach
Istanbul? Show your work:
__________________________________________________.

▪ 17) If your train left London at 6:00am on a Wednesday, but there was a 1 hour
delay in the tunnel underneath the English Channel, and stopped for 2 hours in
Warsaw, what time and day would you reach Istanbul, traveling at 100 kph? Show
your work and round to the nearest minute:
____________________________________________________________________________________________________.
Istanbul is 2 hours later than London. If it is noon in London, it is 2pm in Istanbul.
Knowing this, what would be the local time at which you would arrive in
Istanbul? _____________________.
Now say you have found a direct train that does not require you to go through
Warsaw. So, you can go back to considering the straight line distance again
between London and Istanbul. But now you notice in the train schedule that there
are 2 trains to choose from. Train A departs London at 6:00am Wednesday and
can travel at 100 kph. Train B would let you sleep later in London before heading
to the train station, because it is a high-speed train. It travels at 150 kph and
departs for Istanbul at 10:00am Wednesday. Ignore the time zone difference.

▪ 18) Which train would get you to Istanbul earlier? Show your work:
_____________________________________________.
If the faster train overtakes the slower one, how far would you be from London
where this happens? Show your work:
___________________________________________________.
Look on your map and use the measure and buffer tool. If the faster train
overtakes the slower one, in which country does this happen? ________________.
Near which city does this happen? _________________.

▪ 19) You decide to take the faster train, and depart London at 10:00am
Wednesday, traveling at 150 kph, bound for Istanbul. Three hours later, at 1:00pm
Wednesday, a train departs Istanbul, traveling at 110 kph, bound for London.
Ignore the time zone difference.
What day and time will it be when the trains pass each other? Show your work:
_____________________________________________________________________________________________.
How far from London will the trains be when they pass by each other? Show your
work:
___________________________________________________________________________________________________________.
How far from Istanbul will the trains be when they pass each other? Show your
work:
___________________________________________________________________________________________________________.
Near what city and in which country will you be when the trains pass each other?
_______________________________________________________________.
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▪ 20) Create your own question having to do with distance=rate x time similar to the
questions that you have been solving above:
___________________________________________________________________________.
Now, answer your question:
___________________________________________________________________.
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Step 9: Secondary School Math 7B: Distance = Rate x Time Key

Answer Key
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▪ 1) Answers will vary, but should be near 2,510 km.
▪ 2) Southeast.
▪ 3) Answers will vary slightly but should be similar to the following: sail

southwest along the coast of England and France, then south to Spain and
Portugal, south along Portugal, then east along Spain's coast, through the Strait of
Gibraltar, then along the coast of Morocco and Algeria, south of Italy, south of
Greece, north through the Aegean Sea, northeast to Istanbul through the Sea of
Marmara.

▪ 4) Answers will vary but should be much greater than the straight line distance;
could be over 6,000 km, such as 6,628 km or so.
Answers will vary but should be near: 6628/25 = 265.12 hours

▪ 5) Answers will vary slightly but should be near: 265.12 x 2 + 48 = 554.24 hours.
▪ 6) Answers will vary but should be near: 554.24 / 24 = 23.09 days
▪ 7) Answers will vary slightly but should be near the following: 6628 km = 6628 *

1000 = 6,628,000 meters. 6,628,000 / 50 = 132,560 liters.
132,560 liters * 0.26 = 34.465 gallons.
Answers will vary, but some estimates are 50 feet per gallon for some ships, so
the figures in this lesson are not far off. The fuel efficiency is not high for cruise
ships, given their size, but on the other hand, they may be carrying thousands of
people.

▪ 8) Part A:
Let cs=cruise ship and y=yacht.
The cs takes 6628/25kph = 265.12 hours for the trip.
The y takes 6628/20kph = 331.4 hours for the trip.
Even if the y has a 24 hour head start, the difference in time between the two ships
is 66.28 hours, so the cruise ship will overtake the yacht. The cruise ship will
arrive in Istanbul first.Part B:Let T=Time the yacht travels
Then T-24 = Time the cruise ship travels, because it is 24 hours less than the
yacht
Using Distance = Rate * Time, or D=R*T
25(T-24)=20T
25T-600=20T
600=5T
T=120 This is the number of hours each travel when they meet.
The yacht in 120 hours travels 120*20=2400km
The cruise ship in 96 hours travels 96*25=2400kmPart C:
120 hours after Monday morning 8:00am on the yacht will be:
Tue 8am is 24 hours later. Wed 8am is 48 hours later
Thu 8am is 72 hours later. Fri 8am is 96 hours later
Sat 8am is 120 hours later
Check this against the cruise ship: Yes, 96 hours after Tue 8am is again Sat
8am.Part D:
Using measure on the map, 2400km from London is:
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Southwest off of Portugal in the North Atlantic Ocean.
▪ 9) 2510km/100kph = 25.1 hours. Answers will vary slightly.
▪ 10) Answers will vary but should be near 2,510 / 2 = 1,255 km.
▪ 11) Acceptable answers: Vienna, Eisenstadt, Graz, Zagreb, or Ljubljana.
▪ 12) No, you cannot reach Warsaw.

Yes, you can reach Madrid.
▪ 13) Answers may vary slightly. 498, or even up to 514 cities.
▪ 14) (498/2539) * 100 = 19.6%
▪ 15) Answers may vary slightly, but should be close to 2,821 km. Answer will be

longer than the straight line distance from London to Istanbul, because now the
train is going through Warsaw.
Duisburg, Potsdam, Berlin, Poznan, Plock, Piotrkow, Lublin, Rzeszow, Bistrita,
Buzau, Bucharest, Burgas, and Varna, and several other cities near the straight
line between London, Warsaw, and Istanbul are all acceptable answers.

▪ 16) Answers will vary slightly: Distance is 2,821 km/100 km = 28.21 hours.
▪ 17) Answers will vary slightly: 28.21 hours + 1 + 2 = 31.21 hours. 24 hours from

6:00am Wednesday would be 6:00am Thursday. 7 hours later is 1pm Thursday.
.21 hours is .21*60 = 12.6 minutes. Rounded to nearest minute: Thursday at 1:13
pm, or 13:13, Thursday afternoon.
If Istanbul is 2 hours later, you lose 2 hours on our journey, so you would arrive in
Istanbul at 13:13 + 2 = 15:13, or 3:13pm Thursday afternoon.

▪ 18) Part A:
Let A=Train A and B=Train B.
A takes 2510km/100 kph= 25.1 hours for the trip.
B takes 2510/150 kph = 16.7 hours for the trip.
A has a 12 hour head start.
Let T=Time Train A travels
Then T-6 = Time Train B travels, because it is 4 hours less than Train A.
Using Distance = Rate * Time, or D=R*T
150(T-4)=100T
150T-600=100T
50T=600
T=12 This is the number of hours Train A travels when they meet.
T-4 = 8 is the number of hours Train B travels when they meet.
Train A in 12 hours travels 12*100=1200 km
Train B in 12 hours travels 8*150=1200km
12 hours past 6:00am for Train A is 6:00pm Wednesday.
8 hours past 10:00am for Train B is 6:00pm Wednesday.
Train B catches up to Train A by Wednesday evening by 6:00pm, and then Train
B, traveling faster, passes Train A, and makes it to Istanbul earlier.
You will be 1200km from London when Train B overtakes Train A.Parts B and
C:
Using measure and/or buffer on the map, 1200km from London is:
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Ljubljana, Slovenia or Trieste, Italy. Alternative answer: Klagenfurt, Austria.
▪ 19) Part A: Let Train B be the London to Istanbul train.

Let Train C be the Istanbul to London train.
D=RT
Train B travels 3 hours longer than Train C, so T(B)=T(C)+3
D(B)=R(B)*T(B) = 150(T+3)
D(C)=R(C)*T(B)= 110(T) D(B) + D(C)= 2510km
150(T+3) + 110T = 2510 km
150T + 450 + 110T = 2510
260T = 2060
T = 7.92 hours
.92 hours = .92 * 60 = 55.2 minutes.The trains pass each other at 10:00am + 7
hours and 55.2 minutes later, or at 5:55pm (17:55).
Parts B and C: Train B traveled 150*(3+7.92) = 1639 km from London
Train C traveled 110*7.92 = 871 km from Istanbul
Check: 1639 + 871 = 2510 km total distance Part D: Using the map: Between
Belgrade, Serbia & Montenegro, and Sarajevo, Bosnia & Herzegovina.

▪ 20) Answers will vary. Look for evidence of spatial thinking, spatial analysis,
distances and directions, d=rt understanding, units of measure, and GIS skills.

Step 10: Secondary School Math 8: Measuring the
Circumference of the Earth

Measuring the Circumference of the Earth with GPS

In this activity, students measure the circumference, radius, mass, and volume of the
Earth using Global Positioning Systems (GPS) receivers. This activity incorporates and
integrates geography, mathematics, Earth Science, and physics. It can be used with
secondary students through university level and adult learners. The activity requires
approximately 90 minutes to complete at the minimum and 150 minutes at the
maximum. The field work can be done in as little as 20 minutes and because it only
requires a small area, can be done on the school campus grounds.

Eratosthenes (276 BC-194 BC) was born in Cyrene, now a part of Libya, in the
northern part of Africa. After studying in Alexandria and Athens, he became the
director of the Great Library in Alexandria. The Library truly lived up to its name,
housing a great deal of the learned and compiled knowledge of the time. It was at the
library where Eratosthenes read about a deep vertical well near Syene (now Aswan) in
southern Egypt. Once a year at noon at this well, on the day of the Summer Solstice,
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the bottom of the well was entirely lit up by the sun. The sun was directly overhead, its
rays shining straight into the well.

Eratosthenes then placed a vertical post at Alexandria, which was almost due north of
Syene, and measured the angle of its shadow on the same date and time. Making the
assumptions that (a) the earth is round and that (b) the sun's rays are essentially
parallel, Eratosthenes knew from geometry that the size of the measured angle equaled
the size of the angle at the earth's center between Syene and Alexandria. Knowing also
that the arc of an angle this size was 1/50 of a circle, he then had to determine the
distance between Syene and Alexandria. This was a difficult task during that time, due
to different strides of camels and human error, and despite the best efforts of the King's
surveyors, required years of effort. It was finally determined to be 5000 stadia.
Eratosthenes multiplied 5000 by 50 to find the Earth's circumference. His result,
250,000 stadia (about 46,250 km), was amazingly close to the accepted modern
measurements (40,075 km around the equator and 40,008 km around the poles).

With your GPS, you too can emulate Eratosthenes' methods and measure the
circumference of the Earth! By so doing, you are incorporating and integrating
geography, mathematics, Earth Science, and physics!
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Measuring the Earth's Circumference
▪ 1. Gather the students in pairs. Give a GPS receiver to each student.
▪ 2. For each pair of students, set one GPS receiver to display coordinates in the

format of degrees minutes seconds (hddd° mm' ss.s") latitude-longitude
coordinates. The "H" stands for Hemisphere, ddd=degrees, mm=minutes, and
ss=seconds. Set the other GPS receiver to UTM (Universal Transverse Mercator).
The UTM units are in meters. The units in the UTM system represent eastings
("east" relative to a Central Meridian in given UTM zone), and northings (meters
north of the Equator). Important: Set each GPS receiver's datum to WGS 84 so
that all students are working with the same datum (model of the Earth's shape).
Otherwise, coordinates for the two students in each pair could be vastly different.
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▪ 3. Have the students use the GPS compass to determine which direction true north
and true south lie from their present position.

▪ 4. Position the students until they are located at a whole second of latitude (not a
fraction), as measured by the student using the degrees-minutes-second format.
For example: 39 degrees, 20 minutes, and 5 seconds, rather than 39 degrees, 20
minutes, and 5.1 seconds. At this whole-second position, write down the
coordinates that are showing on each GPS receiver (or mark a waypoint). This
will be latitude-longitude degrees-minutes-seconds on one GPS and UTM on the
other GPS.

▪ 5. Along the north-south line, have each pair of students walk due north or due
south for 1 full second of latitude. When a full second of latitude has been
traversed, the student with the latitude-longitude GPS needs to call "STOP".

▪ 6. When the students stop, write down the coordinates showing on each GPS
receiver (or mark a waypoint). Again, this will be lat-long degrees-minutes-
seconds on one GPS and UTM on the other GPS.

▪ 7. Determine how many meters the pair has walked by comparing the UTM
northing at the starting point to the UTM northing at the end point: _______
meters

▪ 8. Compute the Earth's circumference by using the following equations:
1 second of latitude x 60 = 1 minute of latitude
1 minute of latitude x 60 = 1 degree of latitude 1 degree of latitude x 360 = the
number of degrees around the EarthTherefore, the number of meters that the
students have recorded above x 60 = the number of meters in 1 minute.The
number of meters in 1 minute x 60 = the number of meters in 1 degree.The
number of meters in 1 degree x 360 = the number of meters around the Earth,
through the poles.Fill in the following:The number of meters that you walked =
_________ x 60 = _________ meters in 1 minute x 60 = _________ meters in 1
degree x 360 = _________ meters around the Earth Divided by 1000 =
_________ kilometers around the Earth

▪ 9. How close are you in percent to the accepted circumference of the Earth? Show
your work.

▪ 10. Are you closer to the accepted circumference than Eratosthenes was?
▪ 11. Name at least 3 reasons why your answer is not exactly the same as the

accepted circumference of the Earth.
Example:The number of meters that you walked = 4391181 - 4391150 = 31
meters x 60 = 1,860 meters in 1 minute x 60 = 111,600 meters in 1 degree x 360 =
40,176,000 meters around the Earth Divided by 1000 = 40,176 kilometers around
the Earth Error: 40,176 - 40,008 = 168 / 40,008 = .004 x 100 = .4 %.
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How Long Would It Take to Walk Around the Earth?
▪ 1. Set the receiver to the screen where you can determine how fast you are

moving.
▪ 2. How fast are you walking (in km/hour) when you are walking at a comfortable

pace?
▪ 3. If you could keep up this pace and walk due north or due south from this point,

and walk all the way around the Earth on the meridian, how long would it take
before you arrived back at this same spot? Show your work.

▪ 4. What would the date be when you arrived back at this spot? Show your work.
Example: 40,176 km / 6 km per hour = 6,696 hours, or 279 days.

Determining the Earth's Circumference Based on Measuring 1 Second of Longitude
▪ 1. Pair up the students as before, but this time, position them at a whole second of

longitude.
▪ 2. Record the latitude that you are standing on. Convert this latitude value to

decimal degrees: Latitude = degrees + minutes/60 + seconds/3600
▪ 3. Walk due east or west for a distance of exactly one second of longitude.
▪ 4. Record the distance walked.
▪ 5. Use the following formula to compute the Earth's polar circumference. When

doing the calculation, make sure the cosine is measured in degrees, not radians
(otherwise, your final value will be a negative number!).

Example:

Determining the Distance Around the Earth At Your Present Latitude

Exercise 9

Copyright © 2008 ESRI 9-61



Method A
▪ 1. Determine the length of 1 second of longitude using the method above.
▪ 2. Compute:

▪ 3. Why is the distance around the Earth on this latitude line shorter than the
distance around the Earth along this longitude line?

▪ 4. On what line on the Earth is the distance around the Earth on a latitude line
close to the distance around the Earth on a longitude line?

Method B
▪ 1. Determine the length of the polar circumference using the method above.
▪ 2. Compute: length of this latitude = cosine of latitude * length of Equatorial

circumference
▪ 3. Is the length of this latitude longer or shorter than the equatorial circumference?

Why?
▪ 4. Determine the length of time it would take for you to walk around the Earth at

this latitude at a comfortable walking speed.
▪ 5. What would the date be when you arrived back at this spot? Show your work.
▪ 6. Is the time it takes to walk around the Earth at this latitude east or west longer

or shorter than it would take to walk around the Earth due north or south? Why?

Determining the Mass of the Earth
▪ 1. Determine the length of the polar circumference using the method above.
▪ 2. Determine the Earth's radius based on the circumference.
▪ 3. Compute:

Mass = acceleration * radius2/ Gwhere acceleration due to gravity = 9.8 meters2,
and G, the constant of proportionality, which was computed by Henry Cavendish
in 1798, is 6.67 x 10-11 / kg seconds2.For example: Radius = 6.4 x 106 metersM
= 9.8 * (6.4 * 106) / 6.7 x 10-11 kgM = 6.0 x 1024 kg
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Determining the Volume of the Earth
▪ 1. Determine the length of the polar circumference using the method above.
▪ 2. Determine the Earth's radius based on the circumference.
▪ 3. Compute the Earth's volume from the formula below:

Volume = 4/3 * ? * r3

For More Information
▪ Read the book "The Librarian Who Measured the Earth" by Kathryn Lasky.

Published by Little, Brown, and Company:
http://www.amazon.com/Librarian-Who-Measured-Earth/dp/
0316515264Excellent for all ages but geared for students aged 7-12.

▪ Read more about Eratosthenes on:
http://www.eranet.gr/eratosthenes/html/eoc.html and http://www-groups.dcs.st-
and.ac.uk/~history/Biographies/Eratosthenes.html

▪ Read the book The Mapmaker's Wife by Robert Whitaker, an amazing tale about
measuring 1 degree of latitude in Peru in 1730 by a French mapmaking team.

▪ Read the book Longitude by Dava Sobel, a fascinating book about the man who
invented the world's first accurate clock so that ship captains could determine their
position at sea. A tale about the triumph of the common man!

▪ Read the book The Mapmakers by John Noble Wilford, a book about the history
of cartography over the centuries.
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Step 11: University STEM: Siting a Wind Farm in Colorado:
Introduction

Selecting Wind Farm Sites in Colorado with GIS
Name: ______________________________________________

Summary:
In this 50-question activity, you will determine the best locations to site a wind energy
farm in Colorado. You will use GIS as your primary investigative tool and use spatial
analysis techniques to consider the best site.

Objectives:
To understand and practice site selection using numerous input variables, qualitative
and quantitative decisions, and raster and vector map layers, in a GIS environment.

Skill Level:
Intermediate GIS skills are requires to move through this lesson. Target audience:
University undergraduate or graduate.

Software Involved:
ArcGIS 9.2, 9.3.1, or ArcGIS 10, from ESRI.

Skills Involved:
1. Analyzing spatial patterns and processes within a GIS framework.
2. Investigating wind speed, elevation, federal lands, and other data to
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make a decision using GIS.
3. Tabular queries, labeling features, overlay analysis.

Data Description:
Data layers include: Cities, Continental Divide, Highways, Rivers, Counties, Wind
Data, Federal Lands, and Elevation. The data layers are from ESRI, the National
Renewable Energy Laboratory, and the Colorado Department of Transportation.

The data are stored in a file geodatabase with a Map Document (wind_colorado.mxd).
Note that there is also a 9.2 map document (mxd) for those using ArcGIS 9.2. The data
sets are in the USA Contiguous Lambert Conformal Conic projection.

Problem:

Step 12: University STEM: Siting a Wind Farm: Exploring Your
Data

Examine Your Data

Open the wind_colorado.mxd map document.

You will see a listing of 8 map layers on the left with the state of Colorado map on the
right.

1) Where are the highest elevations in Colorado? Where are the lowest?

2) Would you say the elevation map layer is detailed or generalized? Why?

Exercise 9

Copyright © 2008 ESRI 9-65



3) Turn on the rivers layer. What would you say are the 4 most important rivers in
Colorado?

4) Why do you suppose that some rivers in northeast Colorado start and dead-end?

5) What is the relationship of rivers to elevation?

Turn on the continental divide layer. In Colorado, the Continental Divide separates the
"western slope" from the "eastern slope."

6) What is the relationship of the continental divide to the direction the rivers run?
Why?

7) Turn on the highways and cities layers. What is the relationship of highways and
cities to elevation? Why?

8) What is the relationship of highways and cities to rivers? Why?

9) According to the data set, what are the 5 largest cities in Colorado (field POP100,
from the 1990 Census)?

10) How many of the top 10 cities are on the eastern slope? How did you determine
your answer?

11) In a short paragraph, describe the pattern of settlement in Colorado.

Turn on the counties and cities layers only.

12) Based on these patterns, which 5 counties would you guess to be the largest
counties in population in Colorado?

13) Turn on the federal lands layer. Conduct an investigation using outside sources and
list the full name of the federal agencies responsible for these lands:

BLM _____________________________________________
BOR _____________________________________________
DOD _____________________________________________
FS _____________________________________________
FWS _____________________________________________
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14) Using the statistics tool in the attribute table, summarize the land managed by each
of the 5 agencies above. What agency is responsible for the most land in Colorado?

15) Using other map sources, examine land in southwest Colorado, south of Cortez,
and south and southeast of Durango. What are these large pieces of land that are not
listed in the federal lands map layer? Why are they not listed as federal lands? Should
they be? Why or why not?

Turn on the wind layer. This is a map of Wind Power Class, which represents the
strength of the wind in specific areas. Wind power class is an indicator of likely
resource strength, with a higher wind power class representing higher wind resource
levels. The following classification information is for utility-scale applications at a 50
meter height.

16) Describe the pattern of wind strength in Colorado, noting the relationship of wind
power to elevation, and the proximity to the Continental Divide. Why does this pattern
exist? Is this what you would have expected the wind pattern to look like?

17) Rank the following towns, from windiest to calmest: Denver, Ault, Vilas, Ward,
Eads, and Glenwood Springs.

18) Rank the following counties, from windiest to calmest: Crowley, Mesa, Baca,
Gilpin, and Rio Grande.

Now that you have familiarized yourself with your data, you will turn your attention to
proposing the wind farm sites.
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Step 13: University STEM: Siting a Wind Farm: Considering
Wind, Highways, and Cities

Remember the first criterion:
# 1. In an area where the Wind Power Class is at least 4.
Use Select By Attribute to select these areas.

19) What expression did you use to select these areas?

Use Selection' Export Data to export the selected and suitable wind areas to its own
map layer. Name it wind_acceptable and save it as a feature class within your
geodatabase.

Recall the second criterion:
#2. No further than 5 miles from a highway, so that maintenance crews can more easily
access the wind turbines.
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Use the ArcToolbox' Analysis' Proximity tools to create a buffer around the highways.
Save the new feature class in your geodatabase with a suitable name. Use the ALL
under the Dissolve option, so the highway segments that are buffered are merged into
one continuous buffer, as follows:

20) Describe the pattern of your buffers.

Recall the third criterion:
# 3. No further than 50 miles from a city containing at least 25,000 people, to ensure a
nearby target market.

Select the cities meeting this criterion.

21) Describe the pattern of the selected cities.

Buffer the selected cities the required distance and dissolve any lines between the
buffers, as you did with the highways.

Summarize the shape_area field in your counties attribute table. This number is in
square meters.
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22) How many square meters is in 1 square kilometer?

23) How many square kilometers lie in Colorado?

Open the attribute table for your cities buffer. Summarize the area that lies within 50
miles of major cities.

24) How many square kilometers lies within 50 miles of major cities?

Realizing that some of the buffered area lies in Wyoming and in Utah, approximately
how much land in Colorado lies within 50 miles of major cites?

Step 14: University STEM: Siting a Wind Farm: Considering Land

Remember the fourth criterion:
#4: Not on federal land.

25) What is the AGBUR code for the non-federal land?

Use the AGBUR field to select by attribute to select the lands that are not federal.
Observe that non-federal lands in Colorado includes the lands now highlighted on your
map, including large sections of the eastern plains, which are largely privately held
lands.

26) Describe the pattern of land in Colorado that is not federal.

Now you need to combine the data sets resulting from your consideration of criteria 1
through 4 for your final assessment.
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First, combine the wind_acceptable layer (criterion 1) and the highways 5 mile buffer
(criterion 2) and the cities 50 mile buffer (criterion 3) using, in ArcToolbox' Analysis
Tools' Overlay' Intersect, with these 3 layers as input layers, and with your output layer
as a feature class within your geodatabase named wind_hwys_cities_acceptable, as
follows:

27) Describe the spatial pattern of your resulting acceptable areas. These areas are
windy enough, are close to highways, and are close to cities.

28) Summarize the area in these acceptable areas for wind farms and give the area in
square kilometers, below.

Now, turn your attention to criteria #4. Because you want to consider areas that are not
on federal land, you will use a different geoprocessing tool to "erase" the federal lands
from your consideration.

You should still have the non-federal land "holes" selected in the federal lands. In
either the attribute table or by right clicking on the federal lands layer, use Selection'
Switch Selection. Now you should have all of the federal lands selected.
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Next, use ArcToolbox' Analysis Tools' Overlay' Erase to erase (or 'take out from
consideration') the federal lands, with your criteria 1 through 3 feature class as input,
and your federal lands layer as the erase layer, saving the result to
wind_hwys_cities_lands_acceptable, as follows:

29) Examine your results and describe the spatial pattern of wind farm potential sites.
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Step 15: University STEM: Siting a Wind Farm: Considering Land
Size

Notice how each of these areas that you are considering are actually composed of
numerous polygons:

In order to consider criteria 5 (size of area), you need to work with areas where the
contiguous "islands" are each composed of a single polygon, rather than multiple
polygons. Because the result of your overlay operations created multipart features, you
need to use 2 geoprocessing functions to accomplish this. The first one (Multipart to
Singlepart) separates multipart features into separate singlepart features, and the second
(dissolve) will aggregate the polygons within each "island of acceptable farm sites" to a
single polygon.
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First, run the Multipart to Singlepart tool: Use ArcToolbox' Data Management tools'
Features' Multipart to Singlepart, saving your output into your geodatabase and naming
it "wind_hwys_cities_lands_spart" for "singlepart", as follows:

30) Examine your table and map for the spart layer. What did the multipart to
singlepart tool do? How many rows do you now have in your attribute table?
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Next, dissolve the polygons if they are adjacent: In ArcToolbox' Data Management
Tools' Generalization' Dissolve, naming your output wind_hwys_cities_lands_diss,
and making sure you do not check "create multipart features" (otherwise, you will be
back to where you were before!) and do not check "unsplit lines", as follows:

31) Would you now expect to have more rows in your attribute table for the "diss"
layer, or fewer? Why?

32) Examine your attribute table for your "dissolved" layer. Was your hypothesis
correct? How many rows do you now have?

33) Describe the pattern of wind farms that you are considering.

Now that you have your map that considers criteria 1-4, turn your attention to Criterion
#5:
# 5. On land that meets criteria 1-4 that is also at least 1 square kilometer in size, large
enough for a wind farm.

Sort your dissolved layer on the area. Select areas that are at least 1 square kilometer in
size. Remember that your areas in the table are tied to the map projection; here, they
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are in square meters. Therefore, you are seeking areas that are at least 1,000,000 square
meters in size.

Select these areas.

34) How many areas are you now considering?

How could you rank these final areas so that you are not considering quite so many?
One way is to select the windiest of the sites, assess the piece of land in the field to
clear any hurdles that may exist, and then work your way down the list of sites.

35) Examine your attributes. Do you have a wind power class attribute for these final
sites?

The wind power class field was lost when you dissolved the layer. However, if you
examine your map layer "spart", you will see the wind speed class. One way to "bring
back" the wind speed class is to perform a spatial join between your "diss" layer and
your "spart" layer. First you will create a separate layer for just these largest sites.

With your largest areas (over 1 square kilometer) still selected, right click on the diss
layer and ' Data, Export Data, and export it to a "disslarge" feature class.
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Next, right click on your disslarge layer, use ' Joins and Relates, and perform a spatial
join. Check the "average" under the summary section, and name your result "final," as
follows:

36) What is the difference between the attribute table of "disslarge" and "final"? Why?

Remember that all of the polygons in this map layer are at least 1 square kilometer in
size.

Exercise 9

Copyright © 2008 ESRI 9-77



Sort the final attribute table on avg_WPC. This is the average wind power class in that
polygon.

37) What is the highest wind power class in the final sites under consideration?

Zoom to this polygon.

38) Describe the location of this site under consideration, indicating its county, the part
of the state it is in, closest highway, and closest river.

39) Based on the site's proximity to national forests, Rocky Mountain National Park,
and its elevation, what do you expect that the landscape looks like here? Would there
be any obstacles or opposition to a wind farm in this location? Why or why not?

Select all polygons with a wind power class of at least 5. Zoom to the selected set.

40) How many sites are under consideration?

41) In what part of the state are all but 2 of these sites under consideration?

42) Where are the other 2 sites under consideration in this group?

43) After examining each of these sites' and their proximity to public lands, rivers,
cities, and so on, what 3 sites, in your opinion, would make the best sites for the wind
farms? Why?

Step 16: University STEM: Siting a Wind Farm: Conclusion

Congratulations! You have considered criteria important to siting a wind farm in
Colorado.

44) Create a layout that shows these final sites, a scale bar, your name, a legend, and
any other information that you believe is important. Export the map and paste it into
these lab sheets.

45) Create a 10-minute presentation for the state of Colorado Office of Renewable
Energy that summarizes your results and your recommendations on the potential wind
farm sites in the state.

46) Name at least 5 other factors that may have been useful in your decision making
process in siting wind farms.
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47) What organizations might have the data layers that would allow you to examine
these factors?

48) What factors have you considered that would also be important in other states or in
other regions of the world? Are there any factors that would not be important
considerations elsewhere in the world?

49) Summarize in a paragraph what you have learned about wind in Colorado from
this activity.

50) Summarize in a paragraph how GIS along with the spatial perspective added to
your understanding of wind and other phenomena in Colorado.

Conclusion

GIS can be effectively used in teaching Science, Technology, Engineering, and
Mathematics.

For more lessons and data, visit the following:
▪ Presentations, movies, and resources on GIS in education:

http://edcommunity.esri.com/syfr
▪ Math-related lessons and resources:

http://edcommunity.esri.com/math
▪ Earth Science related lessons and resources:

http://edcommunity.esri.com/esw
▪ Other science related lessons and resources:

http://edcommunity.esri.com/arclessons
▪ Other STEM-related lessons, part of the Our World series of 4 books from ESRI

Press:
http://www.esri.com/ourworldgiseducation
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Teaching and Learning With Web-GIS in Education

Since web-based GIS appeared around the year 2000, teaching with GIS and teaching
about GIS have both been inexorably changing. These changes include opportunities as
well as challenges. As never before, educators have a wealth of geospatial tools at their
fingertips, which may hasten the ability of educators to meet spatial learning challenges
as identified in the National Research Council's "Learning to Think Spatially" report.
Web-based GIS tools can support standards-based inquiry-driven methods of teaching
and learning, while providing basic analysis tools for exploring geographic or scientific
data. Challenges in using Internet-based GIS in education include data quality,
functionality, computer security, Internet bandwidth, and distractions due to the visual
appeal of these new tools.

The advantages of web-based GIS for the educator are numerous. No software is required
beyond a standard web browser. This alone, for instructors who are faced with difficulties
with the school technology staff in installing any software not viewed as standard in the
school, is a significant benefit. Furthermore, most web-based GIS require little time to
learn, drastically reducing the time it takes for educators to incorporate them into their
curricula. Dynamic content, such as real-time wildfires or earthquakes, can be analyzed
online in a way that is not possible in the desktop environment. A significant advantage
of web-GIS over desktop GIS particularly in countries where all data are licensed is that
the data are accessible and viewable (although in some instances, to use it entails cost or
licensing restrictions.) These tools can be used in a variety of ways such as in teaching
about demographics, natural hazards, biodiversity, water resources, energy, land use,
economics, and history. They can be used at any scale-from analyzing locally collected
data in the field to global issues and problems.

Students can learn about the processes that are active on our planet, and the reasons why
those processes exist. They seem better able to make the leap to using maps to analyze
data rather than just using maps to look at places when there is an intermediate
technology that introduces them to spatial analysis. Many web-based GIS tools function
in the same way within a desktop GIS environment that they do in the web-based
environment. Furthermore, web-based GIS provides an excellent avenue to more
advanced spatial analysis with desktop GIS.
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However, another, even more recent, development has occurred over the past few years.
The educator's choices are not confined to using either desktop GIS *OR* web-GIS. The
third choice is to use desktop GIS but stream data down from web-based GIS mapping
services. The advantages to this option include access to the full suite of desktop GIS
tools without having to store large amounts of data locally. Updates are done on the
server side, and the user simply accesses these datasets through online services and tools,
from servers using ArcGIS Server, ArcIMS, or a Web Mapping Service (WMS).

Learning Objectives of this workshop include:

1) To understand the benefits and challenges of using web-based GIS in education.
2) To provide hands-on practice with a variety of web-based GIS tools and resources.
3) To illustrate web-based GIS in conjunction with desktop GIS to take advantages of
both web-GIS and desktop GIS.

Start by examining the lesson entitled "geotools_mapping_and_analysis" on
http://edcommunity.esri.com/arclessons and begin exploring some of the resources listed
there.

Step 1: ESRI's Mapping For Everyone

ESRI's Mapping For Everyone
How can differences in neighborhoods be analyzed and measured? Median age, home
value, population change, and household size are just a few variables that can be useful in
analyzing how your neighborhood differs from others in your community or across the
country. Maps are a powerful way to detect patterns and uncover cause-and-effect
relationships. "Mapping Your State and Community" poses questions that help you think
spatially at scales from local to state to national.

Because Mapping For Everyone uses information from the US Census Bureau, start
with http://www.census.gov/aboutus/, discussing what a census is, why it is taken, and
how its data can be used. What are the benefits and limitations of the data from a self-
reported national census? What segments of the population would be more likely to be
undercounted? Why?

Activity 1: Explore Variables by State: Visit http://www.esri.com/mappingforeveryone
and select "make a map" under the small map on the page. You should now be at the
"Make a Map" site. Examine the Population Density map, which should look like the
map on Page 1. What do the colors mean on the map? How does population density
differ from total population? How is population density calculated?
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Click on individual states to see the exact population density. Which state has the
highest population density? Which state has the lowest? Name three factors that
influence population density. Are the factors that you named economic, political,
physical, or something else? How does the size of the state influence population
density?

Fill in the following table. How can you determine the size of each state given total
population and population density?

State Total Population Population Density Size (Square Miles)

New Jersey

Colorado

Pick A State:

Activity 2: Explore Variables by County: Use the slider bar on the left, or double-click
on the mouse, or hold down the shift key while dragging a rectangle on the map, to
zoom in on a state with a high population density. Start with New Jersey. As you zoom
in, you will see population density by county instead of by state. What difference does
scale make to your understanding of population density? Which parts of New Jersey
have the highest population density? Which parts have the lowest? Examine the cities
in New Jersey. What influence do cities have on population density? Why? Repeat this
process for your own state and summarize in a short paragraph what you learned about
population density in your state.

Activity 3: Examine Population Change: Zoom back out to the United States and
change the variable to population change, 2000-2009. Describe the pattern that you see
of the fast-growth states versus the slow-growth states. How many years does this time
period encompass? If a state had 0.5% growth during each of those years, how much
growth would it have over the period? What color would it be symbolized as? Name
three factors that influence why people move, and hence, why population changes.
What do you predict the fastest growing states in 2010-2020 will be, and why? Zoom
to your own community. Fill in the 2-word phrase that defines the level of geography
that lies between county and block group.

Coarse <- Scale -> Fine
State County _______ ________ Block Group
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In your opinion, which level of geography is most similar to the concept of
"neighborhood?" Identify some block groups in your community. What is the mean
population of these block groups? Show your work here:

What parts of your community are growing the fastest? The slowest? Why? Name
three factors that influence the growth rate of different parts of a community.

Activity 4: Examine Median Age: Describe what a "median" is in mathematics. How is
median age of the population calculated? Zoom back out to the United States and
change the variable to Median Age. What regions of the United States have the
youngest median age? The oldest? What factors influence whether a region will have a
young or old median age? What do you predict the median age of a college town will
be? Zoom to the following communities and record the median age of 5 census tracts,
as in the model.

Community 5 census tract
numbers (last 3

digits)

Median age in
those census

tracts

Mean age of 5 census tracts

Lawrence
KS

502, 300, 400,
901, 501

23.7, 22.9,
20.4, 25.9,

27.7

(23.7+22.9+20.4+25.9+27.7)/
5 = 24.12

Laramie WY

Sun City AZ

<Your
Community>

Can you find a census tract where the median age is younger than 21? What kinds of
communities would you say Lawrence Kansas and Sun City Arizona are based on the
median age of the census tracts there? What implications does the median age have in
terms of planning a community-such as schools versus nursing homes, or skateboard
parks vs. golf courses?

Activity 5: Putting It All Together. Create a 5-minute oral presentation for your class
where you describe what your community is like based on the demographic
characteristics that you have analyzed. Include maps as part of your analysis. If you are
using the Mapping For Everyone Web GIS tool, you can link to your maps, save them
as graphics, and even embed them in your own web page. How do the variables that
you studied change based on the scale? Based on your analysis, include in your
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presentation what you think your community will be like in 20 years. Select at least
one other community in the United States that you are interested in (such as one you
used to live in, or one you have visited) and compare that community to your own
community. How is your community like or different from the other community you
have selected? How have dynamic maps that you created yourself using the Mapping
For Everyone Web GIS tool helped your understanding of your community? How are
these maps different from printed maps?

Example: Analyzing one community. I am interested in investigating Lawrence,
Kansas, and so I type in Lawrence, KS in the box under [1] "Enter a Location." The
default theme is population density per square mile. I see that Lawrence's Census
Tracts have a density of over 1,000 people per square mile, higher than the
surrounding area, which makes sense given that it is a community surrounded by a
rural area. If I zoom out a bit, I see that Lawrence is midway between the higher
density communities of Topeka to the west and Kansas City to the east. It contains
about 14 census tracts, as opposed to about 20 for Topeka and about 100 for Kansas
City, and therefore I would say that Lawrence is smaller in population.

If I zoom to the county level and select counties, Lawrence's Douglas County has
about 114,000 people, while 176,000 people live in Shawnee County, which contains
Topeka. This confirmed my population hypothesis.
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However, the raw numbers only tell a part of the story, so I change the theme to
population change and zoom out until I can see Kansas and Missouri. Even though the
USA increased from 281 to 308 million people from 2000 to early 2010 (as verified on
the Census Bureau's population clock), not all areas experienced population growth.
Indeed, I see that western Kansas and northern Missouri counties are declining in
population.

After further outside research, I discover that the major reason for the declines in these
areas is the rural-to-urban migration that began a century ago with the consolidation of
family farms into larger farms run as an"agribusiness", and better job opportunities in
urban areas. But other reasons exist: Junction City in Riley County, Kansas is
experiencing a decline in population because it is dominated by a large US Army base,
which is reducing its staff. And some neighborhoods in central Kansas City, Missouri
are decreasing because of urban-to-suburban migration.
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Back in Lawrence, I change the variable to median home value. After seeing how the
value ranges from $75,000 on the east side of town to over $250,000 on the west, and
discovering that the unemployment rate is also higher on the east side, I conclude that
the west side is more affluent. A quick tour down some of the streets in Google Street
View confirms my conclusion visually. The variable that sets Lawrence apart from the
surrounding region is its median age:

After averaging the median age for a selection of 5 Census Tracts (502, 300, 400, 901,
and 501), I am left with a value of (23.7+22.9+20.4+25.9+27.7)/ 5 = 24.12 years.
Outside research confirms that Lawrence is the home of a large state university, the
University of Kansas. I discover that this university was founded in 1866 and has
grown to over 30,000 students today. This number is larger than one neighborhood,
and the neighborhoods with a low median age must include the dormitories and the
bulk of the student housing on and near campus. Zooming in, I see the labels for the
student union and stadium which confirms my hypothesis. Changing the variable to
average household size indicates that the lowest values are in the same neighborhoods
as the low median age, which again makes sense given the fact that most college
students live alone or with very few roommates.
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My maps have become an investigative tool in my overall research to help me
understand the community. I can use the same procedures to investigate a different
community, compare the data to that for Lawrence, and most importantly, investigate
the reasons why those differences exist, and where they exist.

Extensions. Examine the variables using the Mapping For Everyone resource that you
may not have yet studied, such as median household income, median home value,
unemployment rate, and average household size. How do these variables influence
each other? How do they change based on the scale of analysis? How do they change
over time? Use other Web GIS tools from the list below to conduct additional research.

Step 2: MLA's Language Mapper

MLA's Language Mapper
The Modern Language Association's (MLA) Language Mapper is another example of a
customizable, query-able web-GIS:
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Access http://www.mla.org/maps
Select "View the Map" and create a map of percent of the population speaking
German. Zoom to the north central part of the country, as follows:
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What historical and current-day reasons account for the existence of this pattern?
Change the map from percentages to raw numbers. What are the differences, and why
do they exist? Create a chart of languages spoken in the USA (according to the 2000
Census of Population) and find German's rank. What do you predict this chart will look
like in 20 years?
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Make a chart indicating the percent of population that speaks German, by state.
Compare it to a chart that indicates the percentage of population that speaks Arabic by
state, as shown below.
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Next, examine the languages spoken by county. How does your county of interest
compare to New York County? Compare the historical and present-day reasons for the
diversity of languages spoken in New York County (Manhattan).
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The MLA Language Mapper can also be used to consider the future of languages
spoken. Create a chart that indicates the age breakdown by a specific language in a
county. For example, consider the age categories that speak Arabic in New York
County, below:

Next, consider the age categories that speak Yiddish in New York County:

Based on these two charts, what predictions can you make about the future of Arabic
spoken in New York County versus the future of Yiddish spoken? Which language
will grow in the future, and which will shrink in usage in the future, based on the
current age of the population that speaks each language?

Try these techniques on another region, language, and county.

Step 3: Worldmapper's Cartograms

Investigating 700 Variables Using WorldMapper's Cartograms and Tables.

Cartograms have long been used as a powerful visual aid to understand phenomena.
WorldMapper (http://www.worldmapper.org) offers nearly 700 maps and data tables
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on world countries presented as equal area cartograms, otherwise known as density-
equalizing maps. The cartogram resizes each territory according to the variable being
mapped. Variables include a myriad of social, environmental, energy, population, and
other variables ranging from youth literacy to metals exports to birth rate and much
more. Each map is available on the web site and as a PDF. New this year are the
cartograms by country, that give an indication of population distribution within each
country.

Examine the A-Z map index and select a variable of interest to you. For example,
consider this map of High-Tech Exports from 2002, below.

The territory size shown indicates the proportion of the value of all high-tech exports
in 2002 that came from that country. This is measured in US dollars by purchasing
power parity, meaning that the values reflect the local cost of living.

Why are some countries in southeast Asia (for example, Malaysia and Singapore) that
are small in area appear large on this map? Why do many countries in northern and
western Europe appear so large while others are barely visible? Which whole
continents are barely visible, and why?

Select a variable and show it to your students. Give them 4 choices on what that
variable is and have them choose the variable they believe is represented. Show the
answer and discuss the reasons the variable has that pattern, and why the students'
chosen answer may or may not display the same pattern.
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One of the most useful things about WorldMapper's web-GIS is that each of the data
sets is well documented. For example, part of the high tech exports metadata is as
follows: "United Nations Development Programme's 2004 Human Development
Report, Table 15. The underlying source for these data is the World Bank's 2004
World Development Indicators 2004. Data in this underlying source is itself based on
data from United Nations Conference on Trade and Development and the International
Monetary Fund."

Another useful feature about WorldMapper is that each of the variables is presented as
an Excel table, as shown below:

Not only can the source data be viewed on the website, but the Excel spreadsheet can
be saved to the local computer and brought into ArcGIS. This can be easily done using
the Join Tables function in ArcMap and using the country code as the join field. This
allows the data user to delve deeper into the analysis than is permitted on the
WorldMapper website. For example, birth rates and life expectancies can be analyzed
together, not simply visually, but using statistical measures available in ArcMap and
ArcToolbox.
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Step 4: Social Explorer's Historical Census Data

Investigating 10,000 Thematic Maps and Historical Census Data from
1790-2000 Using Social Explorer.

Social Explorer (http://www.socialexplorer.com) offers over 10,000 thematic maps
and historical census data from each decennial census taken from 1790 to 2000. Social
Explorer is also connected to the larger database of GIS-compatible maps and data on
http://www.nhgis.org - the National Historical GIS. Social Explorer makes a wide
variety of historical census data available in a web-GIS format that was formerly
difficult and time-consuming to obtain. Premade maps and reports exist, such as the
2002 carbon releases by county and the Queens County New York demographics over
time, but the power of the site is that the data user can create customized maps and
reports of the variables that he or she is interested, at the state, county, census tract,
block group, zip code, place, and other scales of geography.

To get started, access the website, click on "maps", and then select "Census
1790-2007" on the next screen.
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You will see a population density map of the USA, as shown below:
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Zoom in for a closer examination of a region over time. Select different years and
different variables. For each year, after the map is drawn, click in the box below to
"save current map." By repeating the process for different years, you can build a time-
sequence animation. Shown below is a time sequence for population density for 5
different years along the Colorado Front Range.
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Reports can also be generated. Try creating a report of your own for a variable and
region of interest. The example below shows religious affiliation in Boulder County,
Colorado:

Exercise 10

Copyright © 2008 ESRI 10-19



Explore other cities, historical periods, and regions with Social Explorer.
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Step 5: Regional Web GIS

Using Web-GIS to Investigate Regions and Places.

One statewide GIS is the Iowa Geographic Map Server (http://ortho.gis.iastate.edu/).
Access this site and select "Map Search" from the top menu. Use "select a city" and
find Ottumwa. Once you see the 2008 Ottumwa aerial on the screen, select different
map layers and zoom levels at the left. In many areas, you can examine aerial
photographs from the 1930s to the present to get a clear idea of land use change over
time.

This site also allows for the download of each of these layers for further analysis
within ArcGIS.
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The Hawaii I-Map service allows for even more functionality with its environment
built on ArcIMS. Access the server on http://gis.hawaii.gov/Website/OPGeneral/
Run.htm and start making your own maps using the tools in the upper left and the
"refresh map" button below the table of contents in the lower right. Toggle between the
layer list and the legend with the tool in the far upper left of the toolset.

Use this web-GIS to analyze such questions as: What is the relationship between
watersheds and terrain? What is the pattern of population and development versus the
areas of threatened and endangered plants? What are areas where tsunamis have struck
the coast in the past? What is the relationship between rainfall and vegetation, and how
and why does it vary so greatly across the islands and on each island?
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Web GIS is also useful for analyzing current events, as shown by the oil spill map of
the Gulf of Mexico created after the 20 April 2010 incident there.
http://www.esri.com/services/disaster-response/gulf-oil-spill-2010/index.html%20%20

Literally hundreds more of these local and regional Web GIS' exist and can be quite
useful for teaching and learning about events or phenomena with a spatial and
temporal component.

Step 6: National Atlas: From Agriculture to Zebra Mussels

Examining Agriculture to Zebra Mussels via the National Atlas.

The National Atlas of the United States (http://nationalatlas.gov) is a web-GIS service
where you can make maps of hundreds of phenomena literally from A to Z--from
Agriculture to Zebra Mussels. The National Atlas began as a web service in 1998, after
printed publication of the first National Atlas was completed in 1970. Nearly 20
federal agencies contribute to the web-GIS service, and it is managed by the USGS.
Begin by selecting Map Maker. Let's say you were curious after the birth of the
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octuplets in January 2009 about the spatial pattern of multiple births. In National Atlas,
access the Map Maker:

Under the People theme, select Health, and then Multiple Births, All Groups. You will
then see a map of multiple births. Select the Map Key and examine the resulting patterns.
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What pattern do you notice? Does it surprise you? What are some reasons why these
patterns may exist? 2.1 was the total fertility rate (number of births per woman in the
USA) in 2006 (based on current birth rates by age). This is the first time since 1971
that the TFR was above replacement, which is the birth rate required for a given
generation to replace itself. The number of twin births per 1,000 total births in 2006
was 32.1. Would you say that multiple births is commonplace? Why or why not?

Next, make a map of hydrography and zebra mussels. Zebra mussels can be found
under the Biology Category, under "Invasive Species."

Examine your resulting map. How do you think, based on your map, that zebra
mussels migrate? Where do you think the source of this invasive species is?

Make a map of cotton production in the USA. Next, change the theme temperature.
You notice that cotton production favors a warmer climate and notice the southern
pattern of latitude in its production. Change the theme to precipitation. Cotton is grown
in warm, wet areas such as Georgia and Louisiana, but also warm, dry areas such as
west Texas, southern Arizona, and south-central California. How can cotton be grown
in these dry regions? Should cotton be grown in these dry regions? Is this the best use
of natural resources? These web-GIS services can serve as excellent springboards for
discussion with your students about the key issues of the 21st Century--energy, climate
change, water resources, sustainable agriculture, tourism impacts, urban sprawl,
biodiversity, migration, and much more.
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Step 7: National Atlas: Analyzing Hurricanes

Hurricanes Are Spatial Phenomena

Hurricanes are among the most common, and most destructive, types of natural
hazards on the planet, particularly in the North Atlantic Ocean and their cousins, the
tropical cyclones of the Pacific. But have you ever considered that hurricanes are all
spatial phenomena? They occur across space--they have a beginning point when their
classification changes from a tropical storm to a hurricane, a track across water and/or
across land, and an ending point when their winds reduce them from hurricane status.
They also have a temporal element. They have a beginning, a duration, and an end, in
terms of each hurricane, and in terms of their typical season of the year in which they
occur. Because they are spatial phenomena, hurricanes can be better understood with
maps, particularly digital maps within a GIS environment. GIS allows you to use maps
as analytical tools-but not just maps that someone else has made. With GIS, you can
make your own maps to assess spatial and temporal patterns, make decisions, think
spatially, think critically, and solve problems with real-world data.

Say that to better prepare for the next hurricane season along the Gulf of Mexico and
Atlantic Coasts, the US National Oceanic and Atmospheric Administration (NOAA),
the US Geological Survey (USGS), and the Federal Emergency Management Agency
(FEMA) have formed a task force to investigate hurricanes that have occurred over the
past 150 years. Hearing about your expertise in GIS, the task force has hired you as a
contractor to research the spatial and temporal pattern of these hurricanes. Your final
report must include an analysis of hurricane tracks, wind speed, and pressure, how
many hurricanes occur in specific US states, how much land area is affected by
hurricanes, and a map showing the results of some of your investigations.

You will use GIS here in two ways: (1) On the Internet, and (2) As local software
running on your desktop computer.

Hurricane Analysis using Web-based GIS

Use National Atlas' Map Maker to make a map of hurricanes on the web.

After selecting Map Maker, on the right side of the resulting map, in the series of map
layers, select Climate' Tropical Cyclones' Major Landfalling Atlantic Hurricanes'
2000s (A). These are the large hurricanes that reached land. The data was collected by
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the National Hurricane Center (NHC), part of the National Oceanic and Atmospheric
Administration.

Then, select "Redraw Map" (B), as follows:

Which ocean is the birthplace of these hurricanes? Do hurricanes move over land, over
water, or both?
Use the identify tool above the map to identify some of the hurricanes that you see.
What are their names? Describe the direction that hurricanes move over this part of the
globe:
From ____________________ To _____________________

You may wish to consult some additional sources if you're not certain of the direction
of hurricane movement. Later in this lesson, you will be able to track the hurricanes as
they moved using desktop GIS software. Are there any hurricanes that don't fit the
above pattern? Use the identify tool to identify any hurricanes that don't fit the pattern.
What direction did these hurricanes move?

What happens to the direction that many hurricanes move after they reach the land
surface? Name at least two reasons why the fact that hurricanes first move over water
is hazardous for land-dwelling people. What other countries besides the USA in this
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region are affected by these hurricanes? If you need a map with country names, use
another web-GIS service such as the XPeditions Atlas from National Geographic.

What 3 countries in this region seem to be the most frequently visited by hurricanes?
What 3 states in the USA seem to be the most frequently visited by hurricanes? Map
hurricanes from some different decades, remembering to select Redraw Map each
time. Name two things that you notice that are similar for each decade.

Is the hurricane frequency increasing by decade? Which decade looks to be the decade
when most hurricanes reached land? Is the hurricane pattern changing over time?

Zoom in on the southeastern USA. Select "Map Key" in the upper right to display the
key, or legend, for your hurricanes. What do the colors mean?

Make at least two observations about how the wind speed changes as the hurricanes
move across the ocean and across land. What implications do these changes have on
the destructive power of hurricanes?

You have been examining the major hurricanes that reached land. In your map layers
list on the right side of the map, change the layer to Atlantic Tropical Cyclones
(hurricanes), 2000. You will now be looking at all hurricanes in the database for that
decade. How does the pattern of all Atlantic hurricanes (cyclones) compare to the
major landfalling hurricanes of the same decade? Why do you think this is the case?
How does the number of all Atlantic hurricanes (cyclones) compare to the major
landfalling hurricanes of the same decade? Why do you think this is the case?

Step 8: National Atlas: Downloading Hurricane Data from the
Internet

Downloading and Using Data from the National Atlas Inside ArcGIS for
Further Analysis
As you have seen, using the National Atlas of the United States as a web-based GIS is a
powerful tool for scientific and geographic inquiry. However, it has limitations in the
kinds of questions that you can ask and the type of analysis possible. To more deeply
investigate North Atlantic hurricanes to fulfill the NOAA-USGS-FEMA requirements,
you have another, even more powerful tool--desktop GIS software.

You have 2 choices in using web-based map content inside your desktop GIS software:
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(1) Add content as a web mapping service inside your desktop GIS. In this alternative,
you are combining your desktop GIS' tools without having to save the data locally.
This option saves on disk space, and is especially useful for data that changes rapidly,
such as wildfires or cloud cover.
(2) Download the data sets to your local computer. For the most rigorous analysis, this
option has the advantage. This is the option we will use for this part of the exercise.

Minimize your web browser window and create a folder on your desktop computer
where you will store all of the data for this lesson, named appropriately, such as
"hurricane_analysis." Raise your web browser pointed to the National Atlas. Click on
the blue hyperlinked text in your layer list on the right side, on Atlantic Tropical
Cyclones:
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A "map layer window" will appear, which describes the Atlantic Tropical Cyclones
layer. On the right side of this new window, under Raw Data Download, select
"Hurricanes-Historical North Atlantic Tropical Cyclone Tracks" as follows:

On the next screen, your data layer will appear at the top, as follows:

Select the file hurralll020.tar.gz and save this file to the folder that you have created on
your desktop computer where you will store all of the data for this lesson:
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When the file has been saved to your computer, navigate to the folder on your desktop
computer where your data file is located. Use 7-Zip (www.7-zip.org), StuffIt
(my.smithmicro.com/win/stuffit.html) or WinZIP (www.winzip.com) or other zipping/
unzipping program on the Mac or PC to expand the file. If prompted to save in a
temporary folder before unzipping, select "yes." When completed, you should have the
files:
hurralll020.shp = the "G" part of GIS - the Geography, or map.
hurralll020.dbf = the "I" part of GIS-the Information, or database.
hurralll020.shx = the "S" part of GIS-the System, that links the G with the I.
hurralll020.txt = the metadata part of GIS-gives information about the data.

Back on your web browser window, repeat the above process, and download the
following files: Under Climate--> Download Major Landfalling Hurricanes (file
hurmjrl020.tar.gz). Under Boundaries--> Download North American Atlas --> Political
Boundaries (file bound0m_shp.tar.gz). Under Map Reference-->Download North
American Atlas--> Populated Places (file pop000x_shp.tar.gz).

For each of the above, you should be downloading the file in "shapefile" format, not
the version in "export" (ArcInfo coverage export) format. Download all of your data
into the same data folder that you created earlier. When complete, you will have 4 .gz
files, and several shp, dbf, shx, and txt files in your data folder.
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Step 9: Hurricane Analysis in ArcGIS I

Now that you have your data downloaded, you are ready for further investigation using
desktop GIS. Access ArcMap, start a new empty map, and then select the Add Data
button:

Navigate to your data folder and add 3 layers (using the Shift key on the computer):
bound_p, hurmjrl020, and pop_pnt, as follows:

After adding your data, save your ArcMap document with an appropriate file name in
the folder you created earlier.

Use the zoom in, zoom out, and pan tools to navigate on your map, and the globe to
zoom back out to the full extent. Examine the far eastern end of the hurricane tracks,
where they begin. Near what continent do hurricanes begin? Zoom back to the eastern
side of North America and northern South America. Right click on your map layers,
select Rename, and then press Enter on your keyboard, to rename the following map
layers: Rename pop_pnt to "cities", rename hurmjrl020 to "Major Hurricanes" , and
rename bound_p to "States and Countries." Define the projection to be Geographic,
WGS 84 for all of the Layers. Make sure your data frame properties are also
Geographic WGS 84. Now, the layers will be easier to work with and you will be able
to perform spatial queries on them.
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With desktop GIS, you can symbolize your map so that it meets your specific needs.
Symbolize the States and Countries by right clicking on "States and Countries" '
Properties ' and Symbology. Change the symbols to Categories, and Unique Values.
Change the Value Field to the field "name", and use a pastels color scheme.

Select OK. Go back to the symbols, click on the Value field to sort it, and find the
Water polygon in the list. Change this to a blue color. Go back to Properties for States
and Boundaries, and this time, select Labels. Label features using Name.

As you move the mouse around on the map, observe the longitude (x) and the latitude
(y) in the lower left. Why is the longitude a negative number for most of the map?
What is the name of the island at approximately 65 West Longitude and 33 North
Latitude? Would you say that this island or the Bahamas is visited more frequently by
hurricanes?

Label the major hurricanes as you labeled the states and countries, but use a different
color and font. Note that as you zoom in, you see more hurricane names as the scale
permits you to see more text. Describe two characteristics of the pattern of major
hurricanes. Compare and contrast the direction of how hurricanes move across
Pennsylvania, Texas, and Florida. Which three USA states would you say experience
the most major hurricanes? Which three countries in North America would you say
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experience the most major hurricanes? Which states in the USA experienced no major
hurricanes, according to this data set? Which countries on the map experienced no
major hurricanes?

Right click on the major hurricanes map layer and open its attribute table. Examine the
Name field. Why are so many hurricanes unnamed? During what year did names start
being assigned to hurricanes? Pay attention to the FID field. How many rows are in the
hurricanes data set? Examine the data carefully. Is each row a separate hurricane, or is
each row just a part a hurricane's track? How long of a period of time does each row in
the dataset cover?
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Step 10: Hurricane Analysis in ArcGIS II

Investigating Hurricane Andrew

You will now investigate Hurricane Andrew, one of the most destructive hurricanes of
the 20th Century. Highlight the Major Hurricanes layer by single-clicking on it. Select
Hurricane Andrew by Using Selection --> Select By Attribute, as follows:

Select "OK" and examine your map. Save your Map Document. Hurricane Andrew
should be highlighted. Describe the path of Hurricane Andrew.

Use the measure tool to measure the path of Hurricane Andrew. How long was
Andrew from start to end, in kilometers?
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Examine the table. During what year did Hurricane Andrew appear? Study the Day
field. How many days did Andrew last?

Study the Wind_MPH and Pressure fields. What is the relationship between wind
speed and pressure? Why? Study the Category field. The categories are: TD=Tropical
Depression, TS=Tropical Storm, H1 through H5 = Hurricane, Category 1 through 5.
What was the wind speed and pressure when Andrew became a hurricane? Which is
more destructive-an H1 hurricane or an H5 hurricane? How do you know? During how
many days was Andrew a hurricane?

Symbolize hurricanes based on their Category. What countries or states was Andrew
near when it was a H5 hurricane? What category was Andrew when it reached Florida?
Andrew then moved over water again, but made another landfall. What was the second
US state impacted by Andrew? What category was Andrew when it made this second
landfall? What state did Andrew pass through on the second landfall?

Do the same type of analysis with a hurricane of your own choosing. Describe the
path, duration, and intensity of this hurricane. How does your chosen hurricane
compare to Andrew in path, duration, and intensity?

Step 11: Hurricane Analysis in ArcGIS III

Assessing Hurricane Impacts

In this section, you will assess the impact of hurricanes on specific states and cities.
Let's start with Florida. Zoom to there and clear your selection with the Clear Selection
tool.
Next, highlight the Major Hurricanes map layer. Next, select features on the map using
the Select Features tool.
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Click on Florida using this tool. You might need to use Set Selectable Layers under the
Selection menu first to ensure that you are just selecting Florida. Then, use Selection--
> Select By Location to select as follows:

When finished, you should see all of the hurricane tracks that intersect Florida
highlighted on the map. Open the attribute table for Major Hurricanes. How many
hurricane track segments crossed Florida?

Repeat the above process for another state frequently in the news for hurricanes--
Louisiana. Clear your selection, select Louisiana, and examine the attribute table when
completed. Did more hurricanes cross Louisiana or Florida?
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Hurricanes impact much more of the surface and oceans than these thin mapped tracks
indicate. They can be dozens or a hundred kilometers wide. By using the Buffer tool, you
can get an impression of the amount of land impacted by hurricanes. With the hurricanes
in Louisiana still highlighted, select the Buffer tool. This is located in ArcToolbox under
Analysis and Proximity. Create a 20 kilometer buffer in the buffer wizard. This will
create a 40 km swath for each hurricane in Louisiana.

Select OK. Examine your map. Resymbolize and reorder data as needed. Approximately
what percentage of the land area of Louisiana would you estimate has been affected by
hurricanes using a 40 km swath width? Which part of the state is most heavily affected?
Label your cities as you did for hurricanes and states and countries earlier. Which cities
in Louisiana have been impacted by the most hurricanes?

In this section you will discover the number of hurricanes that have passed near New
Orleans. First, clear your selected hurricanes. Next, select New Orleans using Select
By Attribute. New Orleans will now be highlighted on your map. Use the Buffer tool
again in ArcToolbox. Create a new buffer around New Orleans at 100 kilometers. Use
your new buffer to intersect by location the features from the layer "Major
Hurricanes."

Examine the major hurricanes attribute table. How many major hurricane segments
passed within 100 kilometers of New Orleans? Examine your map. What are some of
the names of these hurricanes?
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Remember, however, that up to this point, you have been examining only the major
hurricanes. Remember that your final report must include a consideration of all
hurricanes. Select the Add Data button, navigate to your data folder and add
hurralll020 to your map. This represents all hurricanes for a 150 year period. Rename
this map layer to "All Hurricanes." How does the pattern of all hurricanes compare to
that for the major hurricanes?

Examine the table for all hurricanes and pay attention to the FID field. How many
hurricane segments are in the data set?

Clear your buffer with the Clear Selection tool, and re-buffer 100 kilometers around
New Orleans, this time selecting from "all hurricanes". How many total hurricanes
passed within 100 km of New Orleans?

Repeat the process from earlier when you selected hurricanes that crossed Florida and
Louisiana, but this time, select from the all hurricanes dataset, rather than just the
major hurricanes. How many total hurricanes crossed Florida and Louisiana? How
does this number compare to just the number of major hurricanes? What percentage of
all the hurricanes were major hurricanes in Florida? Show your work. What percentage
of all the hurricanes were major hurricanes in Louisiana? Save your map document
again.

Final Assessment: Write a few sentences of how GIS technology and spatial analysis
has enhanced your understanding of North Atlantic hurricanes. Write your assessment
in your report of North Atlantic hurricane impacts for NOAA-USGS-FEMA. Include
some of the maps you generated with online and desktop GIS in your report. How did
the fact that you are using Geographic coordinates affect your final analysis? What are
some of the inadequacies and dangers of using Geographic coordinates for this type of
analysis?

Step 12: Combining Desktop and Web GIS

The Best of Both Worlds? Streaming Data from Web-GIS to the Desktop
GIS Environment.

Combining desktop GIS and web based GIS may represent the best of both worlds. It
allows you to access all of the GIS tools in the desktop GIS software, and also stream
data from the Internet for access of large and often real-time or near-real-time data
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sets. Combining desktop tools with Internet map services is easier to do than ever
before. Let's explore just a few examples.

Let's say you have some field coordinates collected from a GPS. Start a new ArcMap
document and add trackpoints_18apr, waypoints_18apr, and trackline_18apr. Change
the symbology if you would like to.

The data has no base data. But not for long! This is because you can now access the
wealth of base data from ArcGIS Online. Use File --> Add Data from Resource
Center. You will be placed on the ArcGIS Resource Center web site:

Select World Street Map --> Open the layer (lyr) file.

In ArcMap, use File --> Add Data from Resource Center.
This time, select World Imagery --> Open the layer file.

In ArcMap, use File --> Add Data from Resource Center.
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This time, select US Topo Maps --> Open the layer file.

You now have 3 base layers for your field work. Use the swipe tool to compare and
contrast these different layers, or simply turn them off and on or reorder them in the
table of contents.

Take time to examine the wealth of other data available through ArcGIS Online,
starting with http://www.esri.com/arcgisonline, or specifically on:
http://resources.esri.com/arcgisonlineservices/index.cfm?fa=content

Let's take another example. Say you are doing some weather-related research in your
GIAS and you need to examine a current infrared satellite image. First, start a new
ArcMap session and add the US_STATE layer. Symbolize your state lines as hollow
with a yellow or white outline. Next, add another layer, navigating all the way to the
top of the directory tree and selecting "GIS Servers." Add ArcIMS Server and enter the
following web site: http://maps.pasda.psu.edu. The PASDA site (Pennsylvania Spatial
Data Access) is the public access geospatial information clearinghouse for the
Commonwealth of Pennsylvania; it has served for 12 years as Pennsylvania's node on
the National Spatial Data Infrastructure, Geospatial One-Stop, and the National
Biological Information Infrastructure. It contains data for Pennsylvania but much
more, including live feeds from the US National Weather Service.
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Expand the maps.pasda.psu.edu server to see the many layers available from this web-
GIS service. The National Digital Forecast Database (NDFD) contains a seamless
mosaic of digital forecasts from National Weather Service field offices working in
collaboration with the National Centers for Environmental Prediction (NCEP). Select
the Latest Infrared Satellite choice, as shown below:
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Navigate on your map to examine the near-real time infrared satellite image:

Combining desktop and web-GIS is valuable in other ways as well.
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Start a new ArcMap. Add the Pacific Disaster Center as an ArcIMS site:
http://www.pdc.org and then expand the components underneath the server. Add the
"Atlas Main" component and examine the wealth of layers inside this layer.

What is the relationship between storm intensity zones and latitude? Why?

What is the pattern of recent wildfires?

Use http://www.mapdex.com to search for other web-GIS sites. MapDex is a search
engine designed to search for servers that host mapping and GIS services.

Step 13: More Online Mapping and Analysis

Now that you have used these web-GIS resources to investigate spatial
patterns and processes from a local to a global scale, continue your
investigation by using the following resources:

Gapminder's graphs and map-based human development indices:
http://www.gapminder.org

Nationmaster's data and rankings on world countries:
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http;//www.nationmaster.com

Near real-time wildfires:
http://www.geomac.gov

Near real-time earthquakes:
http://earthquakes.usgs.gov/eqcenter/

Geocoded Ground Photographs: American Mile Markers http://www.kodak.com/US/
en/corp/features/onTheRoad/ and the Degree Confluence Project of photographs and
stories at latitude-longitude intersections: http://www.confluence.org.

Historical Maps on http://www.davidrumsey.com and historical topographic maps on
http://historical.maptech.com.

View local mapping applications in San Diego on:
http://www.sandag.org/index.asp?subclassid=70&fuseaction=home.subclasshome

City of Greeley, Colorado Property Information Map - uses ArcGIS Server:
http://gis.greeleygov.com/origin/propinfo.html

Solar Boston - select the best sites for Solar Panels in the City of Boston, uses ArcGIS
Server:
http://gis.cityofboston.gov/SolarBoston/#

Maryland i-Map: One Maryland One Map - uses ArcGIS Server:
http://mdimap.com/imap/

Other ArcGIS Server sites:
http://www.esri.com/software/arcgis/arcgisserver/success_stories.html

View a wealth of other web-GIS sites on http://edcommunity.esri.com and select the
"Data" tab.

See nearly 300 more resources on the listing: geotools_mapping_and_analysis.pdf on
http://edcommunity.esri.com/arclessons.

Conclusion

For complete lessons on the use of web-GIS, see the ArcLessons GIS-based curriculum
library, on: http://edcommunity.esri.com/arclessons.
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Web-based GIS will continue to develop at a rapid pace, combining functions from a
variety of different services in many ways, including mashups. You have analyzed spatial
phenomena using these easy-to-use but powerful Web-based tools and in combination
with desktop-based GIS tools. Web-GIS and desktop GIS are becoming increasingly
critical and powerful decision-making tools that many educators feel must be included
throughout education if future decision-makers are to solve the complex problems of
today and tomorrow.
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new time tools in
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Exercise 11A: Visualizing change with
the Time Slider
Estimated time: 25 minutes
Challenge: Exploring the Time Slider on
your own
Estimated time: 5 to 8 minutes

Exercise 11B: Visualizing Datasets with
3-D Analyst
Estimated time: 35 minutes
Challenge: Group Layer animation in
ArcScene
Estimated time: 10 min





11AExercise 11A: Visualizing change with the Time Slider

Estimated time: 25 minutes

A tsunami also known as a 'harbor wave' or tidal wave is a series of water waves (called a
tsunami wave train caused by the displacement of a large volume of a body of water,
such as an ocean or a large lake. Due to the immense volumes of water and energy
involved, tsunamis can devastate coastal regions. Casualties can be high because the
waves move faster than humans can run.

Earthquakes, volcanic eruptions and other underwater explosions, landslides and other
mass movements and disturbances above or below water all have the potential to generate
a tsunami.

In this exercise you will learn how to use the time slider tool in ArcMap to visualize the
hourly location and possible areas affected by a Tsunami wave as it travels from a
location you pinpoint as the origin then showing its movement outward from the origin.

The data set you will be using allows you to interactively pinpoint the origin of the
Tsunami and then track its hypothetical progress across the Atlantic Ocean.

By the completion of this exercise you should be able to:
▪ Pre-process a dataset to enable time-based animation
▪ Configure time properties for a layer
▪ Use the Time slider tool and modify time properties
▪ Generate an animation using the time slider

Step 1: Creating a temporal dataset for a Tsunami

For this exercise, you will begin by pinpointing the origin of a Tsunami, then using a
model builder model to perform some preprocessing to create a dataset of contours that
represent the movement of the Tsunami wave on an hourly basis. These contours are the
ones we will use with the time slider tool to visualize the tsunami movement.

Using the geoprocessing model you can specify the origin of the undersea earthquake
location somewhere in the northern half of the Atlantic Ocean, and then based on your
input, the model will create a collection of time contour line features illustrating the
progression of the tsunami at hourly intervals.
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Start ArcMap and open C:\educ\Animations\Tsunami.mxd.

Note: The map document, consists of data representing a portion of the Atlantic Ocean,
as well as a countries polygon layer and a raster layer made up of cells with values
representing the travel time across the study area. This travel time raster was created
using spatial modelling and was generated using known ocean depths and a formula that
computes wave speed in relation to ocean depth. Notice the effect the Mid atlantic ridge
has on the wave speed. aLso note that Shallow water generally has higher wave speed
than deeper waters. Shallower water has a lighter blue shading, while deeper water has a
darker shading.

You will begin by adding a custom toolbox that contains a model to create the dataset.

From the main menu select the Customize >> Extensions and verify that the "Spatial
Analyst" checkbox is checked and click "Close".
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From the main menu select the Geoprocessing >> Geoprocessing Options. On the
menu, make sure that both the "Overwrite the outputs of geoprocessing operations"
and the "Add results of geoprocessing operations to the display" checkboxes are
checked.

Display the ArcToolbox window by clicking the ArcToolbox icon on the standard
toolbar.
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Using the docking control arrows located in the center, top, bottom, left

and right of the ArcMap application, position the ArcToolbox window to the right side
of the application.
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Right click the "ArcToolbox" root icon at the top of the window and choose "Add
Toolbox…"

Navigate to C:\EduUC\Animations\TimeBased\Tsunami.gdb and select the
TsunamiTools toolbox, click the "Open" button, and click "OK". to view the content
of the toolbox.

The "Build Tsunami" model tool is an "inteface" to this model which is designed to
accept your input for the origin of the Tsunami. Using this input location the model then
generates a series of contour lines representing the path of the Tsunami as identified on a
cost surface. Once generated, the model adds a Date and Time field to the contours and
converts the date and time vales into a correctly formatted Date field for consumption by
the Time Slider tool.
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If you wish, you may explore the model by right clicking on the "Build Tsunami"
model tool and choosing edit to open the model. Explore the model,but Do not change
anything.

when done close the model without saving any changes.

Your model should look like the graphic below.

From the Tsunami Tools toolbox, double click on the Build Tsunami tool to launch it.

You will notice that you now have a dialog to interact with. The dialog choices represent
the input and output parameters for the model that you can set.

At the top of the dialog is a warning that you can dismiss. This is pointing out that
some datasets already exist and that you will overwrite them when you run the model.

Now lets start using the model. In the dialog, Click the "Define Features" button
(pointer with dot location) and then click a location in the Atlantic Ocean on the map.
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You can pick anywhere you wish. Somewhere in the West Indies may be a good
choice.

Be careful to click in a blue area because the underlying geoprocessing
tool (Cost Distance) requires contiguous ocean cells in order to work
correctly. There is no need for you to make any changes to the rest of
the model

Press "OK" to run the model tool. It will take 60 to 90 seconds to run. If neccessary,
dismiss the progress window and you should see the wave origin as a red triangle point
location with thick red lines expanding out from that point.
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Double click the WaveHrContours layer and open its layer properties and select the
"Labels" tab. Make sure the "Label features in this layer" checkbox is checked.
Configure the labels to be 10 pt, Arial, bold, white color. Click the "Expression..."
button and enter the following: "Hour-" + [CONTOUR]. Click "OK" twice.

Right click on the WaveHrContours layer and select "Open Attribute Table". The
"CONTOUR" attribute field contains the hour value for each contour and represents
the temporal data we would like to visualize.
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Notice that the model added a TsunamiDayTime field as well as a
TsunamiDayTime_Date field that represents a the day and time of occurance or your
simulated Tsunami, it is the TsunamiDayTime_Date field that will be used with the
time slider to "Animate" wave movement.

When done exploring the table,you can close the table.

Note: Note the supported time field formats

- Any Date field
- String fields of these formats:

▪ YYYYMMDD
▪ YYYY/MM/DD
▪ YYYY-MM-DD
▪ YYYYMMDDhhmmss
▪ YYYY/MM/DD hh:mm:ss
▪ YYYY-MM-DD hh:mm:ss

- Numeric fields of these formats:
▪ YYYYMMDD
▪ YYYYMMDDhhmmss

Step 2: Setup and use the Time Slider Window

Now that you have a temporal dataset, its layer properties have to be set in order to
visualize the wave movement using the Time Slider in ArcMap.
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Time properties on the layer are enabled by checking theEnable time checkbox on the
Time tab of the Layer properties dialog box.

For all time-enabled layers you need to specify how the time values have been stored in
the data. You also, need to specify a time step interval, which represents how often the
time values were recorded in your data.

Now you will enable tme on the layer

Double-click the WaveHrContours layer in the table of contents to open the Layer
Properties dialog box.

Click the Time tab.

Check Enable time on this layer.

The Time properties and Advanced settings controls are now made available. Also, some
of the controls are populated for your convenience. You can choose to change these
depending on your needs.

Based on whether the time stamps for the data are stored in a single field or in two fields
in the attribute table, you can choose one of the following options for defining the value
for Layer Time.

In this case, the WaveHrContours layers has a precreated Date field and the Tme
Properties dialog has recognised this field and has automatically set this property for you.
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All that remains for you to do is to calculate the time extent of your data.

Click the Calculate button

The layer time extent is reported. The time extent of your data is stored with the layer
properties, which is then used by the Time Slider to define the full time extent of the
Time Slider.

As a last step, check on Display data cumulatively.
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click OK to dismiss the layer properties.

Next lets explore the time slider window. The Time Slider window provides controls that
allow you to visualize temporal data in ArcGIS.

You can invoke the Time Slider window by clicking the Open Time Slider Window
button on the Tools toolbar.

Before you start exploring the timeslider tools, click the Enable time on map button.

Note: The button is unavailable if you do not have any time-enabled datasets in your
map.

If you wish, Click the Options button to explore the time slider properties. Dont make
any changes yet.
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Click the Play button to play a time animation that steps through your data
sequentially. You can pause the time animation at any point by clicking the Pause
button.

Click and drag the Time Slider Control to the right or left to step through your
temporal data interactively.

Explore Timestamping by click the Next timestamp button to step forward to your
next date.

Click the Previous timestamp button to step back to the previous time stamp.
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Click the Decrease time extent button to shorten the time extent of the time slider. This
allows you to focus on a shorter period of time.

Click the Increase time extent button to lengthen the time extent of the time slider.
This allows you to focus on a longer period of time.

Note: When you increase or decrease the time extent, the start and end times reported on
the time slider change.

When done exploring the timeslider, click the Enable/Disable time on the map button
to toggle between displaying data based on the time constraints set using the Time
Slider Control and displaying the entire data without any time constraints.

If you wish, click the Export to Video button to export your time visualization to a
video or as sequential images.

Challenge: Exploring the Time Slider on your own
Estimated time: 5 to 8 minutes

In this step you have the opportunity to explore the time slider on your own.

Switch Dataframe to the Gulf of Mexico Oil Spill dataframe.
Explore and symbolize the diffent layers added

Notice how the base layer is derived from an ArcGIS Online sources and how this adds
a creative and simple way for you to gain context for exploring the recent Gulf of
Mexico Oil spill data.

The OilSlickAll layer has a date field that can be used to enable the time slider. You
can now apply the knowledge and skills learnt in the previous steps to enable time on
this layer and then explore the Time Slider tool.
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Conclusion

In this exercise you learned how to pre-process a layer's and prepare it for use with the
time slider. You learnt how to enable time properties for a layer and you explored the
time slider tool.
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Challenge Solution: Exploring the Time Slider on
your own
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11BExercise 11B: Visualizing Datasets with 3-D Analyst

Estimated time: 35 minutes

In this exercise you will explore some of the animation tools included with ArcMap,
ArcScene and ArcGlobe. The animation tools can be used to create simple and complex
dynamic effects, visualize changes in perspective, in scene properties, model geographic
movement and explore temporal changes in data.

An animation consists of the rapid display of a sequence of 2-D or 3-D images in order to
create an illusion of movement. Animations are used to visualize how data changes with
time and space.

An animation may consist of one or more Animation Tracks executed in parallel or
perhaps similar or different types of tracks that can be played together.

An Animation Track is a collection of keyframes of the same type, where each track is
bound to one or more objects and describe their behavior over animation time.

A keyframe is a snapshot of an object's properties at a certain time. The objects can be - a
camera, Layer, Scene or Map View.
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Note: Animations can be created in the following ways:

▪ Building animations from keyframes
▪ Capturing current view to animation
▪ Recording and playing a flyby

▪ Creating Time Layer animations
▪ Building animations from paths

▪ Creating flyby using flight paths
▪ Moving layers along a path (Scene)

▪ Creating Group Layer animations
▪ Manipulating object properties

▪ Using the Animation Manager
▪ Editing keyframe and track properties

Step 1: Creating Animations by capturing your view in ArcMap

Mount St. Helens has erupted more frequently than any other volcano in the Cascade
Range during the past 4,000 years.
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The volcano has exhibited a variety of eruption styles—explosive eruptions of pumice
and ash, slow but continuous extrusions of viscous lava, and eruptions of fluid lava.
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Evidence of the volcano's older eruptions is recorded in the rocks that build and the
deposits that flank the mountain.

Eruptions at Mount St. Helens over the past three decades serve as reminders of the
powerful geologic forces that are reshaping the landscape of the Pacific Northwest. On
May 18, 1980, a massive landslide and catastrophic explosive eruption tore away 2.7
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cubic kilometers of the mountain and opened a gaping, north-facing crater. Lahars flowed
more than 120 kilometers downstream, destroying bridges, roads, and buildings. Ash
from the eruption fell as far away as western South Dakota.

Lets start exploring the animation tools in ArcMap, by capturing the current view as an
animations

Start ArcMap and open C:\educ\Animations\StHelens.mxd

Notice the data layers in the TOC. There are 2 grouped layers - Before and After. These
illustrate the landscape of the Mt StHelens volcano before and after the 1980 eruption.

The EruptionsImpact layer illustrates the Gain and Loss of materials after the eruption.

Notice that the Before and After grouped layers are checked on. Check the Before
layer off and explore the difference in the landscape after the eruption.

Toggle the Before layer on and off a few times to see the magnitude of the effect of the
eruption on the landscape.
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With the After layer still checked on, turn on the EruptionImpact layer.

Notice how the colors illustrate the areas of Loss and areas of Gain of volcanic materials
as a result of the eruption.

Check off the EruptionImpact layer before continuing

Next we will use the "Capture View" tool on the animation toolbar to capture an
animation to share with others illustrating the impact of the eruption at Mt St Helens
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From the main menu select Customize >> toolbars >> Animations

To create a simple animation, you will use the "Capture View" tool to capture an
animation
Before you begin, click Open Animation Control button and reposition the new
toolbar

Now, click Capture view button to capture your first Keyframe

Each time you press the Capture view button you are creating a new Keyframe. Later
when you play the animation ArcGIS will fill in (Interpolate) the frames between those
Keyframes you have captured and the result will be an animation of the views you
displayed when capturing a view.

Zoom in and click the "Capture View" tool once again

Pan around and click the "Capture View" tool - do this several times at different
locations
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Click Options botton on Animation Control menu

Set By duration to 15 seconds.

Note - that this is a playback and the refresh rate of the map is not very fast. However,
once you export it to a video, the animation should be very smooth because all the
frames will be captured in the video.

Click the Play button on the Animations control dialog to view the simple animation
you have just created.

Now lets explore your animation's components.
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From the Animation toolbar >> Animation Menu, choose Animation manager.

Anytime you want to start a new animation you want to clear any
current animation, this will remove existing keyframes and tracks
from the animation manager and allow you to start afresh.

From the Animation manager, clickthe Animation manager - Tracks tab.
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Notice, how all the keyframes we just captured are part of one track. In this track, the
Map View is attached to the track and it therefore animates Key Frames captured from
the current Map View.
Switch to the Keyframe tab and notice how each time you clicked the Capture View
button you were creating a new keyframe on the track.

Notice how each Keyframe has properties - in this case the extent of the data at the time
the Keyframe was captured. If you desired, you could modify the keyframe properties
here and rerun the animation to see the effect.

As a final step, you could Export your Animation - at this point, we won't do this as it is a
time consuming process. By exporting your animation, you can share the results of you
data visualization with other who do not have access to ArcGIS but do have access to a
media player.

If you wish you can save the animation to a file, you may do so now. This will create a
.AGA file that stores all your animation properties. This allows you to reload the
animation file later and modfy its properties.

When you are done, close ArcMap and do not save changes to the map document.

To illustrate the result of exporting your animation, you may want to run the video -
StHelensBefore.avi located in ..\animations\StHelens folder to illustrate the Capture
View result. The video is located in you data folder and can be run using a media
player.

We also created an additional, After and Effect of Eruption Videos using the same
Keyframes but changing the layer we were displaying. You can run these as well if
you wish.
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Step 2: Animating bookmarks in ArcAcene

The object of this exercise is to use the Capture View tool to create simple animations in
ArcScene Using Bookmarks

Open C:\educ\Animations\StHelensArcScene.sxd document

You have just launched the 3D analyst ArcScene application.

Ensure that the 3D analyst extension is checked on. you can do this from the main
menu, by selecting Customize >> Extensions and verify that the "3D Analyst"
checkbox is checked.

Notice that this Scene document has 2 grouped layers - Before and After. These illustrate
the landscape of the Mt St Helens volcano before and after the eruption. The
EruptionsImpact layer illustrates the Gain and Loss of materials after the eruption.
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Just as was done in the previous exercise,you could use the "Capture View" tool to create
simple animations. In this case however,we will use some existing bookmarks in the
ArcScene document and create keyframes from those bookmarks
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Launch Book Mark manager. If you like explore the bookmarks that have been created
for you.

From Animation Toolbar -> Animation menu , Open "Create Keyframe" dialog
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Check the box to import a bookmark to a keyframe.

Specify the following:
▪ Type ->Camera
▪ Bookmark -> Summit
▪ Source Object -> Camera of Main View
▪ Destination Track -> Click New to create a new track (ONLY DO THIS STEP

ONCE, FOR YOUR FIRST BOOKMARK)
All Keyframes created from Bookmarks will be on this one track

▪ Click Create to create the new Keyframe for bookmark

Repeat the process for each of the additional Bookmarks, (BUT ......DONT CREATE
ADDITIONAL DESTINATION TRACKS - each keyframe created for a bookmark
needs to go on only the one destination track you already created )

This option is useful if you've created bookmarks that take you to a certain location in the
display, and you want to incorporate them into your animation. This option is disabled for
all track types except camera and map view tracks, and if no bookmarks have been
created.

Next Show the Animation manager -> Track tab.

Notice all the keyframes we just captured are part of one track. In this track, the Map
View is attached to the track and it therefore animates Key Frames captured from the
bookmarks in the current Map View.
Switch to the Keyframe tab
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Notice, how each time you choose a bookmark,a new keyframe was created on the track.
Also notice how each Keyframe in the ArcScene document has different properties -
Angles, Pitch Roll and other properties specific to 3D navigation are maintained.

The animation manager is used to manage and edit the settings for the keyframes and
tracks that compose an animation and to preview the way your animation will play.

Keyframes tab - lists Keyframes:
▪ Remember that Keyframes are a 'snapshot' of the property values of an object or

objects (such as a layer).
▪ Depending on the type of keyframe, different properties of the object being

animated are listed as column headers.

Tracks tab - Lists the animation tracks that have been created:
-

Beginning and ending time can be set for each track
▪ Track name and the loop option can be set
▪ Type of track indicated in the Type column

Time View tab - used to preview animation:
▪ Drag the vertical red line that appears when you click in the time scale display to

preview the animation in the display, or to move to a specific point in the
animation.

▪ All keyframes in animation tracks are positioned in a time scale from 0 to 1
▪ Changing location within time scale - alters the speed of animation segments
▪ Keyframes of a track can be modified to coincide with keyframes in other tracks.
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In the Animation controls dialog, set By Duration to 15 secs

Now, play the animation.

Notice how the animation begins with the Full extent, then zooms to the Summit
Bookmark, runs for 10 frames and returns back to the Full extent when done.

As a final step, you could Export your Animation - at this point, we won't do this as it is a
time consuming process. By exporting your animation, you can share the results of you
data visualization with other who do not have access to ArcGIS but do have access to a
media player.

If you wish you can save the animation to a file, you may do so now. This will create a
.AGA file that stores all your animation properties. This allows you to reload the
animation file later and modfy its properties.

When you are done, close ArcScene and do not save changes to the scene document.
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Challenge: Group Layer animation in ArcScene
Estimated time: 10 min

Open the StHelensGroupLayer ArcScene document
Describe the layers in the TOC

There are 5 layers consisting of Before and After and a Cut/Fill layer. These illustrate
the landscape of the Mt StHelens volcano before and after the eruption. The
EruptionsImpact layer illustrates the Gain and Loss of materials after the eruption.

From the Animations toolbar, choose Create Group Animation

Make the following settings:
▪ Select a group layer - Top Level Layers. Top-level layers are used to animate all

layers in the TOC
▪ Check - One layer at a time
▪ Check - Invert order
▪ Set Fading transitions to All
▪ Check - Blend layers when fading

When done click OK

From Animation Controls dialog - ensure By Duration is set to 20 seconds
Click Play to run the animation.

The group layer animation is essentially looping through each layer in the TOC and
systematically turning the layers on and off while fading in and out for each layer.

Open and explore the Animation manager -> Track tab.

Notice how each layer in the TOC now has a track associated to it.
Swirtch to the Animation manager - Keyframes tab.

Notice how there is a keyframe to begin and end the Fade-In and a Keyframe to begin the
Fade-out and end the Fade-out

Note that Fade In and Fade Out is setting transparency levels fromm100 to 0 and doing
the reverse 0 to 100 when Fading in.

Play your animation once created

If you have time, explore saving and exporting your animation.
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When you are done close the ArcScene document without saving

Conclusion

In this exercise you learned how to use the arcgis animation tools to visualize changes to
the properties of an object (such as a layer) or a set of objects (such as multiple layers).
You explored using animations to make your documents come alive by storing actions so
they can be replayed as you choose.
ArcGIS allows different types of animations to be created in ArcMap, ArcScene, and
ArcGlobe. During the exercises you explored some of these, remember these is still
plenty to learn and explore.

You may want to try the following on your own data:
▪ Navigate through the display (zoom and pan in ArcMap, or navigate in ArcGlobe

or ArcScene).
▪ Animate the transparency or visibility of layers.
▪ Move the camera or map view along a path.
▪ Move a layer along a path (ArcScene only).
▪ Animate data through time while moving the camera.
▪ Change the background color, lighting, or vertical exaggeration of a scene

(ArcScene only).

Selected Mt St Helens References
▪ Clynne, M. A., Ramsey, D. W., and Wolfe, E. W., 2005, Pre-1980 eruptive

history of Mount St.Helens, Washington: U.S. Geological Survey Fact Sheet
2005-3045, 4 p., http://pubs.usgs.gov/fs/2005/3045

▪ Major, J. J., Scott, W. E., Driedger, Carolyn, and Dzurisin, Dan, 2005, Mount St.
Helens erupts again; Activity from September 2004 through March 2005: U.S.
Geological Survey Fact Sheet 2005-3036, 4 p., http://pubs.usgs.gov/fs/2005/3036

▪ Moore, J. G., and Albee, W. C., 1981, Topographic and structural changes,
March-July 1980- Photogrammetric data, in Lipman, P. W. and Mullineaux, D.
R., eds., The 1980 eruptions of Mount St. Helens, Washington: U.S. Geological
Survey Professional Paper 1250, p. 123-134.

▪ Schilling, S. P., Ramsey, D. W., Messerich, J. A., and Thompson, R. A., 2006,
Rebuilding Mount St. Helens: U.S. Geological Survey Scientific Investigations
Map 2928, http://pubs.usgs.gov/sim/2006/2928

▪ Swanson, D. A., and Holcomb, R. T., 1990, Regularities in growth of the Mount
St. Helens dacite dome, 1980-1986, in Fink, John, ed., The mechanics of lava
flow emplacement and dome growth: International Association of Volcanology
and Chemistry of the Earth's Interior, Proceedings in Volcanology, v. 2, Berlin,
Springer-Verlag, p. 3-24.
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Challenge Solution: Group Layer animation in
ArcScene
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12Exercise 12: Exercise

Estimated time: 45 minutes

ArcGIS.com is a Web site you can visit to begin your online ArcGIS experience. You can
create maps, find and use maps, applications, and tools, and share your maps and
applications with others. Within the site, you will find applications for building and
sharing maps. You will also find thousands of basemaps, specialty layers, applications,
and tools that you can view and use, plus communities you can join.

ArcGIS Online are the aspects of ArcGIS that are available online. This includes maps
and tasks hosted by ESRI, APIs, and GIS functionality such as address locators and
routing services. Much of ArcGIS Online is built into your application experience, for
example, you can share packages directly through ArcGIS Desktop and you can access
ArcGIS Online services through a mobile device.

In this exercise you will:
▪ Navigate ArcGIS.com and explore ArcGIS Online basemaps
▪ Create a web map using ESRI basemap layers
▪ Create an ArcGIS Online account
▪ Create a web map using ESRI basemaps in combination with user-provided layers
▪ Geocode a table of addresses using an ArcGIS Online service
▪ Create and upload layer packages

Step 1: Begin to explore ArcGIS.com

At the ArcGIS.com site, you can browse featured ArcGIS Online content such as maps
and applications published by ESRI and the ArcGIS community, and add comments and
ratings. You can upload and share your own items, either with specific groups that you
created or are a member of, or you can share your items publicly. Use the newly designed
Web Mapping application to quickly create online mashups that you can also share with
others
.
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View Gallery

Open a web browser and navigate to ArcGIS.com at www.arcgis.com.

Take a moment to read through the site and orient yourself. This is the main place to
begin your online ArcGIS experience. You can always get back to this page by
clicking the ArcGIS logo in the upper left corner of each page.

Click Gallery at the top of the page.

The Gallery shows featured maps and apps from the ArcGIS Community you are now
becoming a part of.

Browse the maps and hover over a map of interest. Read the description, which
includes information about the data and what format it is in.

For the purposes of this exercise, choose one with Web Map as the data type and click
to open and view the map.

The ArcGIS Map Viewer will be launched for you to be able to navigate and explore the
chosen map. Notice along the left Table of Contents, you are given the opportunity to
open the map in other applications and then to add to the current map.

Education User Conference 2010

12-2 Copyright © 2008 ESRI



Click the "ArcGIS.com Home" link at the top of the page and then choose Gallery
from the pulldown.

Try another map if you wish.

View groups

Click the ArcGIS logo in the upper left corner of the page.

Click Groups at the top of the page.

Click List all public groups.

Browse the list of groups within ArcGIS Online and the ArcGIS Community to
discover maps and resources currently shared.

Learn More

Click the ArcGIS logo in the upper left corner of the page..

Click Learn More in the lower right part of the site. This will launch the ArcGIS.com
Help system for browsing and searching.

From here you will go on and create a web map using the online resources available
through ArcGIS.com.

Step 2: Create a map with ArcGIS Online

First you will use ArcGIS Online and create a web map starting from an ESRI base map.

This online content from ESRI is powered by ArcGIS Server and includes basemaps,
reference layers, and specialty maps. There are also task-based functional services, such
as, geocoding and routing which we'll look at in a later step.

Click the ArcGIS logo in the upper left corner of the page. (www.arcgis.com)

Click Make a Map or the Map link at the top of the page.

The ArcGIS Online Web Map Viewer opens in a new window. The map opens at the
extent of the contiguous United States, but this is a world topographic map service.

On the left side of the map viewer, move down the slider to the very bottom to zoom
all the way out.
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Scroll your mouse wheel forward to zoom in.

In the Search field for Address, City, or Location, type in Pasadena, CA.

Click Find.

Click the slider or mouse wheel to zoom in and locate the Rose Bowl or Brookside
Park area - intersection of Hwy 134 and 210.

Press SHIFT and draw a box with the mouse as shown in the diagram below.

Note: Using SHIFT and drawing a box is a very common method in web map viewers to
zoom in.

Notice that the level of detail increases significantly as you zoom in on particular areas.
In fact here, you can even see the parking spaces and trees! This level of detail is not
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available in all areas, but with the Community Mapping Program you will find more and
more areas with this much information being contributed.

You will now change your basemap once again and look for your current location - the
San Diego Convention Center.

Click Basemap and choose Streets from the basemap choices.

Note: For a thorough list of the online maps and tasks available from ESRI, see the ESRI
Maps and Data group.
http://www.arcgis.com/home/
group.html?owner=esri&title=ESRI%20Maps%20and%20Data.

You might notice that at certain scales the information is not available.

Zoom out using the slider bar.

In the Search field for Address, City, or Location, type in 111 W. Harbor Drive, San
Diego, CA.

Click Find.

Zoom out slightly to view the vicinity of the San Diego convention center, as shown in
the graphic below.
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On the left side of the viewer, click the Show Contents of Map button. You will see the
Streets map service listed in the table of contents.

Click the small arrow next to the service and choose Description.

This will open a thorough description of the contents of the World Street Map service and
information regarding the service capabilities. If you are familiar with ArcGIS Server,
this would be the Services Directory for the ArcGIS Online.

At this point you could add more layers to your map. However, you will not be able to
save your web map until you have signed in to ArcGIS online. Without an account, you
are limited to finding and using publicly available maps and data. When you have an
account, you can also add your own maps and data and join and create groups.

Therefore you will first sign up for an ArcGIS Online account and/or sign in as a
member.

At the top of your map, Click Save.

Step 3: (Optional) Create an ESRI Global Account

If you have an ArcGIS Global Account, move on to the next step.

If you do not have an ESRI Global account you need to create one to access the full
functionality of ArcGIS online.

Click Create a new global account.

In the form that displays, provide a user name and password of your choice and fill out
the remaining required fields (displayed in bold).

When you have filled out the required fields, click "create my ESRI Global Account."

If the user name you chose is already taken, you will be prompted to choose another one.

Your account will be created and activated upon confirmation of your e-mail address.

Step 4: Register for your ArcGIS Online account

Once you have an ESRI Global account, you can register that account in order to become
a member of ArcGIS Online.
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Click the Register my ESRI Global Account link.

Note: If you have not got this link, click the Sign In link at the top right to reach the
correct page.

Enter your ESRI Global account username and password.

Click the Register button.

Click I accept to accept the ArcGIS Online Terms of Use.

You now have the opportunity to edit your ArcGIS Online Profile if you wish. In the
upper bar you will see a Notification link too where you could manage messages from
some of the ArcGIS Online groups mentioned in the first part of the exercise. For now,
we will move on to creating and saving a map.

Step 5: Save and develop your map

Click the Map link at the top of the page.

The map that you were just building for San Diego will be re-opened and the Save
process you had begun can now be finished.

Complete the Save Map dialog with an appropriate title, Search Tag(s), and Summary.
Perhaps as below:

Click Save Map.

Your map has now been saved to "My Content" in your global account.

Exercise 12

Copyright © 2008 ESRI 12-7



Click OK.

Click ArcGIS.com Home > My Content. Your new EdUC Exercise map has been
saved, but notice that it is not currently shared.

From here there are many options you could take. You can organize your Content by
adding folders, moving items, removing items and adding new items. You could also
create a new map or share existing ones. We will come back to adding and sharing items
shortly. For now lets edit your map.

Click on the EdUC Exercise map link.

Here you will see the metadata for your map. You can complete and maintain further
information about your map such as Description, Access and Use Constraints as well as
add comments by clicking Edit. We will now add information to your map from ArcGIS
Online.

Click the Open link below your map thumbnail.

Click the Add Content to Map button. We will search ArcGIS online for some more
interesting data for our map.

Complete the Search window with Search: ArcGIS Online For: California.

Scroll down through the list of services containing data for California. There are a
couple of interest such as "Califonia Fire History" and "California Tsunami Risk".

Click on California Tsunami Risk and click Item Details. Information about the data
resource is provided.

Click Map at the top of the screen to return to your SanDiego map.

Locate the California Tsunami Risk service once again and click Add to Map. Purple
areas have been added to the street map.

Take a moment to observe your new map.
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a.) If you would like to toggle the Tsunami layer on and off, Click Details, Show
Contents of this map button, and click the radio button next to the service.

It is also possible to edit the order and appearance of the layers in your map. Wouldn't
it be nice to set a transparency on the Tsunami layer?

Click the small callout arrow next to the Tsunami Service. Click Transparency.

Adjust the Transparency slider to ~ 40%.

Click Save.

Click ArcGIS.com > My Content.

You will see your map listed there. We will return to this area shortly with some new data
we will post to ArcGIS Online.
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Step 6: Display Bing Maps Data in ArcMap with local data

You can not only use ArcGIS Online content for making web maps, but you can also
display layers from ArcGIS Online in ArcMap or ArcGIS Explorer, together with data
that are stored locally on your computer. There are two ways to access access
functionality - from ArcGIS.com or from ArcMap.

The default option is set to show Web content only. If you are looking for content like
layer packages or ArcGIS Explorer maps, you won't discover these until you change this
to show all content.

Once this is done you can search for items of interest and will find that more results
appear. To learn more about finding ArcGIS Desktop content, please see the arcgis.com
Help topic Finding content > Finding ArcGIS Desktop content.

To open your search results, click on the Open pulldown beneath the thumbnail and
choose the application you wish to use. The options will vary depending on the resource
you are accessing.

Education User Conference 2010

12-10 Copyright © 2008 ESRI



In this step you will combine Bing Maps data with local data layers in ArcMap.

Launch ArcMap.

Dismiss the New Document Window.

Click the pulldown next to Add Data and notice there are 3 options:

First we will add a Basemap.

Click Add Basemap. This will be a familiar list of options from ArcGIS.com.

Click Bing Maps Hybrid, click Add.

In ArcMap click the Add Data button .

Navigate to your C:\EdUC\ArcGISOnline\SanDiego geodatabase and add
MajorAttractions.

Click Close in the Geographic Coordinate System warning.
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Right click the MajorAttractions and choose Zoom to Layer.

The map zooms to the San Diego downtown area. The major attractions display on top
of the Bing image.

Double-click the Major Attractions layer to open the layer properties and click the
Symbology tab.

You will import the symbology for the MajorAttractions layer from a layer file.

Click Import.

Accept the default option to Import the symbology definition from a layer file.

Navigate to your C:\EdUC\ArcGISOnline folder and double-click the
MajorAttractions.lyr file.

Click OK.

Accept the NAME field for the Import Symbology Matching Dialog. Click OK.
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Click OK to close the layer properties.

To take a look at the resolution of the image, zoom in closely to the Seaport Village
and Mariott Hotel area.

Step 7: Geocode hotel addresses using an ArcGIS online
address locator

In ArcMap click the Add Data button .

Navigate to your C:\EdUC\ArcGISOnline\SanDiego geodatabase and add the
HotelAddr table.

At the bottom of the table of contents, click the Source tab.

Right-click the HotelAddr table and click Open.

HotelAddr is a table of San Diego major hotels and their addresses.

Close the Attributes of HotelAddr table.

Right-click the HotelAddr is a table and click Geocode addresses.
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In ArcGIS 10, the ArcGIS Online address locators are automatically available for your
use. If you wished to use a different one, you could click Add and enter the connection or
location information.

Select the North America Geocode Service.

Click OK.

The Geocode Addresses dialog box will appear.

Confirm that HotelAddr is selected for the address table.

Next you will match the Address Input Fields with the corresponding fields in the
HotelAddr table.

For Address click the dropdown arrow and select ADDR and for City select CITYNM.

The State, Zip and Country fields are automatically matched.

For Output shapefile or feature class, click the Browse button and navigate to the
C:\EdUC\ArcGISOnline\ folder.

For Save As Type, choose File- or Personal Geodatabase feature class.

Double-click the San Diego geodatabase.

For Name, enter MajorHotels and click Save.
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Make sure your Geocode Addresses dialog box looks like the graphic below.

Click OK to start the geocoding process.

When the geocoding process is finished click Close.
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In the table of contents, right-click the Geocoding Results: MajorHotels layer, and
choose Zoom to Layer.

Click the point symbol under Geocoding Results: MajorHotels and assign a hotel
symbol of your choice.

Note: You can enter "Hotel" in the Symbol Selector to retrieve the symbols.

Save the map document in your C:\EdUC\ArcGISOnline\ folder.

Note: You may also wish to explore the Geocoding Toolbar under the Customize menu,
point to Toolbars, then Geocoding. Here you can enter an address and interactively
change the locator being used.

Step 8: Create a layer packages and upload them

In this step you will create layer packages for the MajorAttractions and the Geocoding
Results: Major Hotels layers. Layer packages can be shared in a variety of ways - they
can be e-mailed, published onto CDs or DVDs, or placed on network drives - or they can
be shared via ArcGIS Online.

Note: Layer Packages: A Layer package (LPK) is a file format you create in ArcGIS
Desktop for easy sharing in ArcGIS Online. When you save a map layer as a layer
package, you include its source data as part of the layer package. All your ArcGIS
symbology, cartography, and metadata are included together in a single file.

These files allow you to publish your layers in a packaging format for easy uploading and
downloading in ArcGIS Online. You publish these files in ArcGIS Desktop then add
them to ArcGIS Online. When other users want to use these layers in their ArcGIS
applications, ArcGIS Online unpackages them and opens them in the appropriate ArcGIS
application, such as ArcGIS Desktop or ArcGIS Explorer.

In the ArcMap table of contents, right-click the MajorAttractions layer and choose
Create Layer Package.
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Click the Save package to file option and navigate to your
C:\EdUC\ArcGISOnline\folder. Name the file MajorAttractions.lpk

Click Validate.

ArcGIS will check your layer for all the information required for creating and
ultimately publishing to ArcGIS Online. You will see an error window appear at the
bottom of ArcMap indicating that we need to have a description for the layer in order
to save the layer package.

Right click on the High Severity error in the Prepare window.

Choose Change General Layer Properties.

On the General tab, for Description, enter San Diego major attractions and click OK.

Click Validate again. There should no longer be any errors in the Prepare window.

Click Share.

We will add this to ArcGIS Online shortly. First let's share the Major Hotels directly to
ArcGIS Online.
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In the ArcMap table of contents, right-click the MajorHotels layer and choose Create
Layer Package.

This time choose the Upload package to my ArcGIS Online account, and enter
SDMajorHotels for a name.

Click Validate. You may be prompted for a description again. Enter something
appropriate and Validate again.

Click Share.

When prompted, enter your ArcGIS Online credentials from earlier in the exercise and
click Sign In.

Complete the Package Details menu.

Click OK. It will take a minute or so and you will receive a message that your package
has been posted online.

Let's go and verify that the Major Hotels layer package was in fact posted.

Return to ArcGIS Online. Sign in again if necessary.

Click My Content.

You should see your MajorHotels layer package listed, but not shared. Notice that the
size of this compared to your map is significantly different. This is because the layer
package in fact includes the data itself.

We will now add the Major Attractions.

Click Add Item.

Browse to the Layer package you saved earlier in your C:\EdUC\ArcGISOnline\
folder.

Click on the Supported items link to see what can be posted to ArcGIS Online.

Enter a title and some tags (San Diego, Hotels, California).

Click Add Item.
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Step 9: Watch instructor share items.

Instructor adds check mark to items to share. Click Share.

Use the check box for sharing with Everyone (public). Click OK.

Step 10: Access a shared item

In the ArcGIS.com window, type in MajorAttractions, San Diego and click Search
Content.

Click the MajorAttractions Layer Package and open it in ArcGIS.

Repeat the search for Hotels San Diego.

When you are finished, click Sign Out on the ArcGIS.com windows.

Conclusion

ArcGIS.com and ArcGIS Online make it easy to share GIS content on the web. You can
access ArcGIS Online anonymously and create simple web maps. However, to save your
web maps, share your content and inding and using publicly available maps and data you
need an ArcGIS Online membership account. ArcGIS Online also gives you access to
online services such as geocoding and base layers such as Bing Maps imagery.
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13Exercise 13: Use the Python Scripting Environment

Estimated time: 45 minutes

All scripting languages have a standard set of functionality. For example, every scripting
language has the ability to comment code, to execute loops, to concatenate strings, to run
decision making statements, and to execute a set of built-in functions. The main
differences between scripting languages are the syntax and the type of builtin
functionality that is available.

In the first part of this exercise, you will become familiar with the Python scripting
language. You will learn about comments, variables, built-in functions, modules,
concatenation, decision making, and loops.

In the second part of this exercise, you will work with ESRI's Geoprocessing object. This
object gives script language programmers access to the power of GIS. For example the
Geoprocessing object opens up all the tools in ArcToolbox and also gives programmers
an easy way to get to GIS data for edits, query, manipulation, analysis, and more.

Step 1: Create a script

In this step, you will create a new Python script and add some comments to it.

Start PythonWin.

PythonWin is one of the integrated development environments (IDE) that you can use for
writing Python scripts. When you open PythonWin, it opens with the Interactive
Window. The Interactive Window has many purposes: (1) it provides a quick way to
execute and test individual lines of code without saving that code, (2) it outputs error
messages from scripts, (3) and it shows the output from print statements.

Click File > New.

In the New dialog, verify that Python Script is selected.

Click OK.

Currently, you have two windows in your application: the Interactive Window and the
Script1 window. You can write lines of code in either window. However, if you write
lines of code in the Interactive Window, the code is not saved. For this reason, most of
your code will be written in a script window.
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Resize the Script1 and Interactive windows so that you can see both at the same time
and that neither one covers up the other.

Note: You can click on Window > Tile to do this automatically.

Click File > Save As.

In the Save As dialog, navigate to the C:\EDUC\Python folder, and for the file name
type MyFirstPython.py.

Click Save.

The first lines of code in any script should be comments. Comments are lines of
unexecutable code that are used to document a script. Comments throughout your code
that explain individual lines or blocks of related code make your scripts easy for others to
read and understand.

In Python, any line of code preceded by one or many pound signs (#) is a comment.
Python ignores all commented lines and only executes uncommented lines of code.

In the MyFirstPython.py window, type the following.

# Name: <your name>
# Purpose: This is my first script.

Python's commented code is green and italicized.

Step 2: Use variables

Programming languages uses variables. Variables hold on to a value while a program or
script runs. Throughout the execution of a script, the values in a variable can change.
Variables can store many different types of data, including strings, numbers, lists, and
more. In this step, you will use variables to store numbers, strings, and lists.

First, you will create a numeric variable.

In the MyFirstPython.py window, type the following code under the comments.

a = 5
print a

Notice that the word print turns blue and bold. That indicates that you have typed it in
correctly. The p in print must be lower case. If you had typed an upper case P for Print,
the word would not turn blue or bold and if you ran the code you would get an invalid
syntax error message in PythonWin's status bar.
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From the Standard toolbar, click the Run button.

In the Run Script dialog, click OK.

The value stored in a is printed to the Interactive Window. The print statement sends
output to the Interactive Window.

Variables can also store the result of math equation.

In the MyFirstPython.py window, type the following code after the print a statement.

b = 5 + 8
print b

From the Standard toolbar, click the Run button.

In the Run Script dialog, click OK.

The values stored in a and b are printed to the Interactive Window. The value of b holds
the number 11, which is the sum of 5 + 8.

Variables can store string values. String values must be enclosed in single or double
quotes.

In the MyFirstPython.py window, type the following code after the print b
statement.

c = "Python is Fun!"
print c

Run the script.

Python is Fun is the last line printed to the Interactive Window.

In addition to storing one value inside a variable, you can store multiple values inside a
variable. This data type is known as a list. You can extract a single value (or a subset of
values) from a list based on the index position.

In the MyFirstPython.py window, type the following code after the print c statement.

d = ["Jack", "Clint", "Scott"]
print d[1]

Run the script.

Exercise 13

Copyright © 2008 ESRI 13-3



!

The last line of output in the Interactive Window is Clint. d[0] would print Jack, which is
the first value in the list (lists are zero-based). d[2] would print Scott, which is the third
value in the list.

Before moving on to functions, you will comment out the existing lines of code.

Highlight all executable lines of code in your script.

In the MyFirstPython.py script window, right-click, point to Source code and click
Comment out region.

Verify that all lines are commented.

Two pound signs (##) are placed in front of each line of code and the code turns gray.
The script's code is now commented out and unexecutable.

Step 3: Use functions

Python has a number of built-in functions that allow you to perform various operations.
The round function is just one of many built-in functions.

In the MyFirstPython.py window, type the following code at the end of the script.

f = round(3.4)
print f

Run the script.

The value of 3.4 is rounded to 3.0. You can access the list of built-in functions using the
dir(__builtins__) statement.

In the MyFirstPython.py window, type the following code after the print f statement.

print dir(__builtins__)

There are two underscores on either side of the word builtins, not one.

Run the script.

In the Interactive Window, scroll to the bottom so that you can see the large list of
built in functions.

Can you locate the round function in the list?
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There are many built-in functions in Python that can help you while writing any script.

Step 4: Concatenate strings

When writing scripts, there will be times when you want to combine two strings together.
You can do this using the plus sign (+).

In the MyFirstPython.py window, type the following code after the print
dir(__builtins__) statement.

g = "Streets"
h = ".shp"
print g + h

Run the script.

The two string values are concatenated together and Streets.shp is printed to the
Interactive Window.

Sometimes you might concatenate strings and numbers. To do that you will need a
function to convert the number into a string.

Create another variable.

m = 4

Then add another print statement, but use the str function to convert the number 4 into
a text string.

print g + str(m) + h

Run the script.

Streets4.shp prints out in the Interactive Window. If you tried to print g + m + h you
would get an error message in the Interactive Window.

Comment all executable lines of code before continuing to the next step.

Step 5: Make decisions

One of the most powerful aspects of scripting is the ability to use decision making
statements. Python's syntax for decision making statements is if-elif-else.
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In the MyFirstPython.py window comment the previous lines; then, type the following
code at the end of the script.

x = 5
if x < 5:

print "The number is less than 5"
elif x > 5:

print "The number is greater than 5"
else:

print "The number is 5"

Make sure you follow the same indentation as above. And remember
the colons (:) after the if, elif, and else lines.

After the last line of code, print "The number is 5", press Enter twice to unindent the
code.

Run the script.

Currently, the value of x is equal to 5, therefore the else statement gets executed and The
number is 5 is sent to the Interactive Window.

If you have time, change the value of x to a number greater than 5, then a number less
than 5, and rerun the script.

Before continuing on to the next step, comment out the If statement block of code.

Step 6: Run repeatedly

Programming languages have the ability to run a series of statements repeatedly using a
syntax called a loop. Python has three types of loops: while loop, list loop, and counted
loop. In this step, you will work with one of them.

In the MyFirstPython.py window, type the following code at the end of the script.

y = 1
while y < 10:

print y
y = y + 1

Make sure you follow the same indentation as above. Indentation is
part of the Python languages syntax.
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After typing in the y = y + 1 line of code, press Enter twice to unindent the code.

The above four lines of code represent a while loop that will continue to execute as long
as its (y < 10) condition is true. A while loop ends when its condition becomes false.

Below is a description of each line of code:

Line 1: y is initially assigned a value of 1.
Line 2: As long as y is less than 10, enter the loop.
Line 3: print the value of y to the Interactive Window.
Line 4: Add the value of 1 to y and go back to the top of the loop (Line2).

The while loop will continue to execute until y is greater than or equal to 10. Once y
reaches a value of 10, the loop will terminate.

How many numbers do you expect to be printed to the Interactive
Window?

Run the script.

Values 1 to 9 are printed to the Interactive Window. 10 is not included, because the loop
only executes if the value of y is less than 10.

Increase the while value from 10 to 1000 and run the script again.

Before continuing on to the next step, comment out the While statement block of code.

In the following steps you will start to interact with some GIS functionality and
ArcToolbox.

Step 7: Get Help

In this step, you will create a script that buffers features in a line feature class. First, you
will find the buffer tool and its help. The best way to see if a tool exists is to use the
ArcToolbox Index and Search tabs.

Start ArcMap with a new empty map, or open an existing .mxd document

Click the Add Data button.

Navigate to the c:\EDUC\Python\SanDiego.gdb geodatabase and add all its feature
classes to the map. There should be two of them.

Click the Search tab located on the right side of the ArcMap window.
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In the Search for area, type Buffer.

Click the Search button.

The search area lists the Buffer (Analysis) and Multiple Ring Buffer (Analysis) tools.

In the search area, click on the Buffer tool to open the tools dialog.

In the Buffer window, if necessary click the Show Help button, and click Tool Help.

The ArcGIS Desktop Help window opens at the Buffer tool help page.

Scroll down to the Scripting syntax.

Examine the seven parameters and their descriptions. The first three, input feature
class, output feature class, and buffer distance are the most important for this exercise.

Scroll down to the bottom of the help window to the Code Sample to see the Script
Example.

import arcpy
arcpy.env.workspace = "c:/data"
# Buffer roads.shp based on each road feature's value in the Distance field,
#  and dissolve buffers into groups according to values from Road_Type field.
arcpy.buffer_analysis("roads", "buffered_roads", "Distance", "FULL", "ROUND", "LIST", "Road_Type")

Technically this script could be copied and pasted into a Python script window. However
in order for it to work, you would need either the supporting data mentioned inside the
sample or you would need to change the sample's lines of code to replace the sample's
data with your data.

Now that you know the syntax for the Buffer tool and you have seen some sample code,
you wil create a new buffer script in the next step.

Leave ArcMap and the Help window open.

While you are writing code in the next step you might copy and paste some of the sample
code. After your script runs you will verify that the Buffer tool did indeed create a new
feature class. Then you will add the new feature class to ArcMap.

Return to PythonWin.
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Step 8: Write a buffer script

In this step, you will write a Python script to buffer a feature class from a personal
geodatabase. You will create a new script, import the COM module, create the
Geoprocessor, and set the workspace to C:\EDUC\Python.

In PythonWin, click the File Menu and click New.

In the New dialog, make sure Python Script is selected, and click OK.

Click the File menu and click Save As.

Save the script to C:\EDUC\Python\Buffer.py.

Insert comments for the author name and purpose of the script.

# Name:
# Purpose:

Next you will write the two lines of code to let Python know that you are going to use an
object from the ESRI Geoprocessing library. You will import the arcpy.

Python scripts that you write for ArcGIS desktop will most likely always contain these
two lines of code.

Import the arcpy module by typing in the following line of code.

import arcpy

Note: Instead of typing this and the next line of code you can copy and paste from the
help sample.

Add the following lines of code to set the current Workspace to the SanDiego personal
geodatabase.

arcpy.env.overwriteOutput = 1
arcpy.env.workspace = r"c:\EDUC\Python\SanDiego.gdb"

Note: In Python, the "r" is necessary before a string where you are using a single
backslash, such as a directory path.

Add the following two lines of code to buffer the roads feature class by 2000 feet to
create the RoadBuff feature class.

arcpy.Buffer_analysis("Freeways", "FreewayBuf", 2000)
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Add one more line of code to indicate that the script has finished running.

print "The Freeway buffer has been created."

You are now ready to test this script.

Click the Run button.

Click OK, to run the script.

When the print statement prints in the Interactive Window the script has finished.

Next you will verify that your script has create a buffer zone around the major freeways
of San Diego.

In ArcMap, click the Add Data button.

Navigate to the c:\EDUC\Python\SanDiego.gdb personal geodatabase. Notice that
there is a new feature class in there called FreewayBuf. Add the FreewayBuf feature
class to the map.

Notice the buffer zones around each freeway.

In the next steps you will turn this script into an ArcToolbox tool.

Step 9: Turn a script into a tool

In this step you will turn your Buffer script into an ArcToolbox tool.

In PythonWin and in the Buffer.py script locate the following line of code.

arcpy.env.workspace = r"c:\EDUC\Python\SanDiego.gdb"

After this line of code, add the following two lines to create variables that will store
user input values. When a user runs your tool, they will enter these values inside your
tool's dialog box. The two variables will hold the values for use later on in the script.

output = arcpy.gp.GetParameterAsText(0)
distance = arcpy.gp.GetParameterAsText(1)

Now locate the Buffer line of code.

You are going to change its second and third parameters.
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Replace the current values for output feature class and buffer distance with the two
variables you added above. When finished the line of code should look like the one
below.

arcpy.Buffer_analysis("freeways", output, distance)

Next you will change the print statement.

When someone runs your Freeway Buffer tool they will be in either ArcMap or
ArcCatalog. Your current print message is meaningless in those two application, because
it is designed to print messages in PythonWin's Interactive Window. You will alter the
message line of code so that it can print in ArcMap or ArcCatalog inside your tool's
Progress dialog box.

Replace print with: arcpy.gp.addwarning

Replace the print text with the longer string, shown below, that concatenates the
original text message with the name of the output feature class. The final line of code
should look like the one below.

arcpy.gp.addwarning ("The Freeway buffer " + output + " has been created." )

Click the File menu and click Save As... with the name 'Buffer_Params' to save this
script.

import arcpy
arcpy.gp.overwriteoutput = 1
arcpy.env.workspace = r"c:\EDUC\python\sandiego.mdb"
output = arcpy.gp.GetParameterAsText(0)
distance = arcpy.gp.GetParameterAsText(1)
arcpy.Buffer_analysis("freeways", output, distance)
arcpy.gp.addwarning ("The Freeway Buffer " + output + " has been created." )

Now go to ArcMap and make sure ArcToolbox is open.

In a blank area of ArcToolbox (not on any existing toolbox) right-click and click New
Toolbox.

Rename the new toolbox to MySanDiegoTools.

Right-click the My San Diego Tools toolbox, and click Add > Script.

In the Add Script dialog, for Name, type FreewayBuffer.

Note: Be sure not to leave a space in the name.
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For Label, type Create Freeway Buffer Zones.

For Description, type Creates buffer zones around San Diego Freeways.

Click Next.

For Script File, browse to and add the C:\EDUC\Python\Buffer_Params.py script.

Click Next.

Next, you will specify the two script parameters, output and distance, and then set their
properties.

In the Add Script dialog box, click the first box under Display Name, in the Display
Name column. This opens that box up for data entry.

For Display Name, type Output feature class name.

Change the Data Type to String.

Click the box below Output feature class name and type Buffer distance.

Change the Data Type to Long.

Click Finish to close the Add Script dialog.

Next you will run the tool.

In ArcToolbox go to the My San Diego Tools toolbox and double-click the Create
Freeway Buffer Zone tool.

When the tool's dialog box opens, click Show Help.

Notice the help information matches the text that you entered earlier when creating the
tool.

For the Output feature class name, type Buffer1000.

For the Buffer distance, type 1000.

Click OK to run the tool.
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While the tool is running pay close attention to the messages in the Progress dialog. The
green message is yours, from when you used AddWarning. Warning messages are green,
an AddMessage would be black, and an AddError would be red.

Click Close on the Progress dialog.

Click the Add Data button and add the newly created buffer zones, Buffer1000, to
ArcMap.

Conclusion

In this exercise you learned the basics of Python, how to write a script to run ArcGIS
Desktop tools like Buffer, and then how to turn a script into custom tool for ArcToolbox.
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In this exercise you are going to examine wild fires and a search and rescue operation in
Yosemite National Park. To begin, you will familiarize yourself with the new ArcMap
interface, organize and symbolize your data, and enable time on your data to visualize
wild fires from the past 25 years in Yosemite NP. Next, you will use geoprocessing tools
to create a search and rescue grid and suitability raster outlining the most likely path of a
lost rock climber. You will take advantage of the new basemap layer to increase your
map performance and finally you will prepare your map for export and distribution. You
will use some of the new features in ArcGIS 10 to accomplish these tasks, specifically:

▪ Explore the new user interface, taking advantage of dockable and retractable
windows and updated tables

▪ Use the new search capabilities to locate symbols and tools
▪ Enable time on data using the new time feature
▪ Explore the new geoprocessing capabilities
▪ Create a basemap to optimize map performance
▪ Generate Data Driven pages and create an output PDF

The data is courtesy of the National Park Service, United States Geological Survey, and
ArcGIS Online. The values, shapes, measurements, and attributes in this exercise are for
demonstration purposes only and do not reflect reality.

Step 1: Getting Started

In this step you will start ArcMap, browse to a map, set the default geodatabase, and add
data to your map.

Start the ArcMap application by either clicking the desktop shortcut or by navigating
to Start > All Programs > ArcGIS

In the Getting Started window, select Browse for More... and navigate to the
C:\EdUC\WNEW\YosemiteNPS.mxd

Double-click map document to open.

This exercise will use Maplex labels and the Spatial Analyst extension.
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On the main menu go to Customize > Extensions. Verify the Spatial Analyst and
Maplex extensions are checked on.

Let's start by exploring data in the map. You can do this through the new embedded
Catalog window in ArcMap.

The Catalog window can be opened from the Main Menu > Windows and select
Catalog.

Note: This can also be done by clicking on the catalog button.

The Catalog window provides tools for organizing and managing your map documents,
layers, geodatabases, geoprocessing models and tools, file-based data, and so on. The
Catalog window is used to add data to your map and organize results. Notice the window
opens in the center of the screen.
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Note: If your Catalog window is already docked you can undock it by pinning it open
and placing your mouse over the word "Catalog" on the top of the window and dragging
it into the center of the map.

Dock the Catalog window on the right side of the map. This can be done by dragging
the window and selecting the right arrow. See below graphic.

In ArcGIS, you can interactively dock and retract windows against the sides of the
application window and slide them open as you need them. Retracting the Catalog
window enables you to have more of your application window devoted to your map
display.
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Click the menu pin in the upper right corner to make your menu retract or to pin it
open.

When the Catalog window is retracted into the side of the application window, you'll see
a Catalog menu tab on the side of the application. Mousing over the tab will open the
Catalog window.

Click the pushpin to hold the Catalog window open.

Next, you will set your default geodatabase. Each map document has a default
geodatabase, which is the home location for the spatial content of your map. This location
is used for adding datasets and for saving resulting datasets created by various editing and
geoprocessing operations. For example, when you export features from a layer, the data
will be saved in the map's default geodatabase unless specified otherwise. The default
geodatabase is synchronized with Current Workspace of Geoprocessing Environments;
therefore, all output from tools or models will be saved to this default location. The
current default geodatabase for this map documents is Yosemite, we want to change it to
Results.gdb for organizational purposes.

In the Catalog window, right-click on the Results.gdb and select 'Make Default
Geodatabase
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You have just changed your default geodatabase to Results.gdb.

In the Catalog window, expand the Yosemite.gdb. In the expanded geodatabase select
the campgrounds point feature class and drag it into the center of the map.

Follow the same steps to add Ranger_Stations to the map.

Hide the Catalog window by clicking the pushpin. Notice the map does not redraw.

You have just explored the new Catalog window, changed your default geodatabase, and
added data to the map through the catalog window.

Step 2: Explore and Symbolize Data

In this step, you will explore attribute data through the new table window and symbolize
data using the new search in the symbol selector.

Open the attribute table of the Campground feature class.

Note: The attribute table can be opened by right clicking on the campground layer and
select Open Attribute Table.
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If the table is not docked, dock the table to the bottom of the map so it appears as the
following graphic.

Open the attribute table for the Ranger Stations.

The attribute table will place the two tables on top of each other, with a tab on the bottom
so you can toggle between the tables.

Open the Table Options > Select 'Arrange Tables' > New Vertical Tab Group.

The attribute tables will now appear next to each other.

Note: You can change the divider between the two tables by mousing over the middle of
the two tables, your mouse icon will change to a divider and you will be able to toggle
the width of the tables.

In the campgrounds table, select the 3 Proposed Campgrounds. Scroll to the bottom of
the Type field to find them. You can select multiple records by holding the Shift key
and selecting the 3 records.
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If you cannot see them highlighted on the map, click Bookmark on the main menu and
click Central Valley.

Next, you will select the entrance the campers would likely take to access the proposed
campsites.

In the Ranger Stations attribute table, select the Arch Rock Entrance. On the map there
should be 4 points selected.

Close the attribute table window.
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In the Table of Contents, click the List by Selection button.

In the Table of Contents the layers are sorted by what is selected and how many records
are selected, layers that are selectable and finally layers that cannot be selected.

Clear the selection from the Campgrounds and ranger by hitting the clear selected
button on each layer.

There should be no features selected now.

Change the display to List by Drawing Order , as it was previously.

Turn off the Ranger Stations.

The campground point symbol does not adequately represent the campgrounds. Next, you
will symbolize the campgrounds using the search feature to find a more appropriate
symbol.

Open the properties of the Campgrounds by right clicking the layer and selecting
properties.

Select the Symbology tab, on the show dialog select Unique Values under Categories.
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Change the Value Field to Type and select Add All Values. Uncheck the first option
<all other values>

Double-click on the symbol symbolizing the Existing campground.

The Symbol Selector Dialog will open.

In the search window type in campground, click enter.
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Select the campground symbol under the Civic group.

Click OK

Open the symbol selector window for the proposed sites. You can do this by double-
clicking on the point icon for proposed sites.

Find the same campground symbol and select it (Single-click only).

Note: In the search drop-down you can find previous searches, and select them again.

Click Edit Symbol...

Note: If you have accidentally close the Symbol Selector window, you can reopen by
double-clicking the proposed site symbol, find the campground symbol and select Edit
Symbol.
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Change the Symbol color to Seville Orange (If you mouse over the colors, it will tell
you their name).

Click Ok in the Symbol Property Editor and OK on the Symbol Selector window.

Select OK on the Layer properties

In this step you added data to the map using the new catalog window, examined the
attributes of two layers, and symbolized the campgrounds using the new search feature.

Step 3: Enable Time On Your Data

Every year Yosemite National Park has wildfires within the park. The data in your map
represents the starting points and area burned of the fires in the past 25 years. In this step
you will enable time on your temporal fire data.

Zoom to the Yosemite Park Boundary Bookmark.
Turn on and expand the Fire History group layer. Verify the Fire History 1985-2008 is
the only layer on right now.
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Open the attribute table of the Fire History 1985-2008 layer and scroll to the far right
of the table to find the Start_Yr and End_Yr fields.

These are the fields that contain the time data that will be used to display the fire data.

Right-Click on the Start_Yr field and select Properties.

Notice it is a Date field type. To enable time the field type must be date or string.

click OK to close the properties dialog.

Close the attribute table

Open the properties of the Fire History 1985-2008 layer, click on the Time tab.

Check Enable time on this layer.

Within the Time properties set each property to:
▪ Layer Time to Each feature has a start and end time field.
▪ Set the Start Time Field to Start_Yr and the End Time field to End_Yr.
▪ Set the Time Step Interval to 1 Years.
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Verify the Time Properties matches the following graphic.

Click OK.

Click Open Time Slider Window button on the Tools Toolbar.

The map is now just displaying the fires from 1985. You can tell this because the date the
slider is showing. Next, we will set the time properties of the time slider window.

If you see all the fires, the time slider window may not be activated.
Click on time button within the Time Slider window. See Graphic.
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Click on the properties button on the time slider window, it's the middle button on the
window.

Select the Time Display Tab. Leave the Time zone set to your computer time zone,
verify the time step interval is set to 1.0 Years. Change the Display format to (yyyy).

Click OK

On the Time Slider window click the Play button and watch as the fire data changes
for each year.

You can enable time on multiple layers, as long as they contain attribute data in a date or
string field. Next, you will enable time on the Fire Ignition Points layer.

Turn on the Fire Ignition Points layer
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Open the properties and go to the Time tab. Set the properties to match the following
graphic.

Click OK

On the time slider window move the slide back to 1985.
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Open the properties of the Time Slider window, and select Playback tab. Verify
Display data for each timestamp is set. Move the Speed slider to the middle between
slower and faster.

Click OK.

Click the Play button to watch the layers move through time.

Now the Fire History and Fire Ignition Points move through time together. In this step,
you enabled time on two layers and were able to show the wildfires in Yosemite NPS for
that past 25 years.

Turn off the Fire History Layer.

Close Time Slider.

Step 4: Use New Geoprocessing Features

Within Yosemite, the park service uses GIS for their search and rescue teams. In this
example, a rock climber went missing and the park has gathered a last point seen. Using
the data provided by the park, you will use a model will to predict the most likely path of
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travel taken by a missing rock climber. First, you will enable background Geoprocessing,
so while the model runs you can continue to use the map.

Collapse Yosemite NPS data frame.

Activate and Expand the SAR data frame.

Note: This can be done by right-clicking the SAR data frame and selecting Activate.

Zoom to the Half Dome Hiking bookmark

From the Geoprocessing menu select Geoprocessing Options...

In the Geoprocessing Options verify the following are checked:
▪ Overwrite the outputs of the geoprocessing operations
▪ Log geoprocessing operations to a log file
▪ Enable Background geoprocessing are all checked
▪ When connecting elements, display valid parameters when more than one is

available
▪ Add result of geoprocessing operations to the display

Exercise 14

Copyright © 2008 ESRI 14-17



The geoprocessing options should look like the following graphic.

Click OK

Unhide the Catalog Window and navigate to
C:\EdUC\WNEW\Tools\Model_Exports\ProjectTools.tbx

Right click on the Search and Rescue model and select Properties. On the general tab
uncheck Always run in foreground.

Click OK.

Right-click on the model and select Edit.
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The model is using Spatial Analyst tools to predict were a lost person may have traveled
based on topography, trails, roads, and rivers. The output of this model will be a
suitability raster, a grid breaking up search areas into square miles, and a 2 mile buffer.

Close the model and do not save.

From the Catalog Window, double-click the Search and Rescue Model. It will open the
tool in the map. All output locations will be going to the default geodatabase we set
earlier. Your model should match the following graphic.

Click OK to run

Once the model runs, you will see the task bar in the bottom of map showing the
progress. However, with background geoprocessing enabled you can still use the map.

From the main menu bar, select Bookmarks and go to Valley-wide.

On the Table of Contents, click the List by Visibility button . This will list your
layers by how they are visible on the map.

Exercise 14

Copyright © 2008 ESRI 14-19



Click on the on the Rock Climbing symbol . Notice in the map all the rock climbing
location flash.

Change the Table of Contents display back to List by Drawing Order .

By now the model should be done running. You may have noticed layers entering your
map. There will also be a notification that appears on the lower left corner, showing the
model completed. Let's view the results.

Zoom to the Half Dome Hiking bookmark.

From the Main Menu select Geoprocessing > Results. This opens up the results
window. This will show the completed model process.

Expand Current Session

Expand Search and Rescue Model

Close the Results Window.

Whenever you execute a tool using its dialog box or in the Python window, information
about the execution is written as a result in the Results window. The results window can
allow you to do many useful things including showing you the status of a tool executing
in the background, allowing you to review the results of a tool or reexcute a process that
already created a result.

The model has created a 2 mile buffer and a half mile grid series for a Search and Rescue
operation. In addition, using Spatial Analyst tools the suitability raster was created. Next,
you will label and symbolize the output data.

Education User Conference 2010

14-20 Copyright © 2008 ESRI



Open the properties for the SAR_Grid layer. Go to the Labels tab and check Label
features in this layer.

Select the symbology tab, click the large symbol button, opening up the Symbol
Selector dialog box. Change the symbol to Hollow.

Click OK, and Click OK to close the properties.

Turn off the PLS Buffer layer.
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Single-click on the color ramp of the suitability raster. Right-click on the color ramp
and uncheck graphic view. Change the color ramp to Red to Green Diverging, Bright.
Check Invert.

Click OK

The map is now showing a ½ mile grid system extending two miles from the point last
seen, labeled for easy identification. Also using advanced analysis you have created a
raster showing the path most likely traveled based on topography. You were able to
enable background geoprocessing, which will allow you use the map when running time
intensive tools.

Step 5: Create a Basemap Layer

In this step we will finalize the map for display. We want to show park authorities the
search and rescue grid just created. The final goal is to set your map up so it can be used
to visualize search areas. To optimize display, you will create a basemap layer.

Right-click on the SAR Data Frame and select New Basemap Layer

A new layer is added to the bottom of you the Table of contents. Next, we will move the
layers we want in the basemap layer.
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Select Climbing Pts to Federal Lands. You can do this by selecting climbing points,
holding the SHIFT key and selecting Federal Lands. Drag all the selected Layers to the
New Basemap Layer.

You have just added layers to your basemap layer. You will notice a yellow triangle
containing an exclamation point on the basemap layer. This is a warning. Next, you will
analyze the basemap layer to get more information on the warning.

Right-click on the basemap layer in the table of contents, and select Analyze Basemap
Layer from the context menu.

This will initiate a performance analysis of the layers in your basemap layer and generate
a diagnostic report of potential drawing performance issues. The error report identifies
any potential drawing performance issues and provides recommendations on what you
can do to address the issue.
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Review the error log and notice that the warning is referring to pyramids not being
build on the suitability raster.

You will correct the 1 Warning returned by building pyramids. To speed up find the tool
you will take advantage of the new search capabilities within ArcMap.

Close the Analyze Window.

Unhide the Search Window.

Click the Tools filter above the search text box. In the Search window type pyramids
and click enter.

A list of tools related to pyramids is returned. From here you can add more descriptions
to narrow your search. However, this search returned the tool you need.

Locate the Build Pyramids (Data Management) and double-click on the name to open
the tool.
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In the tool navigate to the suitability raster in the C:\EdUC\WNEW\Results.gdb.

Click OK to run.

Now that you have built pyramids the warning message is gone.

From here you can pan around the map with little to no redraw.

Hide the Search Window and table of contents to open up space on your map.

Note: Hide windows by clicking the pushpin on the windows.

Place your cursor anywhere in the data frame.
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Then, press and hold down the middle mouse button. Initially, your cursor will appear
as the active pan icon - a closed hand. After a few seconds, your cursor will change to
the continuous pan cursor.

Continue to hold down the middle button, and navigate the map by dragging the cursor
in the direction that you want to pan your map. In response, the map will continuously
pan in the same direction. As you pan, the cursor will change into an arrow pointing in
the panning direction.

Press the CTRL key to speed up map panning and the SHIFT key to slow panning
down.

Note: An alternative for continuous map panning is to simultaneously hold down the Q
key while navigating the mouse relative to the center of the map display - i.e., if you
move your mouse to the lower right of center, the map will pan in that direction.
Releasing the Q key will stop map panning. You can control the panning speed based on
how close you are to the center of the display. Move close to center to slow panning
down and further away to speed it up. Using the Q key also enables you to use the mouse
scroll wheel to zoom in and out while panning.

In this step you created a basemap, which will prevent redraw when panning the map.
Basemap layers are non-operational and cannot be edited while in the basemap layer. To
edit a layer you simply drag it out of the basemap layer, edit and drag back into basemap
layer when finished.
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Step 6: Create Data Driven Pages

In this step, you will create data driven pages. Data Driven Pages allow you to quickly
and easily create a series of layout pages from a single map document. The SAR_Grid
already divides the map into 1 mile search areas. Next you generate a map series where
one page is one index feature and export it to a PDF. This could then be printed and
distributed quickly.

From the main menu, select the Half Dome Hiking bookmark from the Bookmarks
menu.

From the Customize drop down on the Main Menu, Select Toolbars > Data Driven
Pages.

From the Data Driven Pages toolbar select the Data Driven Page Setup. This is the first
button on the toolbar.

This opens up the Setup dialog for data driven pages. From here we can select the layer to
be used to create the data driven pages. In this case we are going to use the SAR_Grid
created in the model.

Check the Enable Data Driven Pages.
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Select SAR for the Data Frame, SAR_Grid for the layer, PageName for Name Field,
and PageNumber for Sort Field. Verify Sort Ascending is checked. It should be set up
the same as the graphic below.

Click OK

The data frame zooms to the first page. Using the controls on the data driven pages
toolbar you can go through the each page.

Select the next button and notice how the extent changes to each page.

Next, you will arrange the Yosemite NPS data frame so it can be used as a reference map,
and finally exported to a PDF

Unhide the Table of Contents by clicking on the Table of Contents Tab.

From the Bookmarks menu, zoom to Half Dome Hiking.
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Activate and expand the Yosemite NPS data frame.

Note: You can do this by right-clicking on the Yosemite NPS data frame and select
Activate.

From the bookmarks menu zoom to the Layout bookmark.

Turn on the Layout layer.

Right click on the Yosemite NPS data frame and go to Properties.
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Select the Extent Indicators tab. Select SAR to be the extent Indicator. It should look
like the below graphic.

Click Ok.

Next we will export the pages to a PDF to be distributed. To export to a PDF we need to
be in layout view.
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Change to layout view. This can be done from the Main Menu View Menu > Layout
View. Your map should like similar to the below map.

From the File menu on the main toolbar, select Export Map…

Navigate to C:\EdUC\WNEW

Name the file YosemiteSAR

Select PDF as the file type.
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Expand the options and select the Pages tab. Select All.

Click Save

You will see a dialog exporting each page. Saving may take few extra seconds due to the
size. Once it has been completed, navigate to the save location and open the PDF.

Close ArcMap and do not save changes.

Through Windows Explorer navigate to C:\EdUC\WNEW and open the PDF.

You will see you could distribute this map by each grid to park authorities to show the
most likely traveled location for 1 mile by 1 mile block.

In this step, you created data driven pages, set the extent indicator, and exported each
page to a PDF. This make it easy to print and distribute maps.

Conclusion

ArcGIS Desktop 10 has had many enhancements and new features. In this exercise you
have skimmed the surface. You explored the new look and feel of ArcMap 10. There new
dockable windows, included the Catalog window which is now embedded in ArcMap.
You used the search function within the symbol selector and explored the search window.
A new feature in ArcGIS 10 is to enable time on your data. Using this function you were
able to quickly analyze the fire patterns in Yosemite National park over the last 25 years.
The new background geoprocessing option can save you time while running time
intensive tools or models. You were able to run a complex model and continue to pan
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around the map and organize your data. To stop redraw when panning a map, you learned
how to create a basemap layer and add data into it. Also, to optimize your performance of
your basemap you analyzed it and corrected the warning. Finally, you created a map
series by using the new data driven pages. This allowed you generate specific output
pages for printing. Your end result was a PDF document for each search area. Thank you
for participating in the What's New in 10 Desktop lesson and exercise.
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15Exercise 15: Spatial Pattern Analysis

Estimated time: 25 minutes

Analyzing the Spatial Patterns of Dengue Fever

In this tutorial we are going to use some of the spatial statistics tools to better understand
the pattern of Dengue Fever for Pennathur, a village in Southern India. This village is one
of 44 villages that are part of a Dengue Fever study. Dengue Fever is a painful,
potentially fatal illness that is spread by a tiny mosquito, and unfortunately it is quite
common in Southeast Asia and Central America. It is estimated that as many as 100
million people contract this disease each year…and the CDC is still years away from
finding a vaccine. So the project you are looking at is an attempt to better understand the
disease in order to identify strategies that might reduce the disease until a vaccine can be
found.

Step 1: Analysis

The steps in this tutorial document assume the tutorial data is stored at C:\SpatialStats. If
a different location is used, substitute "C:\SpatialStats" with the alternate location when
entering data and environment paths.

Open ...\PatternAnalysis\DengueFever.mxd
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Make sure that Background Geoprocessing is NOT enabled
(Geoprocessing>Geoprocessing Options)

We are going to begin by looking at the spatial pattern of Dengue in this village. The
white squares are homes, and the bright red dots are individual dengue fever cases over a
35 day time period.
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For our first analysis, we'll use the Average Nearest Neighbor tool to see if the cases of
dengue fever cluster in the village.

Open the Average Nearest Neighbor tool, in the Spatial Statistics Toolbox in the
Analyzing Patterns toolset.

Notice that the tool asks for an optional AREA value. The average nearest neighbor tool
calculates the distance between each feature and its nearest neighbor, then computes the
average for all nearest neighbor distances. It then compares the computed average
distance to a theoretical one that would be obtained if the points were randomly
distributed inside a circle with the same AREA value. We'll use the area for the village
boundary polygon. To find out what that AREA is, we can run the Calculate Area tool:

Run the Calculate Area tool, in the Spatial Statistics Toolbox, in the Utilities Toolset
▪ Input Feature Class: Village Boundary
▪ Output Feature Class: accept the default or choose an output location
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Open the attribute table for the feature class created and copy the F_Area value into
Area parameter for the Average Nearest Neighbor tool

Turn off the output from the Calculate Area tool (uncheck the layer or remove the
layer from the TOC)

Run Average Nearest Neighbor tool with the following options:
▪ Input Feature Class: IndCases
▪ DistanceMethod: EUCLIDEAN_DISTANCE
▪ Generate Report checked ON
▪ Area: 101163.071656
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Open the results window and double click the HTML report.

Notice that the report from the Average Nearest Neighbor tool shows us that the Dengue
cases are, in fact clustered.

We'll talk more about the numeric output from the Average Nearest Neighbor tool in a
minute. What I'd like you to notice right now, however, is that the dengue cases are
reported by household. The Average Nearest Neighbor tool indicated that cases were
clustered, but if the households are clustered, and if we are collecting data by household,
do you think that could impact our results? Absolutely!

To make sure that the clustering is valid, let's run the average nearest neighbor tool on the
households and compare the result to the clustering for individual cases.

Open the Ave Nearest Neighbor tool
▪ Input Feature Class: Households
▪ DistanceMethod: EUCLIDEAN_DISTANCE
▪ Generate Report checked ON
▪ Area: Same as before (This should still be on your clipboard to paste again, but if

not the value is: 101163.071656)

Open the results window and double click the HTML report
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Compare the HTML report for Households with the HTML report for the Individual
Cases

Notice that the report for both Households and Individual Cases indicates statistically
significant clustering. The Z scores, however, are quite different. For cases the Z score is
-26.9 and for households it is only -5.1. Z scores are standard deviations and can be
plotted on a normal curve. The smaller the number (-26 is smaller than -5) the farther
down on the tail of the normal curve the Z score falls; the area under the curve gets very
small in the tails and this area represents the probability that the spatial pattern of your
points is randomly distributed. A Z Score of 0 would fall right in the middle of the curve,
in the location with the largest area under the curve and so the probability that the spatial
pattern is random would be large. With very small Z scores there is a very small
probability (less than 1% likelihood) that the spatial pattern is random. For this tool,
when the Z score is in the left tail, the spatial pattern is more clustered than we would
find with a random pattern. If the Z score is positive, in the right tail, the spatial pattern is
more dispersed than we would find in a random pattern.

It is very important to note that the Z score calculation is strongly influenced by the size
of the study area. So the best way to use this tool is to compare different distributions
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within a fixed study area. In our case, we are comparing the spatial pattern of homes to
the spatial pattern of Dengue fever cases and we find that the clustering is much more
intense for the Dengue fever cases than it is for the homes. We can conclude, then, that
the spatial pattern of dengue fever cases is clustered, and that the observed clustering is
more pronounced than we would expect, given the underlying clustering of the homes.

Close the HTML reports

While having a number that quantifies the clustered spatial pattern for a set of feature is
useful, especially when we compare that number to a different set of features in the study
area, often we are most interested in WHERE the clustering occurs.

To evaluate where spatial clusters, or hot spots, of dengue occur, we can use a different
tool - the hot spot analysis tool. Unlike the Average Nearest Neighbor tool which works
on incidents, the hot spot analysis tool evaluates the attributes of points. So we can't just
use the individual cases, but instead we need to look at the number of cases within each
home.

Right click on Households, and open the attribute table to see the variables that have
been calculated

Each household includes information about the number of cases, the number of people,
and a rate indicating the proportion of people who got Dengue in a particular household.
So if there are 4 people living in a home, and 2 of them contracted Dengue, the rate
would be 50% or 0.5. By the way, for this village as a whole, almost 30% of the
population contracted Dengue fever in the 35 day time period (30%!!).

Now, if a disease is random, if getting dengue is purely a function of bad luck, we would
expect the number of dengue cases to be a function of the number of people. In other
words, we would expect the rates for each household to be around 30%…maybe a little
higher for this home, and a little lower for its neighbor…but overall, the rate for all
homes would be around 30%. If however, the disease is not random, if it hits harder in
particular areas of the village, we can use this information to try to figure out what the
causes might be. Does it strike more often in homes with small children or the elderly?
Are there environmental factors like standing water, or different materials used for
housing? The first step in trying to figure out these risk factors is to see if the spatial
pattern of the disease is random or not.

Close the Households attribute table
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Open the Hot Spot Analysis tool in the Spatial Statistics toolbox, in the Mapping
Clusters toolset
▪ Input Feature Class: Households
▪ Input Field: HHRate
▪ Output Feature Class: accept the default or choose a new location

The next few parameters for the Hot Spot Analysis tool are related to the way that we
represent our scale of analysis. The hot spot analysis tool assesses each feature, each
household in this case, within the context of its neighbors. The first parameter is the
conceptualization of spatial relationships, and we are going to choose the Fixed Distance
Band because it ensures that we have the same scale of analysis across the entire study
area.

▪ Conceptualization of Spatial Relationships: FIXED_DISTANCE_BAND

The next parameter we want to set is the distance band, or the actual scale that we are
going to use for the analysis. This is how we identify which households are considered
neighbors in our analysis.

There are a number of strategies for picking a good distance band. We said the disease is
spread by mosquitoes, so if we have information about the distance this mosquito can
travel, this would be a good value to use for the distance parameter. Another strategy is to
let the data help us understand the spatial scale of the processes we are analyzing. The
Spatial Autocorrelation tool will measure the degree of clustering for different distances.
If we run that tool for a series of distances, and write down the Z score for each one, we
can find the distance where the Z score peaks. The largest Z score indicates the scale
where clustering is most intense, or in other words, the scale where the processes
promoting clustering are most pronounced (in this case the spatial processes include the
activity of mosquitoes and the mobility of infected people in the village).

Minimize the Hot Spot Analysis tool

The hot spot analysis tool works by assessing each feature, each household, within the
context of neighbors, so we want to start looking for the peak using a distance that will
ensure each feature has at least one neighbor. We can use the Calculate Distance Band
from Neighbor tool to find this distance.

Open the Calculate Distance Band from Neighbor tool, in the Spatial Statistics
toolbox, in the Utilities toolset
▪ Input Features: Households
▪ Neighbors: 1
▪ Distance Method: EUCLIDEAN_DISTANCE
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Run the tool

The maximum distance will ensure 1 neighbor for every feature and we see that's 52.7, so
we'll round up and start with a distance of 55.

In the results window, point to the last run of Average Nearest Neighbor, and look at
the Observed Nearest Neighbor Distance (NNObserved).

Notice that the Average Nearest Neighbor for households in the village is about 10
meters (9.868), so each time we run the tool, we will increase the distance by 10 meters.

Open the Spatial Autocorrelation tool, in the Spatial Statistics toolbox in the Analyzing
Patterns toolset
▪ Input Feature Class: Households
▪ Input Field: HHRate
▪ Conceptualization of Spatial Relationships: FIXED_DISTANCE_BAND
▪ Distance Band: 55 (remember, we used the Calculate Distance Band from

Neighbor Tool to figure this starting distance out)

Run the tool
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Note the Z score of 1.7

Repeat: Open the Spatial Autocorrelation tool, in the Spatial Statistics toolbox in the
Analyzing Patterns toolset
▪ Input Feature Class: Households
▪ Input Field: HHRate
▪ Conceptualization of Spatial Relationships: FIXED_DISTANCE_BAND

Distance Band: Now use a distance band of 65 (Remember, we decided to use
increments of 10 because it is the observed Average Nearest Neighbor Distance)

Run the tool, then note the Z score of 2.5

We would continue doing this, increasing the distance by 10 meters, until we found a
peak in the Z score value. A graph has already been created that plots the z-scores at
every distance up to 95 meters.
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Open the graph called Graph of z-scores (View>Graphs>Graph of z-scores)

This graph shows where I've plotted the Z score associated with each distance up to 95
meters, and we can see that there is a very distinct peak at 75 meters, so we'll use this
distance for our hot spot analysis.
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Close the graph and open the hot spot analysis tool from before (should be minimized)
▪ Input Feature Class: Households
▪ Input Field: HHRate
▪ Output Feature Class: accept the default or choose a new location
▪ Conceptualization of Spatial Relationships: FIXED_DISTANCE_BAND
▪ Distance Band: 75 meters

Run the tool

Notice that we DO see hot spots (red) and cold spots (blue).
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What does this tell us? Well, the first thing it tells us is that getting dengue is not just
about bad luck! And where we find the hot and cold spots is a first clue in trying to
determine the risk factors. The next step would be analysis to try to figure out the factors
that are contributing to higher rates of dengue in these hot spot areas.

Conclusion

Whenever one of these 44 villages has an outbreak of dengue fever, a team of
epidemiologists rush in to collect data. There isn't a vaccine, but if we can learn more
about the spatial pattern of this disease, and then use what we learn to identify risk
factors, we will be in a better position to protect the people from this disease -- perhaps
we can experiment with different strategies (bed nets, vitamin supplements, pesticides) to
see if any of these efforts break the pattern and improve outcomes.
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16AExercise 16A: Exploring the Geodatabase

Estimated time: 5 minutes

In this exercise, you will assume the role of a GIS Manager at an environmental
organization. You need to edit and expand your existing data for water quality in the
Yellowstone River Basin.

Upper management identified the following requirements for this task:
▪ All spatial data must be stored in a central location to improve access to, and

sharing of, that spatial data.
▪ The storage format must have built-in solutions to manage and store large

amounts of spatial data.
▪ The storage format must enable data to meet the organization's high standards for

accuracy and integrity.

The environmental organization decides that the best storage format is the file
geodatabase because it meets, and exceeds, their requirements.

The Learning Objectives for this exercise is to:
▪ Navigate a geodatabase
▪ Understand and recognize elements in a geodatabase

Step 1: Explore GDB Elements in ArcCatalog (Demo)

In this step, observe and participate as the instructor explains elements contained within a
geodatabase.

Conclusion

In this exercise, the instructor explained the elements contained within a geodatabase.
The geodatabase is the native data structure for ArcGIS and is the primary data format
used for editing and data management. It has a comprehensive information model for
representing and managing geographic information implemented as a series of tables
holding feature classes, raster datasets, and attributes. In addition, advanced GIS data
objects add GIS behavior; rules for managing spatial integrity; and tools for working with
numerous spatial relationships of the core features, rasters, and attributes.

In the following exercise, you will create and load data into a file geodatabase.

Exercise 16A

Copyright © 2008 ESRI 16-1





16BExercise 16B: Create and Load GDB Elements

Estimated time: 15 minutes

In this exercise, you will continue to assume the role of a GIS Manager at an
environmental organization. Before you can start adding behavior to your data, you must
move it into a geodatabase. You decide to create new elements in a file geodatabase and
load data using two different methods.

The Learning Objectives for this exercise is to:
▪ Create new geodatabase objects.
▪ Load data into an existing feature class with Simple Data Loader.
▪ Load data into a file geodatabase using geoprocessing tools.
▪ Discover the characteristics of a geodatabase feature class.

Step 1: Create a new Feature Class

In this step, you will create a new polygon feature class and import the field definitions
from an existing polygon coverage.

Open ArcMap from the Start button >Program Files > ArcGIS > ArcMap on the
Windows taskbar.

ArcMap will display a Getting Started dialog box from which you will create a new map.

Click New Maps > My Templates on the left pane in the dialog box.

Select Blank Map on the right pane and click OK.

The Catalog window provides tools for organizing and managing your map documents,
layers, geodatabases, geoprocessing models and tools, file-based data, and so on. These
are organized and managed in file folders on your computer. The Catalog window is used
to add data to your map and to save and organize results.

This entire step will be performed from the Catalog window.

If the Catalog window is not visible in ArcMap, open it by clicking Windows >
Catalog on the main menu.

Click the pushpin to hold the Catalog window open.
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An initial task in using the Catalog window is to establish a connection to the workspace
folder that you want to use. Folder connections are used to access the file folders whose
content you plan to work with in ArcGIS.

Click the Connect To Folder button in the Catalog window to create a connection
to the folder.

Navigate to C:\EdUC\GDB and click OK to establish the folder connection.

Expand Folder Connections in the Catalog tree.

Expand the Data folder.

The data folder contains two coverages: minerals and wshed. A coverage is an older
format for storing spatial data. You can use Item Description window to preview data in
the folder.

Right-click the minerals coverage, then choose Item Description.

Click the Preview tab in the Item Description window.

Notice that the minerals coverage contains polygons.

Select Table from the Preview drop-down list.

Examine the coverage table schema.

There are user-defined fields for named AREA and PERIMETER.

Close the Item Description window.

Expand the minerals coverage.

There is more then one geometry stored in a coverage. Each coverage stores a set of
points, lines, polygons, or annotation.

Expand the Ex1b folder.

Expand the WaterAssessment geodatabase.

Notice that some feature classes are already loaded. Feature classes are homogeneous
collections of common features, each having the same spatial representation, such as
points, lines, or polygons, and a common set of attribute columns. You can also create
empty feature classes.
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Right-click the WaterAssessment geodatabase, then select New > Feature Class.

In the New Feature Class dialog box, enter MineralDeposits for Name.

Ensure that Type is set to Polygon Features.

Click Next.

When you create a new feature class, you have to choose a coordinate system. The
coordinate system, along with tolerance and resolution values, makes up a spatial
reference of a feature class. A spatial reference describes where features are located in the
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real world. You can select a predefined coordinate system or import the coordinate
system parameters used by another feature class.

Click the Import button to open the Spatial Reference Properties dialog.

Navigate to C:\EdUC\GDB\Ex1b\WaterAssessment via your Folder Connections and
select the watersheds feature class, then click Add.

Notice the Name became "NAD_1983_UTM_Zone_13N"

Click Next.
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Accept the default settings for XY Tolerance and Resolution.

Click Next.

Accept the default Configuration Keyword. It is only used for ArcSDE feature classes.

Click Next.

When you create a new feature class, you can specify the fields to be included and the
properties for those fields, such as the field type and the maximum size of the data that it
can store. You also have the option to import fields from another feature class.

Select Import and navigate to C:\EdUC\GDB\Data via your Folder Connections.

Double-click minerals > and select polygon,.

Click Add.

The field definitions (schema) from the coverage defines all the fields for the new
geodatabase feature class. Notice that AREA and PERIMETER are the third and fourth
fields, respectively. You will delete those two fields because they are automatically
created as a part of the schema in a geodatabase feature class.

Select the small grey box to the left of AREA in the Field Name column to highlight it
and press delete on the keyboard.
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Repeat the step for the PERIMETER field.

Click Finish to close and execute the New Feature Class wizard.

Do not close ArcMap.

The new MineralDeposits feature class should now appear in the WaterAssessment
geodatabase. In the next step, you will add data to the feature class using the Simple Data
Loader and geoprocessing tools.
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Step 2: Load Data with the Simple Data Loader

In this step you will use the Simple Data Loader to load data from the minerals coverage
into the new MineralDeposits feature class in the WaterAssessment geodatabase.

This entire step will be performed from the Catalog window.

The Simple Data Loader wizard allows you to specify a number of source tables and
feature classes to load data into an existing feature class, provided their schema match.
The schemas match because you imported the minerals schema to into the
MineralDeposits geodatabase feature class.

In the Catalog tree, navigate to C:\EdUC\GDB\Ex1b via your Folder Connections.

Expand the WaterAssessment geodatabase.

Right-click on the MineralDeposits feature class and click Load > Load Data.

The Simple Data Loader wizard opens.

Click Next to skip the welcome screen.

For the Input Data box, click the folder to browse into the minerals coverage in the
C:\EdUC\GDB\Data folder, select polygon and click Open.

Navigate to C:\EdUC\GDB\Data via your Folder Connections.

Double-click minerals > and select polygon.

Click Open.
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Click Add to add it to the list of source data to load.

Click Next.

Click Next again. You do not want to load all features into a subtype.

Notice that two Matching Source Fields are missing. The Simple Data Loader allows you
to specify which fields in the input data are loaded into which fields of the target feature
class.

For the MINERALS# [int] target field, click the Matching Source Field box and
selectMINERALS# [int] field from the drop-down to match the source field to the
target field.
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Repeat this step for the MINERALS-ID [int] target field selecting MINERALS-ID
[int] from the Matching Source Field drop-down.

Click Next.

Verify that the Load all of he source data option is selected.

Click Next.

Review the summary and click Finish.

Use the Item Description window to preview the geometry and table for the
MineralDeposits feature class.

You have now successfully loaded the contents of a coverage feature class into a
geodatabase feature class using the Simple Data Loader. In the next step, you will load
data using geoprocessing tools.
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Step 3: Load Data using Geoprocessing Tools

In this step, you will first create a feature dataset in the WaterAssessment geodatabase.
Then you will move the watersheds feature class into this feature dataset and import data
from the sample_site shapefile using geoprocessing tools.

This entire step will be performed from the Catalog window.

A feature dataset is a collection of related feature classes that share a common coordinate
system. Feature datasets are used to spatially integrate related feature classes into a
common dataset for building a topology, a network dataset, a terrain dataset, or a
geometric network.

In the Catalog tree, navigate to C:\EdUC\GDB\Ex1b via your Folder Connections.

Right-click the WaterAssessment geodatabase and select New > Feature Dataset.

Type Sites for the feature dataset name.

Click Next.

When creating a new feature dataset, you must define its spatial reference. This includes
its coordinate system, coordinate units and tolerances. All feature classes in the same
feature dataset must share a common coordinate system, and x,y coordinates of their
features should fall within a common spatial extent.

You can navigate to the spatial reference you want to use or click import it from a feature
class or feature dataset that uses the same spatial reference.

Navigate to C:\EdUC\GDB\Ex1b via your Folder Connections.

Expand the WaterAssessment geodatabase.

Select the watersheds feature class, then click Add.

Click Next.

Accept the default for Vertical Coordinate Systems, then click Next

Accept the default for XY Tolerance, Z Tolerance, M Tolerance, and Resolution, then
click Finish.

You have just created a new Feature Dataset. Now you will move the watersheds feature
class into it.
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In the Catalog tree, drag and drop the watersheds feature class into the Sites feature
dataset.

Expand the Sites feature dataset to confirm that the watersheds feature class was
moved into the feature dataset.

You will now import the sample_site shapefile into the Sites feature dataset.

Navigate to C:\EdUC\GDB\Ex1b\Data via your Folder Connections.

Use the Item Description window to preview the geometry and table for the
sample_sites shapefile.

Right-click the Sites feature dataset and choose Import > Feature Class (single).

For Input Features, browse to sample_sites.shp.

For Output Location, browse to the Sites feature dataset.
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For Output Feature Class, type SampleSites.

There is no need to modify the Field Map. All of the fields from the shapefile will be
imported into the new geodatabase feature class.

Click OK.
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When the import is complete, expand the Sites feature dataset to confirm that the
sample_sitesshapefile was imported into the Sites feature dataset as SampleSites.

Now there is a feature dataset in the WaterAssessment geodatabase containing both the
watersheds and SampleSites feature classes that you moved and imported, respectively.

The next optional exercise explains how to apply attribute behavior to your data.

Conclusion

In this exercise, you created a new feature class, loaded data, and imported a shapefile.
ArcGIS Desktop contains tools that import data from a wide variety of formats into the
geodatabase. Others ways to add data to a geodatabase using ArcMap and the Catalog
tree include: copy data and paste it into another location, export data directly to a
geodatabase or to an XML workspace or XML record set, load data into an existing table
or feature class using the ArcMap Object Loader, or via XML record set and XML
workspace documents.
The next two optional exercises describe attribute behavior using subtypes and domains,
and geometric coincidence using geodatabase topology. There may not be enough to
complete both exercises. You can choose the exercise that best suits your interests.
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16CExercise 16C: (optional) Working with Attribute Behavior

Estimated time: 30 minutes

In this optional exercise, you will continue to assume the role of a GIS Manager at an
environmental organization. Since your editors receive new field data daily, you want to
setup the geodatabase to make editing attribute more efficient and accurate. You decide
to implement subtypes, domains and default values for your attributes.

The Learning Objectives for this exercise is to:
▪ Understand subtypes and domains.
▪ Create and implement subtypes and domains for your feature class attributes.
▪ Appreciate how subtypes and domains maintain efficient editing and accurate

data.

Step 1: Set up a Coded Value Domain

Your GIS editors regularly add water sample locations and edit mineral deposits data.
You want to ensure that the spelling and values of the attributes being entered are valid.
You will use attribute domains. Attribute domains are rules that describe the legal values
of a field type, providing a method for enforcing data integrity. They are used to
constrain the values allowed in any particular attribute for a table or feature class. In this
step you will create two coded-value domains for the SampleSites feature class.

This entire step will be performed from the Catalog window.

In the Catalog tree, navigate to C:\EdUC\GDB\Ex1c via your Folder Connections.

Expand the WaterAssessment geodatabase and the Sites feature dataset.

Use the Item Description window to preview the table for the SampleSites feature
class.

Notice the CNTY field. It records county codes for Montana and Wyoming. Your editors
should not have to memorize all of these county codes. If an editor remembers a code
incorrectly, your data will become erroneous. A coded-value domain would allow your
editors to choose from a list of valid county codes.

Use the Item Description window to preview the CNTY_CODES table.
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The table records county codes and descriptions. The Table to Domain tool can be used
to create a coded-value domain from the values in this table. You must find the tool first.

Open the Search window it by clicking Windows >Search on the main menu.

Click the pushpin to hold the Search window open.

In the search box, type coded value domain and click the Search icon .

The search will return several items. One is the Table to Domain (Data Management)
tool.

Double click the tool name to open it.

Click the Show Help button to read about the functionality of the tool.

For Input Table, browse to C:\EdUC\GDB\Ex1cvia your Folder Connections.

Double-click the WaterAssessment geodatabase and click CNTY_CODES and click
Add.

For Code Field select CODE.

For Description field select DESCRIPTION.

For Input Workspace, browse to C:\EdUC\GDB\Ex1c via your Folder Connections.

Click WaterAssessment.gdb, then click Add.

For Domain Name type County Codes.
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For Domain Description type County codes and names.

Click OK to convert the table to a geodatabase domain.

Click the pushpin on the Search window to retract it.

Right-click theWaterAssessment geodatabase and click Properties.

Click the Domains tab.

Review the values in the Coded Values fields as well as the settings in the Domain
Properties.

Note: For now, we do not need to worry about the Split and Merge Policies because this
domain will be applied to a points feature class. For more information on Split and Merge
review the Desktop Help.

Click OK.

The CNTY_CODES table is now a coded value domain in the geodatabase. This domain
can be shared across feature classes, tables, and subtypes in a geodatabase. In the next
step you will manually create a range domain.
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Step 2: Set up a Range Domain

Your editors have also been adding numeric values well beyond acceptable range for the
SOURCE field in the MineralDeposits feature class. In this step, you are going to
implement a range domain to ensure that these values are within the acceptable range.

This entire step will be performed from the Catalog window.

In the Catalog tree, navigate to C:\EdUC\GDB\Ex1c via your Folder Connections.

Expand the WaterAssessment geodatabase.

Use the Item Description window to preview the table for the MineralDeposits feature
class.

The SOURCE field records codes that fall within a range from 1 to 18. Your editors
should not use numbers outside of this range. A range domain specifies a valid range of
values for a numeric attribute. When creating a range domain, you enter a minimum and
maximum valid value.

Right-click theWaterAssessment geodatabase.

Click Properties.

If necessary, click the Domains tab.

In the Domain Name field, type Source Codes in the empty space below County
Codes.

In the Description field, type Source codes for geological data.

In the Domain Properties pane, ensure Field Type is Short Integer and Domain Type is
Range.

Change the Minimum Value to 1, the Maximum Value to 18.

For Split Policy choose Duplicate from the drop-down menu.
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For Merge Policy choose Default Value.

Click OK to accept the changes to the Database Properties.

The Source Codes range domain table is now a property of the geodatabase. This domain
can be shared across feature classes, tables, and subtypes in a geodatabase. In Step 4, you
will apply these domains to attribute fields so they can be used to maintain attribute
integrity during editing. In the next step, you will create subtypes.
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Step 3: Create Subtypes

Subtypes for a feature class provide ways to further categorize features within the feature
class. The feature classes that your editors change on a daily and weekly basis are
MineralDeposits and SampleSites. In this step, you will create subtypes for those two
feature classes to aid their editing operations.

First, you will examine the MineralDeposits attribute table.

This entire step will be performed from the Catalog window.

In the Catalog tree, navigate to C:\EdUC\GDB\Ex1c via your Folder Connections.

Expand the WaterAssessment geodatabase.

Use the Item Description window to preview the table for the MineralDeposits feature
class.

Examine the ESU field. The numeric values in this field represents non-metallic minerals,
metallic minerals, and uranium. You will be creating a subtype based on the values in this
field.

Right-click MineralDeposits and choose Properties.

Select the Subtypes tab.

Set the Subtype Field to ESU.

When you create a new feature in the feature class without specifying a subtype, it will
automatically be assigned the default subtype. In this case, whenever a feature added to
the MineralDeposits feature class, its ESU attribute should be automatically be set to
Metallic minerals.

Set the Default Subtype to Metallic minerals.

Subtypes are implemented by creating coded values and, therefore, must be associated
with fields of the data type short or long integer. These integer values each represent a
feature in the subtype.
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Code your subtypes according to the following codes and descriptions.

Code Description

0 Non-metallic minerals

1 Metallic minerals

2 Uranium

Note: You will need to define the subtype values before you can choose a default
subtype.
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Each subtype can have its own set of default values. In this case, the Non-metallic
minerals subtype could have the default value for the MINERAL field set to 0, while the
Metallic minerals subtype could have the default value for the MINERAL field set to 1.
Whenever a feature is added, its subtype will automatically populate the MINERAL field
with its default value.

Click the gray box beside Code 0 in the Subtypes pane to highlight it.

In the Default Values and Domains pane, locate the MINERAL Field Name.
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Click the blank box under the Default Value header and type 0.

Repeat this steps for Code 2 using a default value of 1.

Each subtype can also have its own domain for a given field. In this case, the SOURCE
field should only use values from the Source Codes domain.

Click the gray box beside Code 0 in the Subtypes pane to highlight it.

In the Default Values and Domains pane, locate the SOURCE Field Name.

Click the blank box under the Domain header and select Source Codes from the drop-
down.
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Repeat these steps for Code 1 and Code 2.

Click OK.

You will also subtype the SampleSites feature class based on the integer field SENCODE,
which is the sensitivity code for the river at the point that the sample was taken.

Based on what you learned above, create a subtype on the field SENCODE for the
SampleSites feature class.

Set the Subtype Field to SENCODE.

Set the Default Subtype to Moderate sensitivity.
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Code your subtypes according to the following codes and descriptions.

Code Description

0 No sensitivity

1 Mild sensitivity

2 Moderate sensitivity

3 Moderate High sensitivity

4 High sensitivity

5 Extreme sensitivity
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Assign the County Code domain to the CNTY field for each subtype code.

You now have subtypes where each subtype has its own default value and domain
assigned to it. Subtypes are a subset of features in a feature class, or objects in a table,
that share the same attributes. They are used as a method to categorize your data. In the
next step, you will edit with subtypes and domains.
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Step 4: Edit with Subtypes and Domains

Attribute domains are a type of data validation. The attribute domains you have created
are rules that describe the permissible values of a field type. Multiple feature classes and
tables can share the same attribute domains stored in the database. For example, the
domain you created for valid County Codes can be assigned to the CNTY field of
SampleSites feature class as well as any other feature class in the geodatabase that
contains county codes. In this step, you will edit your data to see how subtypes, domains,
and default values make editing efficient and accurate.

In the Catalog tree, navigate to C:\EdUC\GDB\Ex1c via your Folder Connections.

Expand the WaterAssessment geodatabase.

Right-click SampleSites, select Properties.

Click the Fields tab.

Highlight the field CNTY by clicking the gray box beside the name.

In the Field Properties select County Code as the Domain from the drop-down.

The Source Code Domain does not show up because it was defines as a Short Integer data
type and therefore can only be applied to fields of that type.
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Click OK.

In the Catalog Tree, right-click MineralDeposits, select Properties.

Click the Fields tab.

Highlight the field SOURCE.
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In the Field Properties select Source Codes as the Domain.

Click OK.

The domains you assigned will apply to all the features in the feature class. Now that you
have setup your subtypes and domains, you are ready to edit your SampleSites and
MineralDeposits feature classes.
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One of the field technicians has sent you data with new water sample points. You add the
new points and use the subtypes and domains to ensure the attributes are complete and
accurate.

In ArcMap, click File > Open on the main menu. Navigate to theC:\EdUC\GDB\Ex1c
folder, selectAttributeEdits.mxdand click OK.

If prompted to save your current map document, click No.

From the Catalog window, drag and drop the MineralDeposits and SampleSites feature
classes from the WaterAssessment geodatabase in the Ex1c folder to your map display
to add them to the map.

Notice that both feature classes come in already categorized by an attribute value. This is
default behavior of subtypes.

Right-click SampleSites layer in the Table of Contents.

Select Properties and click the Symbology tab.

Uncheck the box beside the symbol for <all other values> turn off its visibility.

Click Value and select Reverse Sorting.

Highlight the values for No sensitivity (i.e. the 0 value) and click the Remove button.
This removes the values from the display, not from the attribute table.

Highlight all other values (1 to 5) and right-click to bring up the context menu and
click Properties for All Symbols.

Increase the font size from the default 4 to 8.

Click OK.

Without deselecting the values, choose a new color ramp that will better distinguish
the symbols from each other.
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Click OK.

Perform the same steps for the MineralDeposits feature class, removing the symbol
with the value 0 (No Metallic Minerals), and choosing better colors for the remaining
two values.

Now you will add a new point to the SampleSites feature class and use the County Codes
domain to populate a field.

Click the Editor Toolbar button on the Standard toolbar to open the Editor
Toolbar.

Click Editor > Start Editing to enable the Create Features window.

In the Create Features window, click the Extreme sensitivity feature template to
activate the Point construction tool.

Click anywhere along the Yellowstone River to place a new point and leave the new
feature selected.
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Click the Attributes button on the Editor Toolbar to open the Attributes window.

Click the <Null> value in the CNTY field to reveal a drop-down menu.

These are the values in the County Codes domain created in Step 1. The geodatabase
store the codes and ArcMap displays the code descriptions. You are restricted to choose
from only these values. As such, invalid values cannot be introduced into your data.

Click the close button on the Attribute window to close it.

Click Clear the selected features button on the Tools toolbar.

Click Editor > Save Edits.

Now you will add a new polygon to the SampleSites feature class and use the Source
Codes domain to validate a value.

In the Create Features window, click the Metallic minerals template to activate the
Polygon construction tool.

Place a new polygon anywhere within the area defined by the Watersheds feature
class.

Open the Attribute Table for the MineralDeposits layer and click Show selected
records button .

Notice that the MINERAL field is already populated. In the previous step, you set this
default value to the Metallic minerals subtype. Whenever a Metallic minerals feature is
added, its subtype will automatically populate the MINERAL field with its 1 as its
default value.

Change the value of SOURCE to 22 and click away to accept the value.

The following warning will appear:

Remember the valid range of values in the Source Codes domain is from 1 to 18.
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Click OK.

Change the value of SOURCE to 6 and click away to accept the value.

Close the Attribute Table for MineralDeposits.

Click Editor > Validate Features.

All of the feature attributes should be valid.

Stop editing, do not save your edits.

Close ArcMap, do not save the map document.

In this step, you edited using coded values and range domains to ensure only valid values
were entered in your data. Coded values appear as a drop-down menu listing only the
values you can choose. Range domains provide messages and a method to validate your
features to ensure the integrity of your data.

In the next optional exercise, you will create a simple geodatabase topology.

Conclusion

In this exercise, you implemented subtypes, domains, and default values to maintain
efficient and accurate editing.
One of the advantages of storing your data in a geodatabase is that you can define rules
about how the data can be edited. Attribute domains are rules that describe the legal
values of a field type. Multiple feature classes and tables can share attribute domains
stored in the database. Subtypes are a subset of features in a feature class, or objects in a
table, that share the same attributes. You can establish a separate set of domains and
default values for each subtype to further distinguish features within a feature class.
In the following optional exercise, you will create a geodatabase topology, validate your
data for accuracy, and edit a topological error.
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16DExercise 16D: (optional) Working with Topology

Estimated time: 15 minutes

In this optional exercise, you will continue to assume the role of a GIS Manager at an
environmental organization. Since your editors receive new field data daily, you want to
setup the geodatabase to ensure that the spatial relationships between features are
efficiently and accurately modeled. You decide to create a geodatabase topology, validate
your data, and fix any topological errors that may exist.

The Learning Objectives for this exercise is to:
▪ Understand how to build a geodatabase topology.
▪ Use a geodatabase topology to help find and fix topological errors.

Step 1: Create a Simple Topology

If you have features that are coincident and share the same location of coordinates,
boundaries, or nodes, a geodatabase topology will help you better manage your
geographic data. Geodatabase topologies help you ensure data integrity. Using a topology
provides a mechanism to perform integrity checks on your data and helps you to validate
and maintain better feature representations in your geodatabase. In this step, you will
create a geodatabase topology.

This entire step will be performed from the Catalog window.

In the Catalog tree, navigate to C:\EdUC\GDB\Ex1c via your Folder Connections.

Expand the WaterAssessment geodatabase and the Sites feature dataset.

Note: The feature classes contains the SampleSites and watersheds feature classes.

Right-click the Sites feature dataset and select New > Topology.

Click Next on the New Topology dialog.

The name and cluster tolerance of the new topology can be specified. The name cannot
contain reserved words or special characters.

Creating topological relationships involves analyzing the coordinate locations of feature
vertices among features in the same feature class as well as between the feature classes
that participate in the topology. A cluster tolerance is used to integrate vertices. All
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vertices that are within the cluster tolerance are assumed to represent the same location
and may move slightly in the validation process.

Generally, you can use an x,y tolerance that is 10 times the x,y resolution and expect very
good results. A typical x,y tolerance is orders of magnitude smaller than the true accuracy
of your data capture because if your x,y tolerance is too large, feature coordinates may
collapse on one another. This can compromise the accuracy of feature boundary
representations.

In this case, click Next to accept the default name and cluster tolerance.

All feature classes that will participate in the topology must be organized into the same
feature dataset and, hence, the same coordinate system. You will be shown a list of all the
feature classes in your feature dataset from which you will choose the feature classes that
will participate in the topology.

Click Select All to include both the feature classes in the topology and click Next.

The coordinate accuracy ranks helps control how vertices are moved when they fall
within the cluster tolerance of one another. Typically, the less accurate coordinate is
moved to the location of the more accurate coordinate. The most accurate feature classes
should receive a rank of 1, and lower accuracies must descend in order from the highest
rank (the second most accurate gets a rank of 2 and so on). Multiple feature classes can
have the same accuracy rank. If you cannot perceive that there is a difference in accuracy,
set the ranks of all feature classes to 1 (in other words, so the accuracy is the same).

For Number of Ranks, type 2.

For SampleSites choose 1.
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For Watersheds choose 2.

Click Next.

Topology rules define the permissible spatial relationships between features. For
example, in a ownership parcels feature class, the rule Must not overlap can be chosen to
ensure that ownership parcels do not overlap. The rules you define for a topology control
the relationships between features within a feature class, between features in different
feature classes, or between subtypes of features. There are around 25 rules from which to
choose.

You will add only one rule to establish a relationship between the two feature classes.

Click Add Rule.

The Add Rule dialog has controls for selecting a rule and the feature classes that
participate in the rule. It also gives a description of the selected rule.

For Features of feature class, select SampleSites.
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For Rule select Must be Properly Inside.

For Feature Class select watersheds.

Click OK to add the rule and close the Add Rule dialog.

Click Next.

Review the summary and click Finish.

You have now added the new topology and its properties to your feature dataset. You will
be asked if you would like to validate your topology in your feature dataset. The
validation process identifies shared coordinates between features (both in the same
feature class and across feature classes).

Click No.

The topology is stored in a geodatabase as rules that define how the features in one or
more feature classes share geometry. In the next step, you will validate the geodatabase
topology.

Step 2: Explore the Topology in ArcMap

Once you have created a topology and loaded data, at any time, you can run a
validation against the feature class contents of the topology. ArcMap contains a
number of advanced tools and functions for managing and editing a topology. In this
step, you will validate the geodatabase topology, then locate and fix a topological
error.
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In ArcMap, click File > Open on the main menu. Navigate to theC:\EdUC\GDB\Ex1d
folder, selectGeometryEdit.mxdand click OK.

If prompted to save your current map document, click No.

From the Catalog window, drag and dropSites_Topology from the WaterAssessment
geodatabase in the Ex1d folder to your map display.

Click No when prompted to add the feature classes that participate in the topology to
the map.

A topology layer is added to your Table of Contents to display topological relationships,
errors, and exceptions. You can access the display properties for a topology layer just like
any other layer—by right-clicking the layer name and clicking Properties.

Right-click the topology layer and select Properties.

Click the Errors tab and click the Generate Summary button.

The summary yields no errors. Since validation runs a set of integrity checks to identify
any violations of the rules that have been defined for the topology, errors have not been
identified.

Click OK to close the Topology Properties dialog.

In the Catalog window, validate the topology by right-clicking it in the catalog tree and
clicking Validate.

When you validate your topology, it generates an error report so you can be aware of
issues and have the opportunity to repair serious errors. In this way, topology helps you
know about the integrity of your datasets and their suitability for use in various
applications.

Right-click the topology layer and select Properties.

Click the Errors tab and click the Generate Summary button.

There is one error. The Must be Properly Inside rule has been violated.

Click OK to close the Layer Properties window.
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By default, the topology layer symbolizes topology errors in pink. If you choose, you can
access the display properties for a topology layer and click the Symbology tab to change
the drawing properties for your topology.

Zoom to the error in the right-uppermost area of the watershed.

Select 1:250 000 from the scale drop-down on the Standard toolbar.

The error summary reported that Must be Properly Inside rule has been violated.
Specifically, the SampleSites point is not properly inside the Watershed.

You realize that the site is in the wrong location and it should be moved inside the
boundary of the watershed feature. You will now use the topology toolbar to correct the
misplaced site location in an edit session.

Click Customizes > Toolbars > Topology from the main menu to open the Topology
toolbar.
If the Editor toolbar is not open, click the Editor Toolbar button on the Standard
toolbar to open it.

Education User Conference 2010

16-42 Copyright © 2008 ESRI



Click Editor > Start Editing.

Select the erroneous point with the Topology Edit Tool on the Topology toolbar.
Move the point within the watersheds polygon boundary along the Yellowstone River.

Click the Validate Topology In Current Extent button on the Topology toolbar to
validate only the extent of your map display.

The Error Inspector lets you view topology errors in a table that tells you the rules
violated, the feature class or classes involved in the errors, the geometry of the errors, the
feature IDs of the features involved in the errors, and whether or not the errors have been
marked as exceptions. You can sort the errors by any of the fields in the table so that you
can work with all the errors of a given type. You can also limit the errors shown in the
table to errors of a given type, errors that occur in the currently visible map extent, or
errors that have been marked as exceptions.
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Click the Error Inspector button on the Topology toolbar to enable it.

Select SampleSites - Must Be Properly Inside - watersheds from the Show drop-down
and click Search Now.

Since the error has been fixed, the Error Inspector does not return an results.

On the Editor toolbar, click Editor > Stop Editing.

Save your edits.

Close ArcMap without saving the map document.

The ArcMap editing environment provides several ways to maintain the integrity of your
data. You have now validated a topology, found errors, and fixed topological errors thus
better managing your geographic data.

Conclusion

In this exercise, you created a geodatabase topology, validated your data, and fixed a
topological error to ensure that the spatial relationships between features are efficiently
and accurately modeled.
Topology is the arrangement for how point, line, and polygon features share geometry.
Geodatabase topologies help you ensure data integrity. It provides a mechanism to
perform integrity checks on your data and helps you to validate and maintain better
feature representations in your geodatabase. A topology is stored in a geodatabase as one
or more relationships that define how the features in one or more feature classes share
geometry.
This is the final exercise in the lesson. Thank you for participating.
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IMPORTANT — READ CAREFULLY
BEFORE OPENING THE SEALED MEDIA PACKAGE

ENVIRONMENTAL SYSTEMS RESEARCH INSTITUTE, INC. (ESRI), IS WILLING TO LICENSE THE
ENCLOSED ELECTRONIC VERSION OF THIS TRAINING COURSE TO YOU ONLY UPON THE
CONDITION THAT YOU ACCEPT ALL OF THE TERMS AND CONDITIONS CONTAINED IN THIS
ESRI DATA LICENSE AGREEMENT. PLEASE READ THE TERMS AND CONDITIONS CAREFULLY
BEFORE OPENING THE SEALED MEDIA PACKAGE. BY OPENING THE SEALED MEDIA
PACKAGE, YOU ARE INDICATING YOUR ACCEPTANCE OF THE ESRI DATA LICENSE
AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS AS STATED, THEN
ESRI IS UNWILLING TO LICENSE THE TRAINING COURSE TO YOU. IN SUCH EVENT, YOU
SHOULD RETURN THE MEDIA PACKAGE WITH THE SEAL UNBROKEN AND ALL OTHER
COMPONENTS (E.G., THE CD-ROM, TRAINING COURSE MATERIALS, TRAINING DATABASE,
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COMPONENTS.

ESRI DATA LICENSE AGREEMENT

This is a license agreement, and not an agreement for sale, between you (Licensee) and ESRI. This ESRI
data license agreement (Agreement) gives Licensee certain limited rights to use the electronic version of the
training course materials, training database, software, and related materials (hereinafter collectively referred to
as the "Training Course"). All rights not specifically granted in this Agreement are reserved to ESRI and its
licensor(s).

Reservation of Ownership and Grant of License: ESRI and its licensor(s) retain exclusive rights,
title, and ownership to the copy of the Training Course licensed under this Agreement and hereby grant to
Licensee a personal, nonexclusive, nontransferable license to use the Training Course as a single package for
Licensee's own personal use only pursuant to the terms and conditions of this Agreement. Licensee agrees
to use reasonable efforts to protect the Training Course from unauthorized use, reproduction, distribution, or
publication.

Proprietary Rights and Copyright: Licensee acknowledges that the Training Course is proprietary and
confidential property of ESRI and its licensor(s) and is protected by United States copyright laws and
applicable international copyright treaties and/or conventions.
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Permitted Uses:
▪ Licensee may run the setup and install one (1) copy of the Training Course onto a permanent electronic

storage device and reproduce one (1) copy of the Training Course and/or any online documentation in
hard-copy format for Licensee's own personal use only.

▪ Licensee may use one (1) copy of the Training Course on a single processing unit.
▪ Licensee may make only one (1) copy of the original Training Course for archival purposes during the

term of this Agreement, unless the right to make additional copies is granted to Licensee in writing by
ESRI.

▪ Licensee may use the Training Course provided by ESRI for the stated purpose of Licensee's own
personal GIS training and education.

Uses Not Permitted:
▪ Licensee shall not sell, rent, lease, sublicense, lend, assign, time-share, or transfer, in whole or in part,

or provide unlicensed third parties access to the Training Course, any updates, or Licensee's rights
under this Agreement.

▪ Licensee shall not separate the component parts of the Training Course for use on more than one (1)
computer, used in conjunction with any other software package, and/or merged and compiled into a
separate database(s) for other analytical uses.

▪ Licensee shall not reverse engineer, decompile, or disassemble the Training Course, except and only to
the extent that such activity is expressly permitted by applicable law notwithstanding this restriction.

▪ Licensee shall not make any attempt to circumvent the technological measure(s) (e.g., software or
hardware key) that effectively controls access to the Training Course, except and only to the extent that
such activity is expressly permitted by applicable law notwithstanding this restriction.

▪ Licensee shall not remove or obscure any copyright, trademark, and/or proprietary rights notices of
ESRI or its licensor(s).

Term: The license granted by this Agreement shall commence upon Licensee's receipt of the Training Course
and shall continue until such time that (1) Licensee elects to discontinue use of the Training Course and
terminates this Agreement or (2) ESRI terminates for Licensee's material breach of this Agreement. The
Agreement shall automatically terminate without notice if Licensee fails to comply with any provision of this
Agreement. Upon termination of this Agreement in either instance, Licensee shall return to ESRI or destroy
all copies of the Training Course, and any whole or partial copies, in any form and deliver evidence of such
destruction to ESRI, which evidence shall be in a form acceptable to ESRI in its sole discretion. The parties
hereby agree that all provisions that operate to protect the rights of ESRI and its licensor(s) shall remain in
force should breach occur.

Limited Warranty and Disclaimer: ESRI warrants that the media upon which the Training Course is
provided will be free from defects in materials and workmanship under normal use and service for a period of
ninety (90) days from the date of receipt.

EXCEPT FOR THE LIMITED WARRANTY SET FORTH ABOVE, THE TRAINING COURSE
CONTAINED THEREIN IS PROVIDED "AS-IS," WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
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MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NONINFRINGEMENT. ESRI
DOES NOT WARRANT THAT THE TRAINING COURSE WILL MEET LICENSEE'S NEEDS OR
EXPECTATIONS; THAT THE USE OF THE TRAINING COURSE WILL BE UNINTERRUPTED; OR
THAT ALL NONCONFORMITIES, DEFECTS, OR ERRORS CAN OR WILL BE CORRECTED. THE
TRAINING DATABASE HAS BEEN OBTAINED FROM SOURCES BELIEVED TO BE RELIABLE,
BUT ITS ACCURACY AND COMPLETENESS, AND THE OPINIONS BASED THEREON, ARE NOT
GUARANTEED. THE TRAINING DATABASE MAY CONTAIN SOME NONCONFORMITIES,
DEFECTS, ERRORS, AND/OR OMISSIONS. ESRI AND ITS LICENSOR(S) DO NOT WARRANT THAT
THE TRAINING DATABASE WILL MEET LICENSEE'S NEEDS OR EXPECTATIONS, THAT THE USE
OF THE TRAINING DATABASE WILL BE UNINTERRUPTED, OR THAT ALL NONCONFORMITIES
CAN OR WILL BE CORRECTED. ESRI AND ITS LICENSOR(S) ARE NOT INVITING RELIANCE
ON THIS TRAINING DATABASE, AND LICENSEE SHOULD ALWAYS VERIFY ACTUAL DATA,
WHETHER MAP, SPATIAL, RASTER, TABULAR INFORMATION, AND SO FORTH. THE DATA
CONTAINED IN THIS PACKAGE IS SUBJECT TO CHANGE WITHOUT NOTICE.

Exclusive Remedy and Limitation of Liability: During the warranty period, Licensee's exclusive remedy
and ESRI's entire liability shall be the return of the license fee paid for the Training Course upon the Licensee's
deinstallation of all copies of the Training Course and providing a Certification of Destruction in a form
acceptable to ESRI.

IN NO EVENT SHALL ESRI OR ITS LICENSOR(S) BE LIABLE TO LICENSEE FOR COSTS OF
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, LOST PROFITS, LOST SALES OR
BUSINESS EXPENDITURES, INVESTMENTS, OR COMMITMENTS IN CONNECTION WITH ANY
BUSINESS, LOSS OF ANY GOODWILL, OR FOR ANY INDIRECT, SPECIAL, INCIDENTAL, AND/OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THIS AGREEMENT OR USE OF THE TRAINING
COURSE, HOWEVER CAUSED, ON ANY THEORY OF LIABILITY, AND WHETHER OR NOT ESRI
OR ITS LICENSOR(S) HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. THESE
LIMITATIONS SHALL APPLY NOTWITHSTANDING ANY FAILURE OF ESSENTIAL PURPOSE OF
ANY LIMITED REMEDY.

No Implied Waivers: No failure or delay by ESRI or its licensor(s) in enforcing any right or remedy under
this Agreement shall be construed as a waiver of any future or other exercise of such right or remedy by ESRI
or its licensor(s).

Order for Precedence: This Agreement shall take precedence over the terms and conditions of any purchase
order or other document, except as required by law or regulation.

Export Regulation: Licensee acknowledges that the Training Course and all underlying information or
technology may not be exported or re-exported into any country to which the U.S. has embargoed goods, or
to anyone on the U.S. Treasury Department's list of Specially Designated Nationals, or to the U.S. Commerce
Department's Table of Deny Orders. Licensee shall not export the Training Course or any underlying
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information or technology to any facility in violation of these or other applicable laws and regulations. Licensee
represents and warrants that it is not a national or resident of, or located in or under the control of, any country
subject to such U.S. export controls.

Severability: If any provision(s) of this Agreement shall be held to be invalid, illegal, or unenforceable by
a court or other tribunal of competent jurisdiction, the validity, legality, and enforceability of the remaining
provisions shall not in any way be affected or impaired thereby.

Governing Law: This Agreement, entered into in the County of San Bernardino, shall be construed and
enforced in accordance with and be governed by the laws of the United States of America and the State of
California without reference to conflict of laws principles.

Entire Agreement: The parties agree that this Agreement constitutes the sole and entire agreement of
the parties as to the matter set forth herein and supersedes any previous agreements, understandings, and
arrangements between the parties relating hereto.
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